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Alarm Troubleshooting

This chapter gives a description, severity, and troubleshooting procedure for each commonly 
encountered Cisco ONS 15600 SDH alarm and condition. Tables 2-1 through 2-5 provide lists of 
ONS 15600 SDH alarms organized by severity. Table 2-6 on page 2-4 provides a list of alarms organized 
alphabetically. Table 2-7 gives definitions of all ONS 15600 SDH alarm logical objects, which are the 
basis of the alarm profile list in Table 2-8 on page 2-8. For a comprehensive list of all conditions, refer 
to the Cisco ONS SDH TL1 Command Guide.

An alarm troubleshooting procedure applies to both the Cisco Transport Controller (CTC) and 
Transaction Language One (TL1) version of that alarm. If the troubleshooting procedure does not clear 
the alarm, log into the Technical Support Website at http://www.cisco.com/techsupport for more 
information or call the Cisco Technical Assistance Center (TAC) (1 800 553-2447).

2.1 Alarm Indexes by Default Severity
The following tables group alarms and conditions by their default severities in the ONS 15600 SDH 
system. These severities are the same whether they are reported in the CTC Alarms window severity 
(SEV) column or in TL1. 

Note The CTC default alarm profile contains some alarms or conditions which are not currently implemented 
but are reserved for future use.

Note The CTC default alarm profile in some cases contains two severities for one alarm (for example, 
MJ/MN). The ONS 15600 SDH platform default severity comes first (in this example, MJ), but the alarm 
can be demoted to the second severity in the presence of a higher-ranking alarm. This is in accordance 
with Telcordia GR-474-CORE.

2.1.1 Critical Alarms (CR)
Table 2-1 alphabetically lists ONS 15600 SDH Critical (CR) alarms.

Table 2-1 ONS 15600 SDH Critical Alarm List

AU-LOP (VCMON-HP) HP-PLM (VCMON-HP) LOS (STMN)

BKUPMEMP (EQPT) HP-UNEQ (VCMON-HP) MEA (EQPT)
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2.1.2  Major Alarms (MJ)
2.1.2 Major Alarms (MJ)
Table 2-2 alphabetically lists ONS 15600 SDH Major (MJ) alarms.

2.1.3 Minor Alarms (MN)
Table 2-3 alphabetically lists ONS 15600 SDH Minor (MN) alarms.

CTNEQPT-PB-A (EQPT) IMPROPRMVL (EQPT) MEA (PIM)

CTNEQPT-PB-B (EQPT) IMPROPRMVL (FAN) MEA (PPM)

ENCAP-MISMATCH-P (POS) IMPROPRMVL (PIM) MFGMEM (EQPT)

EQPT (EQPT) IMPROPRMVL (PPM) MFGMEM (FAN)

EQPT (PIM) LASER-BIAS (EQPT) MFGMEM (PIM)

EQPT (PPM) LASER-BIAS (PPM) MFGMEM (PPM)

EQPT-BOOT (EQPT) LASER-OVER-TEMP (EQPT) RS-TIM (STMN)

EQPT-CC-PIM (PIM) LASER-OVER-TEMP (PPM) SYNCCLK (NE)

EQPT-PIM-PPM (PPM) LOF (STMN) XCMTX (NE)

FAN-FAIL (FAN) — —

Table 2-1 ONS 15600 SDH Critical Alarm List (continued)

Table 2-2 ONS 15600 SDH Major Alarm List

APSCM (STMN) E-W-MISMATCH (STMN) MEM-GONE (EQPT)

APSCNMIS (STMN) EXTRA-TRAF-PREEMPT (STMN) PRC-DUPID (STMN)

CARLOSS (GIGE) FAN-FAIL-PARTIAL (FAN) PWR (PWR)

CLKFAIL (EQPT) GFP-LFD (POS) RING-MISMATCH (STMN)

CXCHALT (EQPT) GFP-UP-MISMATCH (POS) SYNCPRI (NE-SREF)

DBOSYNC (NE) HIBATVG (PWR) SYSBOOT (NE)

EHIBATVG (PWR) INVMACADR (BPlane) TPTFAIL (POS)

ELWBATVG (PWR) LWBATVG (PWR) WVL-OUT-OF-LOCK (STMN)

Table 2-3 ONS 15600 SDH Minor Alarm List

APSB (STMN) HELLO (STMN) NON-CISCO-PPM (PPM)

APSCDFLTK (STMN) HI-LASERBIAS (PPM) OPEN-SLOT (EQPT)

APSC-IMP (STMN) HI-LASERBIAS (STMN) PROV-MISMATCH (PPM)

APSCINCON (STMN) HI-RXPOWER (STMN) PWR-FA (BPlane)

AUTORESET (EQPT) HI-TXPOWER (PPM) PWR-FAIL-A (CAP)

BPV (BITS) HI-TXPOWER (STMN) PWR-FAIL-A (EQPT)

CIDMISMATCH-A (EQPT) HP-TIM (VCMON-HP) PWR-FAIL-B (CAP)

CIDMISMATCH-B (EQPT) IMPROPRMVL (CAP) PWR-FAIL-B (EQPT)
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2.1.4  Not Alarmed (NA) Conditions
2.1.4 Not Alarmed (NA) Conditions
Table 2-4 alphabetically lists ONS 15600 SDH Not Alarmed conditions.

CONTBUS-CLK-A (EQPT) IMPR-XC (NE) PWR-FAIL-RET-A (EQPT)

CONTBUS-CLK-B (EQPT) ISIS-ADJ-FAIL (STMN) PWR-FAIL-RET-B (EQPT)

CONTBUS-IO-A (EQPT) KBYTE-APS-CHANNEL-FAILURE 
(STMN)

RS-EOC (STMN)

CONTBUS-IO-B (EQPT) LOF (BITS) SFTWDOWN (EQPT)

CONTCOM (EQPT) LO-LASERBIAS (PPM) SNTP-HOST (NE)

DATAFLT (NE) LO-LASERBIAS (STMN) SSM-FAIL (BITS)

DUP-IPADDR (NE) LO-RXPOWER (STMN) SSM-FAIL (STMN)

DUP-NODENAME (NE) LOS (BITS) SYNCPRI (EXT-SREF)

EQPT (CAP) LO-TXPOWER (PPM) SYNCSEC (EXT-SREF)

EQPT-HITEMP (EQPT) LO-TXPOWER (STMN) SYNCSEC (NE-SREF)

EXT (ENVALRM) MATECLK (EQPT) SYNCTHIRD (EXT-SREF)

FAN-DEGRADE (FAN) MEM-LOW (EQPT) UNPROT-SYNCCLK (NE)

FAN-PWR (FAN) MFGMEM (CAP) UNPROT-XCMTX (NE)

FEPRLF (STMN) MS-EOC (STMN) UNQUAL-PPM (PPM)

FREQ-MISMATCH (EQPT) MSSP-SW-VER-MISM (STMN) UNROUTEABLE-IP (NE)

Table 2-3 ONS 15600 SDH Minor Alarm List (continued)

Table 2-4 ONS 15600 SDH NA Conditions List

ALS (STMN) HP-DEG (VCMON-HP) SSM-DUS (STMN)

AUD-LOG-LOSS (NE) HP-EXC (VCMON-HP) SSM-LNC (BITS)

AUD-LOG-LOW (NE) INTRUSION-PSWD (NE) SSM-LNC (NE-SREF)

AUTOSW-LOP-SNCP (VCMON-HP) KB-PASSTHR (STMN) SSM-LNC (STMN)

AUTOSW-SDBER-SNCP (VCMON-HP) LKOUTPR-S (STMN) SSM-OFF (BITS)

AUTOSW-SFBER-SNCP (VCMON-HP) LOCKOUT-REQ (STMN) SSM-OFF (STMN)

AUTOSW-UNEQ-SNCP (VCMON-HP) LOCKOUT-REQ (VCMON-HP) SSM-PRC (BITS)

CHANLOSS (STMN) LOCKOUT-REQ-RING (STMN) SSM-PRC (NE-SREF)

EXERCISE-RING-FAIL (STMN) LPBKCRS (VCMON-HP) SSM-PRC (STMN)

FAILTOSW (STMN) LPBKFACILITY (GIGE) SSM-SDH-TN (BITS)

FAILTOSW-HO (VCMON-HP) LPBKFACILITY (STMN) SSM-SDH-TN (NE-SREF)

FAILTOSWR (STMN) LPBKPAYLOAD (STMN) SSM-SDH-TN (STMN)

FAILTOSWS (STMN) LPBKTERMINAL (GIGE) SSM-SETS (BITS)

FE-FRCDWKSWBK-SPAN (STMN) LPBKTERMINAL (STMN) SSM-SETS (NE-SREF)

FE-FRCDWKSWPR-RING (STMN) MAN-REQ (VCMON-HP) SSM-SETS (STMN)

FE-FRCDWKSWPR-SPAN (STMN) MANRESET (PIM) SSM-SMC (STMN)
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2.1.5  Not Reported (NR) Conditions
2.1.5 Not Reported (NR) Conditions
Table 2-5 alphabetically lists ONS 15600 SDH Not Reported conditions.

2.2 Alarms and Conditions Listed by Alphabetical Entry
Table 2-6 alphabetically lists all ONS 15600 SDH alarms and conditions.

FE-LOCKOUTOFPR-ALL (STMN) MANRESET (PPM) SSM-STU (BITS)

FE-LOCKOUTOFPR-SPAN (STMN) MANSWTOINT (NE-SREF) SSM-STU (NE-SREF)

FE-MANWKSWBK-SPAN (STMN) MANSWTOPRI (EXT-SREF) SSM-STU (STMN)

FE-MANWKSWPR-RING (STMN) MANSWTOPRI (NE-SREF) SWTOPRI (EXT-SREF)

FE-MANWKSWPR-SPAN (STMN) MANSWTOSEC (EXT-SREF) SWTOPRI (NE-SREF)

FE-SF-SPAN (STMN) MANSWTOSEC (NE-SREF) SWTOSEC (EXT-SREF)

FORCED-REQ (VCMON-HP) MANSWTOTHIRD (EXT-SREF) SWTOSEC (NE-SREF)

FORCED-REQ-RING (STMN) MANSWTOTHIRD (NE-SREF) SWTOTHIRD (EXT-SREF)

FORCED-REQ-SPAN (STMN) MANUAL-REQ-RING (STMN) SWTOTHIRD (NE-SREF)

FRCDSWTOINT (NE-SREF) MANUAL-REQ-SPAN (STMN) SW-VER (EQPT)

FRCDSWTOPRI (EXT-SREF) MS-DEG (STMN) SYNC-FREQ (BITS)

FRCDSWTOPRI (NE-SREF) MS-EXC (STMN) SYNC-FREQ (STMN)

FRCDSWTOSEC (EXT-SREF) MS-SQUELCH-HP (STMN) UPGRADE (NE)

FRCDSWTOSEC (NE-SREF) PWRRESTART (EQPT) VOLT-MISM (PWR)

FRCDSWTOTHIRD (EXT-SREF) RING-SW-EAST (STMN) WKSWPR (STMN)

FRCDSWTOTHIRD (NE-SREF) RING-SW-WEST (STMN) WKSWPR (VCMON-HP)

FRNGSYNC (NE-SREF) ROLL (VCMON-HP) WTR (STMN)

FSTSYNC (EQPT) ROLL-PEND (VCMON-HP) WTR (VCMON-HP)

FULLPASSTHR-BI (STMN) SSM-DUS (BITS) —

HLDOVRSYNC (NE-SREF) SSM-SMC (BITS) —

MANRESET (EQPT) SSM-SMC (NE-SREF) —

Table 2-4 ONS 15600 SDH NA Conditions List (continued)

Table 2-5 ONS 15600 SDH NR Conditions List

AIS (BITS) AUTOSW-AIS-SNCP (VCMON-HP) MS-AIS (STMN)

AU-AIS (VCMON-HP) HP-RFI (VCMON-HP) MS-RFI (STMN)

Table 2-6 ONS 15600 SDH Alarm and Condition Alphabetical List

AIS (BITS) FRNGSYNC (NE-SREF) MS-EOC (STMN)

ALS (STMN) FSTSYNC (EQPT) MS-EXC (STMN)
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APSB (STMN) FULLPASSTHR-BI (STMN) MS-RFI (STMN)

APSCDFLTK (STMN) GFP-LFD (POS) MSSP-SW-VER-MISM (STMN)

APSC-IMP (STMN) GFP-UP-MISMATCH (POS) MS-SQUELCH-HP (STMN)

APSCINCON (STMN) HELLO (STMN) NON-CISCO-PPM (PPM)

APSCM (STMN) HIBATVG (PWR) OPEN-SLOT (EQPT)

APSCNMIS (STMN) HI-LASERBIAS (PPM) PRC-DUPID (STMN)

AU-AIS (VCMON-HP) HI-LASERBIAS (STMN) PROV-MISMATCH (PPM)

AUD-LOG-LOSS (NE) HI-RXPOWER (STMN) PWR (PWR)

AUD-LOG-LOW (NE) HI-TXPOWER (PPM) PWR-FA (BPlane)

AU-LOP (VCMON-HP) HI-TXPOWER (STMN) PWR-FAIL-A (CAP)

AUTORESET (EQPT) HLDOVRSYNC (NE-SREF) PWR-FAIL-A (EQPT)

AUTOSW-AIS-SNCP (VCMON-HP) HP-DEG (VCMON-HP) PWR-FAIL-B (CAP)

AUTOSW-LOP-SNCP (VCMON-HP) HP-EXC (VCMON-HP) PWR-FAIL-B (EQPT)

AUTOSW-SDBER-SNCP (VCMON-HP) HP-PLM (VCMON-HP) PWR-FAIL-RET-A (EQPT)

AUTOSW-SFBER-SNCP (VCMON-HP) HP-RFI (VCMON-HP) PWR-FAIL-RET-B (EQPT)

AUTOSW-UNEQ-SNCP (VCMON-HP) HP-TIM (VCMON-HP) PWRRESTART (EQPT)

BKUPMEMP (EQPT) HP-UNEQ (VCMON-HP) RING-MISMATCH (STMN)

BPV (BITS) IMPROPRMVL (CAP) RING-SW-EAST (STMN)

CARLOSS (GIGE) IMPROPRMVL (EQPT) RING-SW-WEST (STMN)

CHANLOSS (STMN) IMPROPRMVL (FAN) ROLL (VCMON-HP)

CIDMISMATCH-A (EQPT) IMPROPRMVL (PIM) ROLL-PEND (VCMON-HP)

CIDMISMATCH-B (EQPT) IMPROPRMVL (PPM) RS-EOC (STMN)

CLKFAIL (EQPT) IMPR-XC (NE) RS-TIM (STMN)

CONTBUS-CLK-A (EQPT) INTRUSION-PSWD (NE) SFTWDOWN (EQPT)

CONTBUS-CLK-B (EQPT) INVMACADR (BPlane) SNTP-HOST (NE)

CONTBUS-IO-A (EQPT) ISIS-ADJ-FAIL (STMN) SSM-DUS (BITS)

CONTBUS-IO-B (EQPT) KB-PASSTHR (STMN) SSM-DUS (STMN)

CONTCOM (EQPT) KBYTE-APS-CHANNEL-FAILURE 
(STMN)

SSM-FAIL (BITS)

CTNEQPT-PB-A (EQPT) LASER-BIAS (EQPT) SSM-FAIL (STMN)

CTNEQPT-PB-B (EQPT) LASER-BIAS (PPM) SSM-LNC (BITS)

CXCHALT (EQPT) LASER-OVER-TEMP (EQPT) SSM-LNC (NE-SREF)

DATAFLT (NE) LASER-OVER-TEMP (PPM) SSM-LNC (STMN)

DBOSYNC (NE) LKOUTPR-S (STMN) SSM-OFF (BITS)

DUP-IPADDR (NE) LOCKOUT-REQ (STMN) SSM-PRC (BITS)

DUP-NODENAME (NE) LOCKOUT-REQ (VCMON-HP) SSM-PRC (NE-SREF)

EHIBATVG (PWR) LOCKOUT-REQ-RING (STMN) SSM-PRC (STMN)

Table 2-6 ONS 15600 SDH Alarm and Condition Alphabetical List (continued)
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2.2  Alarms and Conditions Listed by Alphabetical Entry
ELWBATVG (PWR) LOF (BITS) SSM-SDH-TN (BITS)

ENCAP-MISMATCH-P (POS) LOF (STMN) SSM-SDH-TN (NE-SREF)

EQPT (CAP) LO-LASERBIAS (PPM) SSM-SDH-TN (STMN)

EQPT (EQPT) LO-LASERBIAS (STMN) SSM-SETS (BITS)

EQPT (PIM) LO-RXPOWER (STMN) SSM-SETS (NE-SREF)

EQPT (PPM) LOS (BITS) SSM-SETS (STMN)

EQPT-BOOT (EQPT) LOS (STMN) SSM-SMC (BITS)

EQPT-CC-PIM (PIM) LO-TXPOWER (PPM) SSM-SMC (NE-SREF)

EQPT-HITEMP (EQPT) LO-TXPOWER (STMN) SSM-SMC (STMN)

EQPT-PIM-PPM (PPM) LPBKCRS (VCMON-HP) SSM-STU (BITS)

E-W-MISMATCH (STMN) LPBKFACILITY (GIGE) SSM-STU (NE-SREF)

EXERCISE-RING-FAIL (STMN) LPBKFACILITY (STMN) SSM-STU (STMN)

EXT (ENVALRM) LPBKPAYLOAD (STMN) SWTOPRI (EXT-SREF)

EXTRA-TRAF-PREEMPT (STMN) LPBKTERMINAL (GIGE) SWTOPRI (NE-SREF)

FAILTOSW (STMN) LPBKTERMINAL (STMN) SWTOSEC (EXT-SREF)

FAILTOSW-HO (VCMON-HP) LWBATVG (PWR) SWTOSEC (NE-SREF)

FAILTOSWR (STMN) MAN-REQ (VCMON-HP) SWTOTHIRD (EXT-SREF)

FAILTOSWS (STMN) MANRESET (EQPT) SWTOTHIRD (NE-SREF)

FAN-DEGRADE (FAN) MANRESET (PIM) SW-VER (EQPT)

FAN-FAIL (FAN) MANRESET (PPM) SYNCCLK (NE)

FAN-FAIL-PARTIAL (FAN) MANSWTOINT (NE-SREF) SYNC-FREQ (BITS)

FAN-PWR (FAN) MANSWTOPRI (EXT-SREF) SYNC-FREQ (STMN)

FE-FRCDWKSWBK-SPAN (STMN) MANSWTOPRI (NE-SREF) SYNCPRI (EXT-SREF)

FE-FRCDWKSWPR-RING (STMN) MANSWTOSEC (EXT-SREF) SYNCPRI (NE-SREF)

FE-FRCDWKSWPR-SPAN (STMN) MANSWTOSEC (NE-SREF) SYNCSEC (EXT-SREF)

FE-LOCKOUTOFPR-ALL (STMN) MANSWTOTHIRD (EXT-SREF) SYNCSEC (NE-SREF)

FE-LOCKOUTOFPR-SPAN (STMN) MANSWTOTHIRD (NE-SREF) SYNCTHIRD (EXT-SREF)

FE-MANWKSWBK-SPAN (STMN) MANUAL-REQ-RING (STMN) SYSBOOT (NE)

FE-MANWKSWPR-RING (STMN) MANUAL-REQ-SPAN (STMN) TPTFAIL (POS)

FE-MANWKSWPR-SPAN (STMN) MATECLK (EQPT) UNPROT-SYNCCLK (NE)

FEPRLF (STMN) MEA (EQPT) UNPROT-XCMTX (NE)

FE-SF-SPAN (STMN) MEA (PIM) UNQUAL-PPM (PPM)

FORCED-REQ (VCMON-HP) MEA (PPM) UNROUTEABLE-IP (NE)

FORCED-REQ-RING (STMN) MEM-GONE (EQPT) UPGRADE (NE)

FORCED-REQ-SPAN (STMN) MEM-LOW (EQPT) VOLT-MISM (PWR)

FRCDSWTOINT (NE-SREF) MFGMEM (CAP) WKSWPR (STMN)

FRCDSWTOPRI (EXT-SREF) MFGMEM (EQPT) WKSWPR (VCMON-HP)

Table 2-6 ONS 15600 SDH Alarm and Condition Alphabetical List (continued)
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2.3  Alarm Logical Objects
2.3 Alarm Logical Objects
The CTC alarm profile list organizes all alarms and conditions according to the logical objects they are 
raised against. These logical objects represent physical objects such as cards, logical objects such as 
circuits, or transport and signal monitoring entities such as the SDH optical overhead bits. One alarm 
can appear in multiple entries. It can be raised against multiple objects. For example, the loss of signal 
(LOS) alarm can be raised against the optical signal (STM-N) or the building integrated timing supply 
(BITS) clock as well as other objects. Therefore, both STMN: LOS and BITS: LOS appear in the list (as 
well as the other objects).

Alarm profile list objects are defined in Table 2-7.

Note Alarm logical object names can appear as abbreviated versions of standard terms used in the system and 
the documentation. For example, the “STMN” logical object refers to the STM-N signal. Logical object 
names or industry-standard terms are used within the entries as appropriate.

FRCDSWTOPRI (NE-SREF) MFGMEM (FAN) WTR (STMN)

FRCDSWTOSEC (EXT-SREF) MFGMEM (PIM) WTR (VCMON-HP)

FRCDSWTOSEC (NE-SREF) MFGMEM (PPM) WVL-OUT-OF-LOCK (STMN)

FRCDSWTOTHIRD (EXT-SREF) MS-AIS (STMN) XCMTX (NE)

FRCDSWTOTHIRD (NE-SREF) MS-DEG (STMN) —

FREQ-MISMATCH (EQPT) SSM-OFF (STMN) —

Table 2-6 ONS 15600 SDH Alarm and Condition Alphabetical List (continued)

Table 2-7 Alarm Logical Object Type Definitions

Type Description

BITS Building integrated timing supply incoming references (BITS-1, BITS-2).

BPLANE The backplane.

CAP Customer access panel (CAP).

ENVALRM An environmental alarm port.

EQPT A card, its physical objects, and logical objects as they are located in any of the eight 
noncommon card slots. The EQPT object is used for alarms that refer to the card 
itself and all other objects on the card including ports, lines, high-order paths 
(HOPs), and low-order paths (LOPs).

EXT-SREF BITS outgoing references (SYNC-BITS1, SYNC-BITS2).

FAN Fan-tray assembly.

GIGE Gigabit Ethernet.

NE The entire network element.

NE-SREF The timing status of the NE.

PIM Pluggable input-output module (or 4PIO) for the ASAP card.

POS Packet over SDH (virtual entity).
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2.4 Alarm List by Logical Object Type 
Table 2-8 lists all ONS 15600 SDH Software Release 8.0 alarms and logical objects as they are given in 
the system alarm profile. The list entries are organized logical object name and then by alarm or 
condition name. Each entry refers to an alarm description in this chapter. Where appropriate, the alarm 
entries also contain troubleshooting procedures.

Note In a mixed network containing different types of nodes (such as an ONS 15310-CL, ONS 15454 SDH, 
and ONS 15600 SDH), the initially displayed alarm list in the Provisioning > Alarm Profiles > Alarm 
Profile Editor tab lists all conditions that are applicable to all nodes in the network. However, when you 
load the default severity profile from a node, only applicable alarms will display severity levels. 
Nonapplicable alarms can display “use default” or “unset.”

Note In some cases this list does not follow alphabetical order, but it does reflect the order shown in CTC.

PPM Pluggable port module (PPM), or Small Form-factor Pluggable (SFP), for the ASAP 
card.

PWR The node’s power supply.

STMN An STM-N line on an STM-N card.

VCMON-HP High-order path virtual concatenation monitoring.

Note The network element reports alarms or conditions on ingress ports of the 
card. Alarms detected at the internal ports (TERM side) will be ingress 
mapped to the MON side. The alarm profile entities of VCMON-HP, if 
available, should be changed to the same severity as the customized severity 
for a specific VCMON-HP alarm.

Table 2-7 Alarm Logical Object Type Definitions (continued)

Table 2-8 ONS 15600 SDH Alarm List by Logical Object in Alarm Profile

BITS: AIS (NR) NE-SREF: FRCDSWTOTHIRD (NA) STMN: FE-FRCDWKSWPR-SPAN (NA)

BITS: BPV (MN) NE-SREF: FRNGSYNC (NA) STMN: FE-LOCKOUTOFPR-ALL (NA)

BITS: LOF (MN) NE-SREF: HLDOVRSYNC (NA) STMN: FE-LOCKOUTOFPR-SPAN (NA)

BITS: LOS (MN) NE-SREF: MANSWTOINT (NA) STMN: FE-MANWKSWBK-SPAN (NA)

BITS: SSM-DUS (NA) NE-SREF: MANSWTOPRI (NA) STMN: FE-MANWKSWPR-RING (NA)

BITS: SSM-FAIL (MN) NE-SREF: MANSWTOSEC (NA) STMN: FE-MANWKSWPR-SPAN (NA)

BITS: SSM-LNC (NA) NE-SREF: MANSWTOTHIRD (NA) STMN: FE-SF-SPAN (NA)

BITS: SSM-OFF (NA) NE-SREF: SSM-LNC (NA) STMN: FEPRLF (MN)

BITS: SSM-PRC (NA) NE-SREF: SSM-PRC (NA) STMN: FORCED-REQ-RING (NA)

BITS: SSM-SDH-TN (NA) NE-SREF: SSM-SDH-TN (NA) STMN: FORCED-REQ-SPAN (NA)

BITS: SSM-SETS (NA) NE-SREF: SSM-SETS (NA) STMN: FULLPASSTHR-BI (NA)

BITS: SSM-SMC (NA) NE-SREF: SSM-SMC (NA) STMN: HELLO (MN)
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BITS: SSM-STU (NA) NE-SREF: SSM-STU (NA) STMN: HI-LASERBIAS (MN)

BITS: SYNC-FREQ (NA) NE-SREF: SWTOPRI (NA) STMN: HI-RXPOWER (MN)

BPLANE: INVMACADR (MJ) NE-SREF: SWTOSEC (NA) STMN: HI-TXPOWER (MN)

BPLANE: PWR-FA (MN) NE-SREF: SWTOTHIRD (NA) STMN: ISIS-ADJ-FAIL (MN)

CAP: EQPT (MN) NE-SREF: SYNCPRI (MJ) STMN: KB-PASSTHR (NA)

CAP: IMPROPRMVL (MN) NE-SREF: SYNCSEC (MN) STMN: 
KBYTE-APS-CHANNEL-FAILURE 
(MN)

CAP: MFGMEM (MN) NE: AUD-LOG-LOSS (NA) STMN: LKOUTPR-S (NA)

CAP: PWR-FAIL-A (MN) NE: AUD-LOG-LOW (NA) STMN: LO-LASERBIAS (MN)

CAP: PWR-FAIL-B (MN) NE: DATAFLT (MN) STMN: LO-RXPOWER (MN)

ENVALRM: EXT (MN) NE: DBOSYNC (MJ) STMN: LO-TXPOWER (MN)

EQPT: AUTORESET (MN) NE: DUP-IPADDR (MN) STMN: LOCKOUT-REQ (NA)

EQPT: BKUPMEMP (CR) NE: DUP-NODENAME (MN) STMN: LOCKOUT-REQ-RING (NA)

EQPT: CIDMISMATCH-A (MN) NE: IMPR-XC (MN) STMN: LOF (CR)

EQPT: CIDMISMATCH-B (MN) NE: INTRUSION-PSWD (NA) STMN: LOS (CR)

EQPT: CLKFAIL (MJ) NE: SNTP-HOST (MN) STMN: LPBKFACILITY (NA)

EQPT: CONTBUS-CLK-A (MN) NE: SYNCCLK (CR) STMN: LPBKPAYLOAD (NA)

EQPT: CONTBUS-CLK-B (MN) NE: SYSBOOT (MJ) STMN: LPBKTERMINAL (NA)

EQPT: CONTBUS-IO-A (MN) NE: UNPROT-SYNCCLK (MN) STMN: MANUAL-REQ-RING (NA)

EQPT: CONTBUS-IO-B (MN) NE: UNPROT-XCMTX (MN) STMN: MANUAL-REQ-SPAN (NA)

EQPT: CONTCOM (MN) NE: UNROUTEABLE-IP (MN) STMN: MS-AIS (NR)

EQPT: CTNEQPT-PB-A (CR) NE: UPGRADE (NA) STMN: MS-DEG (NA)

EQPT: CTNEQPT-PB-B (CR) NE: XCMTX (CR) STMN: MS-EOC (MN)

EQPT: CXCHALT (MJ) PIM: EQPT (CR) STMN: MS-EXC (NA)

EQPT: EQPT (CR) PIM: EQPT-CC-PIM (CR) STMN: MS-RFI (NR)

EQPT: EQPT-BOOT (CR) PIM: IMPROPRMVL (CR) STMN: MS-SQUELCH-HP (NA)

EQPT: EQPT-HITEMP (MN) PIM: MANRESET (NA) STMN: MSSP-SW-VER-MISM (MN)

EQPT: FREQ-MISMATCH (MN) PIM: MEA (CR) STMN: PRC-DUPID (MJ)

EQPT: FSTSYNC (NA) PIM: MFGMEM (CR) STMN: RING-MISMATCH (MJ)

EQPT: IMPROPRMVL (CR) POS: ENCAP-MISMATCH-P (CR) STMN: RING-SW-EAST (NA)

EQPT: LASER-BIAS (CR) POS: GFP-LFD (MJ) STMN: RING-SW-WEST (NA)

EQPT: LASER-OVER-TEMP (CR) POS: GFP-UP-MISMATCH (MJ) STMN: RS-EOC (MN)

EQPT: MANRESET (NA) POS: TPTFAIL (MJ) STMN: RS-TIM (CR)

EQPT: MATECLK (MN) PPM: EQPT (CR) STMN: SSM-DUS (NA)

EQPT: MEA (CR) PPM: EQPT-PIM-PPM (CR) STMN: SSM-FAIL (MN)

EQPT: MEM-GONE (MJ) PPM: HI-LASERBIAS (MN) STMN: SSM-LNC (NA)

EQPT: MEM-LOW (MN) PPM: HI-TXPOWER (MN) STMN: SSM-OFF (NA)

Table 2-8 ONS 15600 SDH Alarm List by Logical Object in Alarm Profile (continued)
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EQPT: MFGMEM (CR) PPM: IMPROPRMVL (CR) STMN: SSM-PRC (NA)

EQPT: OPEN-SLOT (MN) PPM: LASER-BIAS (CR) STMN: SSM-SDH-TN (NA)

EQPT: PWR-FAIL-A (MN) PPM: LASER-OVER-TEMP (CR) STMN: SSM-SETS (NA)

EQPT: PWR-FAIL-B (MN) PPM: LO-LASERBIAS (MN) STMN: SSM-SMC (NA)

EQPT: PWR-FAIL-RET-A (MN) PPM: LO-TXPOWER (MN) STMN: SSM-STU (NA)

EQPT: PWR-FAIL-RET-B (MN) PPM: MANRESET (NA) STMN: SYNC-FREQ (NA)

EQPT: PWRRESTART (NA) PPM: MEA (CR) STMN: WKSWPR (NA)

EQPT: SFTWDOWN (MN) PPM: MFGMEM (CR) STMN: WTR (NA)

EQPT: SW-VER (NA) PPM: NON-CISCO-PPM (MN) STMN: WVL-OUT-OF-LOCK (MJ)

EXT-SREF: FRCDSWTOPRI (NA) PPM: PROV-MISMATCH (MN) VCMON-HP: AU-AIS (NR)

EXT-SREF: FRCDSWTOSEC (NA) PPM: UNQUAL-PPM (MN) VCMON-HP: AU-LOP (CR)

EXT-SREF: FRCDSWTOTHIRD (NA) PWR: EHIBATVG (MJ) VCMON-HP: AUTOSW-AIS-SNCP (NR)

EXT-SREF: MANSWTOPRI (NA) PWR: ELWBATVG (MJ) VCMON-HP: AUTOSW-LOP-SNCP (NA)

EXT-SREF: MANSWTOSEC (NA) PWR: HIBATVG (MJ) VCMON-HP: AUTOSW-SDBER-SNCP 
(NA)

EXT-SREF: MANSWTOTHIRD (NA) PWR: LWBATVG (MJ) VCMON-HP: AUTOSW-SFBER-SNCP 
(NA)

EXT-SREF: SWTOPRI (NA) PWR: PWR (MJ) VCMON-HP: AUTOSW-UNEQ-SNCP 
(NA)

EXT-SREF: SWTOSEC (NA) PWR: VOLT-MISM (NA) VCMON-HP: FAILTOSW-HO (NA)

EXT-SREF: SWTOTHIRD (NA) STMN: ALS (NA) VCMON-HP: FORCED-REQ (NA)

EXT-SREF: SYNCPRI (MN) STMN: APSB (MN) VCMON-HP: HP-DEG (NA)

EXT-SREF: SYNCSEC (MN) STMN: APSC-IMP (MN) VCMON-HP: HP-EXC (NA)

EXT-SREF: SYNCTHIRD (MN) STMN: APSCDFLTK (MN) VCMON-HP: HP-PLM (CR)

FAN: FAN-DEGRADE (MN) STMN: APSCINCON (MN) VCMON-HP: HP-RFI (NR)

FAN: FAN-FAIL (CR) STMN: APSCM (MJ) VCMON-HP: HP-TIM (MN)

FAN: FAN-FAIL-PARTIAL (MJ) STMN: APSCNMIS (MJ) VCMON-HP: HP-UNEQ (CR)

FAN: FAN-PWR (MN) STMN: CHANLOSS (NA) VCMON-HP: LOCKOUT-REQ (NA)

FAN: IMPROPRMVL (CR) STMN: E-W-MISMATCH (MJ) VCMON-HP: LPBKCRS (NA)

FAN: MFGMEM (CR) STMN: EXERCISE-RING-FAIL (NA) VCMON-HP: MAN-REQ (NA)

GIGE: CARLOSS (MJ) STMN: EXTRA-TRAF-PREEMPT 
(MJ)

VCMON-HP: ROLL (NA)

GIGE: LPBKFACILITY (NA) STMN: FAILTOSW (NA) VCMON-HP: ROLL-PEND (NA)

GIGE: LPBKTERMINAL (NA) STMN: FAILTOSWR (NA) VCMON-HP: WKSWPR (NA)

NE-SREF: FRCDSWTOINT (NA) STMN: FAILTOSWS (NA) VCMON-HP: WTR (NA)

NE-SREF: FRCDSWTOPRI (NA) STMN: FE-FRCDWKSWBK-SPAN 
(NA)

—

NE-SREF: FRCDSWTOSEC (NA) STMN: FE-FRCDWKSWPR-RING 
(NA)

—

Table 2-8 ONS 15600 SDH Alarm List by Logical Object in Alarm Profile (continued)
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2.5 Trouble Notifications
The ONS 15600 SDH system reports trouble by utilizing standard alarm and condition characteristics, 
standard severities following the rules in Telcordia GR-253-CORE, and graphical user interface (GUI) 
state indicators. These notifications are described in the following paragraphs.

The ONS 15600 SDH uses standard Telcordia categories to characterize levels of trouble. The system 
reports trouble notifications as alarms and status or descriptive notifications (if configured to do so) as 
conditions in the CTC Alarms window. Alarms typically signify a problem that the user needs to remedy, 
such as a loss of signal. Conditions do not necessarily require troubleshooting.

2.5.1 Alarm Characteristics
The ONS 15600 SDH uses standard alarm entities to identify what is causing trouble. All alarms stem 
from hardware, software, environment, or operator-originated problems whether or not they affect 
service. Current alarms for the network, CTC session, node, or card are listed in the Alarms tab. (In 
addition, cleared alarms are also found in the History tab.)

2.5.2 Condition Characteristics
Conditions include any problem detected on an ONS 15600 SDH shelf. They might include standing or 
transient notifications. A snapshot of all current raised, standing conditions on the network, node, or card 
can be retrieved in the CTC Conditions window or using TL1's set of RTRV-COND commands. (In 
addition, some but not all cleared conditions are also found in the History tab.)

For a comprehensive list of all conditions, refer to the Cisco ONS SDH TL1 Command Guide. For a 
comprehensive list of all transient conditions, see Chapter 3, “Transient Conditions.”

2.5.3 Severities
The ONS 15600 SDH uses Telcordia-devised standard severities for alarms and conditions:

• A Critical (CR) alarm generally indicates severe, Service-Affecting (SA) trouble that needs 
immediate correction. 

• A Major (MJ) alarm is a serious alarm, but the trouble has less impact on the network.

• Minor (MN) alarms generally are those that do not affect service. For example, the automatic 
protection switching (APS) byte failure (APSB) alarm indicates that line terminating equipment 
(LTE) detects a byte failure on the signal that could prevent traffic from properly executing a traffic 
switch.

• Not Alarmed (NA) conditions are information indicators, such as for the free-running 
synchronization (FRNGSYNC) state. They might or might not require troubleshooting, as indicated 
in the entries.

• Not Reported (NR) conditions occur as a secondary result of another event. For example, the alarm 
indication signal (AIS), with severity NR, is inserted by a downstream node when an LOS (CR or 
MJ) alarm occurs upstream. These conditions do not in themselves require troubleshooting, but are 
to be expected in the presence of primary alarms.
2-11
Cisco ONS 15600 SDH Troubleshooting Guide, R8.0

July 2010



Chapter 2 Alarm Troubleshooting
2.5.4  Alarm Hierarchy
Severities can be customized for an entire network or for single nodes, from the network level down to 
the port level by changing or downloading customized alarm profiles. These custom severities are 
subject to the standard severity-demoting rules given in Telcordia GR-474-CORE and shown in the 
2.5.4 Alarm Hierarchy section. Procedures for customizing alarm severities are located in the “Manage 
Alarms” chapter in the Cisco ONS 15600 SDH Procedure Guide.

2.5.4 Alarm Hierarchy
All alarm, condition, and unreported event severities listed in this manual are default profile settings. 
However in situations when traffic is not lost, such as when the alarm occurs on protected ports or 
circuits, alarms having Critical (CR) or Major (MJ) default severities can be demoted to lower severities 
such as Minor (MN) or Non-Service-Affecting (NSA) as defined in Telcordia GR-474-CORE. 

A path alarm can be demoted if a higher-ranking alarm is raised for the same object. For example, If an 
high-order path trace identifier mismatch (HP-TIM) is raised on a circuit path and then an administrative 
unit (AU) loss of pointer (LOP) is raised on it, the AU-LOP alarm stands and the HP-TIM closes. The 
path alarm hierarchy used in the ONS 15600 SDH system is shown in Table 2-9.

Facility (port) alarms also follow a hierarchy, which means that lower-ranking alarms are closed by 
higher-ranking alarms. The facility alarm hierarchy used in the ONS 15600 SDH system is shown in 
Table 2-10.

Table 2-9 Path Alarm Hierarchy

Priority Condition Type

Highest AU-AIS

— AU-LOP

— HP-UNEQ

Lowest HP-TIM

Table 2-10 Facility Alarm Hierarchy

Priority Condition Type

Highest LOS

— LOF

— MS-AIS

— MS-EXC1 

— MS-DEG1 

— MS-RDI1

— RS-TIM

— AU-AIS

— AU-LOP

— HP-EXC1

— HP-DEG1 

— HP-UNEQ
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Near-end failures and far-end failures follow different hierarchies. Near-end failures stand according to 
whether they are for the entire signal (LOS, LOF), facility (MS-AIS), path (AU-AIS, etc.) or VT 
(TU-AIS, etc.). The full hierarchy for near-end failures is shown in Table 2-11. This table is taken from 
Telcordia GR-253-CORE.

The far-end failure alarm hierarchy is shown in Table 2-12, as given in Telcordia GR-253-CORE.

— HP-TIM

Lowest HP-PLM1

1. This alarm is not currently used in the platform.

Table 2-10 Facility Alarm Hierarchy

Priority Condition Type

Table 2-11 Near-End Alarm Hierarchy

Priority Condition Type

Highest LOS

— LOF

— MS-AIS

— AU-AIS1

1. Although it is not defined as a defect or failure, all-ones VT pointer relay is also 
higher priority than AU-LOP. Similarly, all-ones VC pointer relay is higher 
priority than TU-LOP.

— AU-LOP2

2. AU-LOP is also higher priority than the far-end failure MS-RFI, which does not 
affect the detection of any near-end failures. Similarly, TU-LOP is higher priority 
than LP-RF.

— HP-UNEQ

— HP-TIM

— HP-PLM

— TU-AIS1

— TU-LOP2

— LP-UNEQ3

3. This alarm is not used in this platform in this release.

— LP-PLM3

Lowest DS-N AIS (if reported for 
outgoing DS-N signals)

Table 2-12 Far-End Alarm Hierarchy

Priority Condition Type

Highest MS-RDI1

— HP-RFI

Lowest LP-RFI1 
2-13
Cisco ONS 15600 SDH Troubleshooting Guide, R8.0

July 2010



Chapter 2 Alarm Troubleshooting
2.5.5  Service Effect
2.5.5 Service Effect
Service-Affecting (SA) alarms—those that interrupt service—might be Critical (CR) or Major (MJ) 
severity alarms. Service-Affecting (SA) alarms indicate service is affected. 
Non-Service-Affecting (NSA) alarms always have a Minor (MN), Not Alarmed (NA), or Not 
Reported (NR) severity. 

2.5.6 States
The Alarms and History tab State (ST) columns indicate the disposition of alarms and conditions as 
follows:

• A raised (R) event is one that is active.

• A cleared (C) event is one that is no longer active.

• A transient (T) event is one that is automatically raised and cleared in CTC during system changes 
such as user login, logout, loss of connection to node view, etc. Transient events do not require user 
action. These are listed in Chapter 3, “Transient Conditions.”

2.5.7 Safety Summary
This section covers safety considerations to ensure safe operation of the ONS 15600 SDH system. 
Personnel should not perform any procedures in this manual unless they understand all safety 
precautions, practices, and warnings for the system equipment. Some troubleshooting procedures 
require installation or removal of cards. In these instances, users should pay close attention to the 
following caution:

Caution Hazardous voltage or energy might be present on the backplane when the system is operating. Use 
caution when removing or installing cards.

Some troubleshooting procedures require installation or removal of optical cards. In these instances, 
users should pay close attention to the following warnings:

Warning Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector. 
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain 
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of 
100 mm could pose an eye hazard. Statement 1056 

Warning Use of controls, adjustments, or performing procedures other than those specified may result in 
hazardous radiation exposure. Statement 1057

Warning Class 1 laser product. Statement 1008

1. This condition is not used in this platform in this release.
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Warning Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed 
circuitry could constitute an energy hazard. Statement 206

Warning The power supply circuitry for the equipment can constitute an energy hazard. Before you install or 
replace the equipment, remove all jewelry (including rings, necklaces, and watches). Metal objects 
can come into contact with exposed power supply wiring or circuitry inside the DSLAM equipment. 
This could cause the metal objects to heat up and cause serious burns or weld the metal object to the 
equipment. Statement 207

2.6 Alarm Procedures
This section lists alarms alphabetically and includes some conditions commonly encountered when 
troubleshooting alarms. The severities, descriptions, and troubleshooting procedures accompany alarms 
and conditions.

Note When an entity is put in the Out of Service and Maintenance (Locked,maintenance) administrative state, 
the ONS 15600 SDH suppresses all standing alarms on that entity. All alarms and events appear on the 
Conditions tab. You can change this behavior for the LPBKFACILITY, LPBKPAYLD, and 
LPBKTERMINAL alarms. To display these alarms on the Alarms tab, set the 
NODE.general.ReportLoopbackConditionsOnPortsInOOS-MT to TRUE on the NE Defaults tab.

2.6.1 AIS
Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)

Logical Object: BITS

The Alarm Indication Signal (AIS) condition indicates that this node is detecting an alarm indication 
signal in the incoming signal SDH overhead.

Generally, any AIS is a special SDH signal that communicates to the receiving node when the transmit 
node does not send a valid signal. AIS is not considered an error. It is raised by the receiving node on 
each input when the node sees the AIS instead of a real signal. In most cases when this condition is 
raised, an upstream node is raising an alarm to indicate a signal failure; all nodes downstream from it 
only raise some type of AIS. This condition clears when you resolved the problem on the upstream node.

Clear the AIS Condition

Step 1 Determine whether there are alarms on the upstream nodes and equipment, especially the “LOS 
(STMN)” alarm on page 2-86 or if there are out-of-service (Locked,maintenance or Locked,disabled) 
ports.

Step 2 Clear the upstream alarms using the applicable procedures in this chapter.
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2.6.2  ALS
Step 3 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.6.2 ALS
For information about this condition, refer to the “Alarm Troubleshooting” chapter of the 
Cisco ONS 15454 DWDM Troubleshooting Guide.

2.6.3 APSB
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

Logical Object: STMN

The APS Channel Byte Failure alarm occurs when LTE detects protection switching byte failure or an 
invalid switching code in the incoming APS signal. Some older SDH nodes not manufactured by Cisco 
send invalid APS codes if they are configured in a 1+1 protection scheme with newer SDH nodes, such 
as the ONS 15600 SDH. These invalid codes cause an APSB alarm on an ONS 15600 SDH.

Note APS switches are hitless on the ONS 15600 SDH.

Clear the APSB Alarm

Step 1 Use an optical test set to examine the incoming SDH overhead to confirm inconsistent or invalid K bytes. 
For specific procedures to use the test set equipment, consult the manufacturer. If corrupted K bytes are 
confirmed and the upstream equipment is functioning properly, the upstream equipment might not 
interoperate effectively with the ONS 15600 SDH.

Caution Always use the supplied electrostatic discharge wristband when working with a powered 
ONS 15600 SDH. Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf 
assembly.

Step 2 If the alarm does not clear and the overhead shows inconsistent or invalid K bytes, you might need to 
replace the upstream cards for protection switching to operate properly. Complete the “Replace an I/O 
Card” procedure on page 2-134. 

Caution For the ONS 15600 SDH, removing a card that currently carries traffic on one or more ports can cause 
a traffic hit. To avoid this, perform an external switch if a switch has not already occurred. See the 
“2.8.5 Verify or Create Node DCC Terminations” section on page 2-139 for commonly used alarm 
troubleshooting procedures.

Note When you replace a card with the identical type of card, you do not need to make any changes 
to the database.
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Step 3 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447).

2.6.4 APSCDFLTK
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

Logical Object: STMN

The APS Default K Byte Received alarm occurs when a bidirectional line switched ring (MS-SPRing) 
is not properly configured—for example, when a four-node MS-SPRing has one node configured as a 
unidirectional path switched ring (SNCP). When this misconfiguration occurs, a node in an SNCP or 1+1 
configuration does not send the two valid K1/K2 APS bytes anticipated by a system configured for 
MS-SPRing. One of the bytes sent is considered invalid by the MS-SPRing configuration. The K1/K2 
byte is monitored by receiving equipment for link-recovery information.

Clear the APSCDFLTK Alarm

Step 1 Complete the “Identify an MS-SPRing Ring ID or Node ID Number” procedure on page 2-122 to verify 
that each node has a unique node ID number.

Step 2 Repeat Step 1 for all nodes in the ring.

Step 3 If two nodes have the same node ID number, complete the “Change an MS-SPRing Node ID Number” 
procedure on page 2-122 to change one node ID number so that each node ID is unique.

Step 4 If the alarm does not clear, verify correct configuration of east port and west port optical fibers. (See the 
“E-W-MISMATCH” alarm on page 2-48.) West port fibers must connect to east port fibers and east port 
fibers must connect to west port fibers. The “Install Cards and Fiber-Optic Cable” chapter in the 
Cisco ONS 15600 SDH Procedure Guide contains procedures for fibering an MS-SPRing.

Step 5 If the alarm does not clear and if the network is a four-fiber MS-SPRing, ensure that each protect fiber 
is connected to another protect fiber and each working fiber is connected to another working fiber. The 
software does not report any alarm if a working fiber is incorrectly attached to a protect fiber.

Step 6 If the alarm does not clear, complete the “Verify Node Visibility for Other Nodes” procedure on 
page 2-123.

Step 7 If nodes are not visible, complete the “2.8.5 Verify or Create Node DCC Terminations” procedure on 
page 2-139 to ensure that SDH data communication channel (DCC) terminations exist on each node.

Step 8 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447).

2.6.5 APSC-IMP
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

Logical Object: STMN

An Improper SDH APS Code alarm indicates three consecutive, identical frames containing:

• Unused code in bits 6 through 8 of byte K2.
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• Codes that are irrelevant to the specific protection switching operation being requested.

• Requests that are irrelevant to the ring state of the ring (such as a span protection switch request in 
a two-fiber ring NE).

• ET code in K2 bits 6 through 8 received on the incoming span, but not sourced from the outgoing 
span.

Note This alarm can occur on a VC_LO_PATH_TUNNEL tunnel when it does not have lower order circuits 
provisioned on it. It can also occur when the exercise command or a lockout is applied to a span. An 
externally switched span does not raise this alarm because the traffic is preempted.

Note The APSC-IMP alarm may be raised on a MS-SPRing when a drop connection is part of a cross-connect 
loopback.

Note The APSC-IMP alarm may be momentarily raised on BLSR spans during PCA circuit creation or 
deletion across multiple nodes using CTC.

Warning Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector. 
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain 
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of 
100 mm could pose an eye hazard. Statement 1056 

Warning Use of controls, adjustments, or performing procedures other than those specified may result in 
hazardous radiation exposure. Statement 1057

Clear the APSC-IMP Alarm

Step 1 Use an optical test set to determine the validity of the K byte signal by examining the received signal. 
For specific procedures to use the test set equipment, consult the manufacturer.

Caution Always use the supplied electrostatic discharge wristband when working with a powered 
ONS 15600 SDH. Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf 
assembly.

If the K byte is invalid, the problem lies with upstream equipment and not with the reporting 
ONS 15600 SDH. Troubleshoot the upstream equipment using the procedures in this chapter, as 
applicable. If the upstream nodes are not ONS 15600 SDHs, consult the appropriate user documentation.

Step 2 If the K byte is valid, verify that each node has a ring name that matches the other node ring names. 
Complete the “Identify an MS-SPRing Ring ID or Node ID Number” procedure on page 2-122.

Step 3 Repeat Step 2 for all nodes in the ring.

Step 4 If a node has a ring name that does not match the other nodes, make that node’s ring name identical to 
the other nodes. Complete the “Change an MS-SPRing Ring ID Number” procedure on page 2-122.
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Step 5 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447).

2.6.6 APSCINCON
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

Logical Object: STMN

An APS Inconsistent alarm means that an inconsistent APS byte is present in the SDH overhead. The 
SDH overhead contains K1/K2 APS bytes that notify receiving equipment, such as the ONS 15600 SDH, 
to switch the SDH signal from a working to a protect path when necessary. An inconsistent APS code 
occurs when three consecutive frames contain nonidentical APS bytes, which in turn give the receiving 
equipment conflicting commands about switching.

Clear the APSCINCON Alarm

Step 1 Look for other alarms, especially the “LOS (STMN)” alarm on page 2-86, the “LOF (STMN)” alarm on 
page 2-82, or the “AIS” condition on page 2-15. Clearing these alarms clears the APSCINCON alarm.

Step 2 If an APSINCON alarm occurs with no other alarms, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.6.7 APSCM
Default Severity: Major (MJ), Service-Affecting (SA)

Logical Object: STMN

The APS Channel Mismatch alarm occurs when the ONS system expects a working channel but receives 
a protect channel. In many cases, the working and protect channels are crossed and the protect channel 
is active. If the fibers are crossed and the working line is active, the alarm does not occur. The APSCM 
alarm occurs only on the ONS system when bidirectional protection is used on STM-N cards in a 1+1 
configuration.

Warning Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector. 
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain 
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of 
100 mm could pose an eye hazard. Statement 1056 

Warning Use of controls, adjustments, or performing procedures other than those specified may result in 
hazardous radiation exposure. Statement 1057

Note APS switches are hitless in the ONS 15600 SDH.
2-19
Cisco ONS 15600 SDH Troubleshooting Guide, R8.0

July 2010



Chapter 2 Alarm Troubleshooting
2.6.8  APSCNMIS
Clear the APSCM Alarm

Step 1 Verify that the working-card channel fibers are physically connected directly to the adjoining node’s 
working-card channel fibers.

Caution Always use the supplied electrostatic discharge wristband when working with a powered 
ONS 15600 SDH. Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf 
assembly.

Step 2 If the fibers are correctly connected, verify that the protection-card channel fibers are physically 
connected directly to the adjoining node’s protection-card channel fibers.

Step 3 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447) to report a Service-Affecting (SA) problem.

2.6.8 APSCNMIS
Default Severity: Major (MJ), Service-Affecting (SA)

Logical Object: STMN

The APS Node ID Mismatch alarm occurs when the source node ID contained in the incoming APS 
channel K2 byte is not present in the ring map. The APSCNMIS alarm could occur and clear when a 
MS-SPRing is being provisioned. If so, you can disregard the temporary occurrence. If the APSCNMIS 
remains, the alarm clears when a K byte with a valid source node ID is received.

Clear the APSCNMIS Alarm

Step 1 Complete the “Identify an MS-SPRing Ring ID or Node ID Number” procedure on page 2-122 to verify 
that each node has a unique node ID number.

Step 2 If the Node ID column contains any two nodes with the same node ID listed, record the repeated node ID.

Step 3 Click Close in the Ring Map dialog box.

Step 4 If two nodes have the same node ID number, complete the “Change an MS-SPRing Node ID Number” 
procedure on page 2-122 to change one node ID number so that each node ID is unique.

Note If the node names shown in the network view do not correlate with the node IDs, log into each 
node and click the Provisioning > MS-SPRing tabs. The MS-SPRing window shows the node 
ID of the login node.

Note Applying and removing a lockout on a span causes the ONS node to generate a new K byte. The 
APSCNMIS alarm clears when the node receives a K byte containing the correct node ID.

Step 5 If the alarm does not clear, use the “Initiate a Lock Out on a MS-SPRing Protect Span” procedure on 
page 2-129 to lock out the span.
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Step 6 Complete the “Clear a MS-SPRing External Switching Command” procedure on page 2-130 to clear the 
lockout.

Step 7 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447) to report a Service-Affecting (SA) problem.

2.6.9 AU-AIS 
Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)

Logical Objects: VCMON-HP

An AU AIS condition applies to the administration unit, which consists of the virtual container (VC) 
capacity and pointer bytes (H1, H2, and H3) in the SDH frame.

Generally, any AIS is a special SDH signal that communicates to the receiving node when the transmit 
node does not send a valid signal. AIS is not considered an error. It is raised by the receiving node on 
each input when it detects the AIS instead of a real signal. In most cases when this condition is raised, 
an upstream node is raising an alarm to indicate a signal failure; all nodes downstream from it only raise 
some type of AIS. This condition clears when you resolved the problem on the upstream node.

Clear the AU-AIS Condition

Step 1 Complete the “Clear the AIS Condition” procedure on page 2-15.

Step 2 If the condition does not clear, complete the “Clear the APSB Alarm” procedure on page 2-16.

Step 3 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or log into  
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free 
Technical Support numbers for your country.

2.6.10 AUD-LOG-LOSS
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Object: NE

The Audit Trail Log Loss condition occurs when the log is 100 percent full and that the oldest entries 
are being replaced as new entries are generated. The log capacity is 640 entries. The log must be 
off-loaded using the following procedure to make room for more entries. 

Clear the AUD-LOG-LOSS Condition

Step 1 In node view, click the Maintenance > Audit tabs.

Step 2 Click Retrieve.

Step 3 Click Archive.
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Step 4 In the Archive Audit Trail dialog box, navigate to the directory (local or network) where you want to 
save the file.

Step 5 Enter a name in the File Name field.

You do not have to assign an extension to the file. It is readable in any application that supports text files, 
such as WordPad, Microsoft Word (imported), etc.

Step 6 Click Save.

The 640 entries are saved in this file. New entries continue with the next number in the sequence, rather 
than starting over.

Step 7 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447).

2.6.11 AUD-LOG-LOW
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Object: NE

The Audit Trail Log Low condition occurs when the audit trail log is 80 percent full.

Note AUD-LOG-LOW is an informational condition. It does not require troubleshooting.

2.6.12 AU-LOP 
Default Severity: Critical (CR), Service-Affecting (SA)

Logical Objects: VCMON-HP

An AU-LOP alarm indicates that the SDH high order path overhead section of the administration unit 
has detected a loss of path. AU-LOP occurs when there is a mismatch between the expected and 
provisioned circuit size.

Warning Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector. 
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain 
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of 
100 mm could pose an eye hazard. Statement 1056 

Warning Use of controls, adjustments, or performing procedures other than those specified could result in 
hazardous radiation exposure. Statement 1057

Clear the AU-LOP Alarm 

Step 1 In node view, click the Circuits tab and view the alarmed circuit.
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Step 2 Verify that the correct circuit size is listed in the Size column. If the size is different from what is 
expected, such as a VC4-4c instead of a VC4, this causes the alarm.

Step 3 If you have been monitoring the circuit with optical test equipment, a mismatch between the provisioned 
circuit size and the size expected by the test set can cause this alarm. Ensure that the test set monitoring 
is set up for the same size as the circuit provisioning. For specific procedures to use the test set 
equipment, consult the manufacturer.

Step 4 If you have not been using a test set, or if the test set is correctly set up, the error is in the provisioned 
CTC circuit size. Delete the circuit.

Step 5 Recreate the circuit for the correct size. For procedures, refer to the “Create Circuits” chapter in the 
Cisco ONS 15600 SDH Procedure Guide.

Step 6 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or log into  http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to 
obtain a directory of toll-free Technical Support numbers for your country in order to report a 
Service-Affecting (SA) problem.

2.6.13 AUTORESET
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

Logical Object: EQPT

The Automatic System Reset alarm occurs when you change an IP address or perform any other 
operation that causes an automatic card-level reboot. Resets performed during a software upgrade also 
prompt the alarm. This condition clears automatically when the card finishes resetting.

Note If an optical card associated with an active port in a 1+1 protection group resets, all DCC traffic 
terminated or tunneled on the active port is lost while the card resets. No DCC traffic is lost during a 
reset of an optical card associated with a standby port.

Clear the AUTORESET Alarm

Step 1 Determine whether there are additional alarms that could have triggered an automatic reset. If there are, 
troubleshoot these alarms using the applicable section of this chapter.

Step 2 If the card automatically resets more than once a month with no apparent cause, complete the “Replace 
an I/O Card” procedure on page 2-134. If the lack of communication continues, the AUTORESET alarm 
is cleared and the 2.6.47 EQPT-BOOT alarm occurs. In this case, no AUTORESET troubleshooting is 
required.

Caution Always use the supplied electrostatic discharge wristband when working with a powered 
ONS 15600 SDH. Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf 
assembly.
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Caution For the ONS 15600 SDH, removing a card that currently carries traffic on one or more ports can cause 
a traffic hit. To avoid this, perform an external switch if a switch has not already occurred. See the 
“2.8.2 Protection Switching, Lock Initiation, and Clearing” section on page 2-123 for commonly used 
traffic-switching procedures.

Note When you replace a card with the identical type of card, you do not need to make any changes 
to the database.

Step 3 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447).

2.6.14 AUTOSW-AIS-SNCP
Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)

Logical Object: VCMON-HP

The Automatic SNCP Switch Caused by an AIS condition indicates that automatic SNCP protection 
switching occurred because of an “AU-AIS” alarm on page 2-21 condition. If the SNCP is configured 
for revertive switching, it reverts to the working path after the fault clears. The AU-AIS also clears when 
the upstream trouble is cleared.

Note This condition is only reported if the SNCP is set up for revertive switching.

Generally, any AIS is a special SDH signal that communicates to the receiving node when the transmit 
node does not send a valid signal. AIS is not considered an error. It is raised by the receiving node on 
each input when it detects the AIS instead of a real signal. In most cases when this condition is raised, 
an upstream node is raising an alarm to indicate a signal failure; all nodes downstream from it only raise 
some type of AIS. This condition clears when you resolve the problem on the upstream node.

Clear the AUTOSW-AIS-SNCP Condition

Step 1 Complete the “Clear the AU-AIS Condition” procedure on page 2-21.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.6.15 AUTOSW-LOP-SNCP 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Object: VCMON-HP
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The Automatic SNCP Switch Caused by LOP condition indicates that automatic SNCP protection 
switching occurred because of the “AU-LOP” alarm on page 2-22. If the SNCP is configured for 
revertive switching, it reverts to the working path after the fault clears.

Note This condition is only reported if the SNCP is set up for revertive switching.

Clear the AUTOSW-LOP-SNCP Condition

Step 1 Complete the “Clear the AU-LOP Alarm” procedure on page 2-22.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.6.16 AUTOSW-SDBER-SNCP
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Object: VCMON-HP

The Automatic SNCP Switch Caused by Signal Degrade Bit Error Rate (SDBER) condition indicates 
that a “MS-DEG” condition on page 2-98 caused automatic SNCP protection switching to occur. If the 
SNCP is configured for revertive switching, the SNCP reverts to the working path when the MS-DEG is 
resolved.

Note This condition is only reported if the SNCP is set up for revertive switching. 

Clear the AUTOSW-SDBER-SNCP Condition

Step 1 Complete the “Clear the MS-DEG Condition” procedure on page 2-98. (The clearing procedure is the 
same for all signal degrade and signal fail alarms.)

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.6.17 AUTOSW-SFBER-SNCP 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Object: VCMON-HP

The Automatic USPR Switch Caused by Signal Fail Bit Error Rate (SFBER) condition indicates that a 
“MS-EXC” condition on page 2-99 caused automatic SNCP protection switching to occur. If the SNCP 
is configured for revertive switching, the SNCP reverts to the working path when the MS-EXC is 
resolved.
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Note This condition is only reported if the SNCP is set up for revertive switching. 

Clear the AUTOSW-SFBER-SNCP Condition

Step 1 Complete the “Clear the MS-EXC Condition” procedure on page 2-99. (The clearing procedure is the 
same for all signal degrade and signal fail alarms).

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.6.18 AUTOSW-UNEQ-SNCP 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Object: VCMON-HP

The Automatic SNCP Switch Caused by Unequipped Circuit condition indicates that an “HP-UNEQ” 
condition on page 2-69 alarm caused automatic SNCP protection switching to occur. If the SNCP is 
configured for revertive switching, it reverts to the working path after the fault clears.

Note This condition is only reported if the SNCP is set up for revertive switching.

Clear the AUTOSW-UNEQ-SNCP Condition

Step 1 Complete the “Clear the HP-UNEQ Alarm” procedure on page 2-69.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.6.19 BKUPMEMP
Default Severity: Critical (CR), Service-Affecting (SA)

Logical Object: EQPT

The Primary Non-Volatile Backup Memory Failure alarm refers to a problem with the TSC card flash 
memory. The alarm occurs when the controller card is in use and has one of four problems: 

• Flash manager fails to format a flash partition.

• Flash manager fails to write a file to a flash partition.

• Problem at the driver level.

• Code volume fails cyclic redundancy checking (CRC, a method to verify for errors in data 
transmitted to the TSC card).
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The BKUPMEMP alarm can also cause the “EQPT (EQPT)” alarm on page 2-44. If the EQPT alarm is 
caused by BKUPMEMP, complete the following procedure to clear the BKUPMEMP and the EQPT 
alarm.

Caution It can take up to 30 minutes for software to be updated on a standby TSC card.

Clear the BKUPMEMP Alarm

Step 1 Verify that both TSC cards are powered and enabled by confirming lighted SRV LEDs on the TSC cards.

Step 2 Determine whether the active or standby TSC card that has the alarm. 

Step 3 If both TSC cards are powered and enabled, reset the TSC card against which the alarm is raised. 
Complete the “Soft-Reset a Card Using CTC” procedure on page 2-130.

Wait ten minutes to verify that the card you reset completely reboots.

Step 4 If the TSC card you reset does not reboot successfully, or the alarm has not cleared, call Cisco TAC (1 
800 553-2447). If the Cisco TAC technician tells you to reseat the card, complete the “Reset a Card with 
a Card Pull (Reseat)” procedure on page 2-133. If the Cisco TAC technician tells you to remove the card 
and reinstall a new one, follow the “Replace a TSC Card” procedure on page 2-136.

2.6.20 BPV
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

Logical Object: BITS

The Bipolar Violation alarm is generated when bipolar violation does not satisfy the requirements 
described in ITU-T recommendations.

Clear the BPV Alarm

Step 1 Check if the input signal is correct and that the externally synchronized node is correctly provisioned 
with the 64KHz signal.

Step 2 If the type of signal is correct then check if all two wires are firmly connected to the BITS-IN pins. 

Step 3 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA) 
problem.

2.6.21 CARLOSS
Default Severity: Major (MJ), Service-Affecting (SA)

Logical Object: GIGE

The Carrier Loss for Gigabit Ethernet (GE) alarm occurs on ASAP ports supporting Gigabit Ethernet 
traffic. The loss can be due to a misconfiguration, fiber cut, or client equipment problem.
2-27
Cisco ONS 15600 SDH Troubleshooting Guide, R8.0

July 2010



Chapter 2 Alarm Troubleshooting
2.6.22  CHANLOSS
Clear the CARLOSS Alarm

Step 1 Ensure that the GIGE client is correctly configured by completing the following steps:

a. Double-click the ASAP card to display the card view.

b. Click the Provisioning > Pluggable Port Modules tabs.

c. View the Pluggable Port Modules area port listing in the Actual Equipment Type column and 
compare this with the client equipment. If no SFP (referred to as a PPM in CTC) is provisioned, 
refer to the “Install Cards and Fiber-Optic Cable” chapter in the Cisco ONS 15600 SDH Procedure 
Guide for provisioning instructions.

d. If an SFP (PPM) has been created, view the contents of the Selected PPM area Rate column for the 
port and compare this rate with the client equipment data rate. In this case, the rate should be 
ETHER. If the SFP (PPM) rate is differently provisioned, select the SFP (PPM), click Delete, then 
click Create and choose the correct rate for the equipment type. 

Step 2 If there is no SFP (PPM) misprovisioning, check for a fiber cut. 

Step 3 If there is no fiber cut or provisioning error, check the client-side equipment for any transmission errors 
on the line.

Step 4 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA) 
problem.

2.6.22 CHANLOSS
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Object: STMN

The SDH Section Layer DCC Termination Failure condition occurs when the ONS 15600 SDH receives 
unrecognized data in the section layer DCC bytes.

Warning Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector. 
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain 
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of 
100 mm could pose an eye hazard. Statement 1056 

Warning Use of controls, adjustments, or performing procedures other than those specified may result in 
hazardous radiation exposure. Statement 1057

Clear the CHANLOSS Condition

Step 1 In the absence of other alarms, determine whether the alarmed port is connected to another vendor’s 
equipment. If so, you can mask the alarm on this path using a custom alarm profile. For more information 
about custom profiles, refer to the “Manage Alarms” chapter in the Cisco ONS 15600 SDH Procedure 
Guide.
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Step 2 If alternate vendor equipment is not the cause of the alarm, complete the “Soft-Reset a Card Using CTC” 
procedure on page 2-130 for the traffic card.

Caution Always use the supplied electrostatic discharge wristband when working with a powered 
ONS 15600 SDH. Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf 
assembly.

Step 3 If the alarm does not clear, complete the “Replace an I/O Card” procedure on page 2-134.

Step 4 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447).

2.6.23 CIDMISMATCH-A
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

Logical Object: EQPT

A Connection ID Mismatch on SSXC A (in Slot 6) alarm occurs when at least one internal connection 
ID mismatch is present at the VC3 level on the traffic (STM-N) card outbound data path.

The alarm occurs when the head end of the connection between traffic cards is removed.

• This alarm can occur on a VT tunnel if it does not have VT circuits provisioned on it. 

• This alarm can occur on an open ended STS circuit if the circuit is not provisioned completely.

Note When an alarm includes a numeric or alphabetical designation, it indicates whether the alarm applies to 
the first or second card of a specific type on the shelf. A zero or A indicates that the alarm occurs against 
the first card of its type, from left to right, in the shelf. A one or B indicates that the alarm occurs against 
the second card of its type in the shelf.

Clear the CIDMISMATCH-A Alarm

Step 1 Depending on how many CIDMISMATCH alarms are raised, take one of the following actions:

• If two CIDMISMATCH alarms (CIDMISMATCH-A and the“CIDMISMATCH-B” alarm on 
page 2-30) are present, continue with Step 6. 

• One CIDMISMATCH-x alarm indicates trouble related to one SSXC card. If an automatic switch to 
the alternate copy SSXC card occurred, the alarmed SSXC card can be serviced. If traffic has not 
switched, complete the “Request a Cross-Connect Card Preferred Copy Switch” procedure on 
page 2-132.

To determine which SSXC card is the preferred copy and if it is currently being used, in node view 
click the Maintenance > Preferred Copy tabs. The Data Copy area Preferred field shows Copy A 
or Copy B. The Currently Used field shows the copy being used.
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Note In CTC, Copy A refers to the SSXC card in Slot 6. Copy B refers to the SSXC card in Slot 8. 
Either copy can be chosen as the preferred copy SSXC card. The other SSXC card is called 
the alternate SSXC card in this chapter.

Step 2 Complete the “Soft-Reset a Card Using CTC” procedure on page 2-130 for the alarmed SSXC card.

Step 3 If the alarm does not clear, ensure that an automatic protection switch has moved traffic to the protect 
port. If an APS switch occurred, continue with Step 4.

• A SNCP APS is identified by an AUTOSW-type alarm or condition (such as AUTOSW-AIS, 
AUTOSW-LOP, AUTOSW-PDI, AUTOSW-SDBER, AUTOSW-SFBER, or AUTOSW-UNEQ).

• A 1+1 APS is identified in the node view Maintenance > Protection tab. If you click the protection 
group, under the Selected Group list, the ports are designated as Working/Standby and 
Protect/Active.

If the reporting traffic card has 1+1 active ports and traffic has not switched to the protect ports, complete 
the “Initiate a 1+1 Protection Port Force Switch Command” procedure on page 2-123. 

Step 4 Complete the “Reset a Card with a Card Pull (Reseat)” procedure on page 2-133 for the SSXC card. 

Step 5 If the alarm does not clear, complete the “Replace an SSXC Card” procedure on page 2-133, “Replace 
an I/O Card” procedure on page 2-134, or “Replace a TSC Card” procedure on page 2-136 as appropriate 
for the reporting card.

Step 6 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447).

Step 7 When the alarm clears, if an automatic switch to the alternate copy SSXC card occurred, traffic is 
restored to the preferred copy.

If the reporting card is a traffic card, traffic reverts to the working port if an automatic switch occurred. 
If traffic was manually switched in a 1+1 protection group, revert traffic to the original port by 
completing the “Clear a 1+1 Protection Port Force or Manual Switch Command” procedure on 
page 2-124. If traffic was manually switched in an SNCP, revert traffic to the original path by completing 
the “Clear a SNCP Span External Switching Command” procedure on page 2-127.

2.6.24 CIDMISMATCH-B
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

Logical Object: EQPT

A Connection ID Mismatch on SSXC-B (Slot 8) alarm occurs when at least one internal connection ID 
mismatch is present at the VC3 level on the STM-16 or STM-64 card outbound data path.

The alarm occurs when the head end of the connection between traffic (STM-N) cards is removed. 

• This alarm can occur on a VT tunnel if it does not have VT circuits provisioned on it. 

• This alarm can occur on an open ended STS circuit if the circuit is not provisioned completely.

Clear the CIDMISMATCH-B Alarm

Step 1 Complete the “Clear the CIDMISMATCH-A Alarm” procedure on page 2-29.
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Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447).

2.6.25 CLKFAIL
Default Severity: Major (MJ), Service-Affecting (SA)

Logical Object: EQPT

The Clock Fail alarm occurs when an internal clock module fails. If this alarm occurs against the standby 
TSC card, the card must be replaced. If the alarm occurs against the active TSC card, the card 
automatically becomes standby because the traffic and SSXC cards can only take timing from the active 
TSC card.

Clear the CLKFAIL Alarm

Step 1 Complete the “Replace a TSC Card” procedure on page 2-136 for the reporting TSC card.

Caution Always use the supplied electrostatic discharge wristband when working with a powered 
ONS 15600 SDH. Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf 
assembly.

Note When there are different versions of system software on the two TSC cards, it takes 
approximately 20 minutes for the active TSC card to transfer the system software to the newly 
installed standby TSC card. When the transfer completes, the TSC card reboots and goes into 
standby mode after approximately three minutes.

Note If the active and standby TSC cards have the same versions of software, it takes approximately 
three minutes for software to be updated on a standby TSC card. 

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447).

2.6.26 CONTBUS-CLK-A
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

Logical Object: EQPT

An Inbound Interconnection Timing Control Bus 0 Failure alarm on the Slot 10 TSC card occurs if the 
timing signal from the Slot 5 TSC card has an error. If the Slot 10 TSC card and all other cards on the 
shelf raise this alarm, the alarm processor on the Slot 5 TSC card clears the alarm on the other cards and 
raises this alarm against the Slot 5 TSC card only. 
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Clear the CONTBUS-CLK-A Alarm

Step 1 If a single traffic card is reporting the alarm and it is part of an SNCP, complete the “Initiate a Force 
Switch for All Circuits on a SNCP Span” procedure on page 2-126. If the traffic card is part of a 1+1 
protection group, complete the “Initiate a 1+1 Protection Port Force Switch Command” procedure on 
page 2-123.

Note If the reporting card is an SSXC card, traffic should have already switched from the errored copy 
of the card. 

Note If the active TSC is reporting the alarm, shelf control should already have switched off the card.

Step 2 Complete the appropriate procedure in the “2.8.4 Physical Card Reseating, Resetting, and 
Replacement” section on page 2-133 for the reporting card.

Step 3 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447).

When the alarm clears, if an automatic switch to the alternate copy SSXC occurred, traffic is 
automatically restored to the preferred copy. 

Step 4 If traffic was manually switched in a 1+1 protection group, revert traffic to the original port by 
completing the “Clear a 1+1 Protection Port Force or Manual Switch Command” procedure on 
page 2-124. If traffic was manually switched in an SNCP, revert traffic to the original path by completing 
the “Clear a SNCP Span External Switching Command” procedure on page 2-127.

Step 5 When the alarm has been cleared, if desired, complete the “Soft-Reset a Card Using CTC” procedure on 
page 2-130.

2.6.27 CONTBUS-CLK-B
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

Logical Object: EQPT

An Inbound Interconnection Timing Control Bus 1 Failure alarm on the Slot 5 TSC card occurs if the 
timing signal from the Slot 10 TSC card has an error. If the Slot 5 TSC card and all other cards on the 
shelf raise the alarm, the processor on the Slot 10 TSC card clears the alarm on the other cards and raises 
this alarm against the Slot 10 TSC card only. 

Note When an alarm includes a numeric or alphabetical designation, it indicates whether the alarm applies to 
the first or second card of a specific type on the shelf. A zero or A indicates that the alarm occurs against 
the first card of its type, from left to right, in the shelf. A one or B indicates that the alarm occurs against 
the second card of its type in the shelf.

Clear the CONTBUS-CLK-B Alarm

Step 1 Complete the “Clear the CONTBUS-CLK-A Alarm” procedure on page 2-32.
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Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447).

2.6.28 CONTBUS-IO-A
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

Logical Object: EQPT

A TSC Card A to Shelf A Slot Communication Failure alarm occurs when the active Slot 5 TSC card 
(TSC card A) has lost communication with another card in the shelf. The other card is identified by the 
Object column in the CTC alarm window.

The CONTBUS-IO-A alarm can appear briefly when the ONS 15600 SDH switches to the standby TSC 
card. In the case of a TSC card protection switch, the alarm clears after the other cards establish 
communication with the newly active TSC card. If the alarm persists, the problem lies with the physical 
path of communication from the TSC card to the reporting card. The physical path of communication 
includes the TSC card, the other card, and the backplane.

Clear the CONTBUS-IO-A Alarm

Step 1 Ensure that the reporting card is physically present in the shelf. Record the card type. Click the 
Inventory tab and view the Eqpt Type column to display the provisioned type.

If the actual card type and the provisioned card type do not match, see the “MEA” alarm on page 2-94 
for the reporting card.

Step 2 Complete the “Soft-Reset a Card Using CTC” procedure on page 2-130 for the alarmed card. For the 
LED behavior, see the “2.7 LED Behavior” section on page 2-120.

Wait ten minutes to verify that the card you reset completely reboots and becomes the standby card. (A 
reset standby card remains standby.)

Step 3 If CONTBUS-IO-A is raised on several cards at the same time, complete the “Reset a Card with a Card 
Pull (Reseat)” procedure on page 2-133.

Wait ten minutes to verify that the card you reset completely reboots and becomes the standby card.

Step 4 Verify that the reset is complete and error-free and that no new related alarms appear in CTC. A green 
SRV LED indicates an active card.

Step 5 If the CTC reset does not clear the alarm, complete the “Reset a Card with a Card Pull (Reseat)” 
procedure on page 2-133 for the reporting card.

Caution Always use the supplied electrostatic discharge wristband when working with a powered 
ONS 15600 SDH. Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf 
assembly.

Step 6 If the reset card has not rebooted successfully, or the alarm has not cleared, call Cisco TAC (1 800 
553-2447). If the Cisco TAC technician tells you to reseat the card, complete the “Reset a Card with a 
Card Pull (Reseat)” procedure on page 2-133. If the Cisco TAC technician tells you to remove the card 
and reinstall a new one, follow the “Replace a TSC Card” procedure on page 2-136.
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2.6.29 CONTBUS-IO-B
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

Logical Object: EQPT

A TSC Card B to Shelf Communication Failure alarm occurs when the active Slot 10 TSC card (TSC 
card B) has lost communication with another card in the shelf. The other card is identified by the Object 
column in the CTC alarm window.

The CONTBUS-IO-B alarm might appear briefly when the ONS 15600 SDH switches to the protect 
TSC card. In the case of a TSC card protection switch, the alarm clears after the other cards establish 
communication with the newly active TSC card. If the alarm persists, the problem lies with the physical 
path of communication from the TSC card to the reporting card. The physical path of communication 
includes the TSC card, the other card, and the backplane.

Clear the CONTBUS-IO-B Alarm

Step 1 Ensure that the reporting card is physically present in the shelf. Record the card type. Click the 
Inventory tab and view the Eqpt Type column to display the provisioned type.

If the actual card type and the provisioned card type do not match, see the “MEA” alarm on page 2-94 
for the reporting card.

Step 2 Complete the “Soft-Reset a Card Using CTC” procedure on page 2-130 for the alarmed card. For the 
LED behavior, see the “2.7 LED Behavior” section on page 2-120.

Step 3 If the alarm object is the standby Slot 5 TSC card, complete the “Reset a Card with a Card Pull (Reseat)” 
procedure on page 2-133.

Wait ten minutes to verify that the card you reset completely reboots and becomes the standby card. (A 
reset standby card remains standby.)

Step 4 If CONTBUS-IO-B is raised on several cards at the same time, complete the “Soft-Reset a Card Using 
CTC” procedure on page 2-130.

Wait ten minutes to verify that the card you reset completely reboots and becomes the standby card.

Step 5 Verify that the reset is complete and error-free and that no new related alarms appear in CTC. A green 
SRV LED indicates an active card.

Step 6 If the CTC reset does not clear the alarm, complete the “Reset a Card with a Card Pull (Reseat)” 
procedure on page 2-133 for the reporting card.

Caution Always use the supplied electrostatic discharge wristband when working with a powered 
ONS 15600 SDH. Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf 
assembly.

Step 7 If the reset card has not rebooted successfully, or the alarm has not cleared, call Cisco TAC (1 800 
553-2447). If the Cisco TAC technician tells you to reseat the card, complete the “Reset a Card with a 
Card Pull (Reseat)” procedure on page 2-133. If the Cisco TAC technician tells you to remove the card 
and reinstall a new one, follow the “Replace a TSC Card” procedure on page 2-136.
2-34
Cisco ONS 15600 SDH Troubleshooting Guide, R8.0

July 2010



Chapter 2 Alarm Troubleshooting
2.6.30  CONTCOM
2.6.30 CONTCOM
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

Logical Object: EQPT

The Interconnection Control Communication Failure alarm occurs when the internal messaging 
processor on the reporting active TSC card fails. 

A TSC card should boot and be in the ready state within approximately five minutes. If the CONTCOM 
alarm clears within this time frame and the TSC card goes to standby or active mode as applicable, no 
action is necessary.

If the communication equipment on the backplane fails, a CONTBUS alarm occurs instead of a 
CONTCOM alarm.

Clear the CONTCOM Alarm

Step 1 Complete the “Soft-Reset a Card Using CTC” procedure on page 2-130.

Step 2 If the CTC reset does not clear the alarm, complete the “Reset a Card with a Card Pull (Reseat)” 
procedure on page 2-133. 

Step 3 If the alarm does not clear, complete the “Replace a TSC Card” procedure on page 2-136.

Step 4 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447).

Step 5 When the alarm has been cleared, complete the “Soft-Reset a Card Using CTC” procedure on page 2-130 
as needed.

2.6.31 CTNEQPT-PB-A
Default Severity: Critical (CR), Service-Affecting (SA)

Logical Object: EQPT

The SSXC-0 Data Payload Bus Interconnect Failure alarm occurs when the data path interconnection 
between equipment from SSXC-0 (Slot 6) to inbound or outbound traffic (STM-N) card slots has a 
failure. The SSXC card and the reporting card are no longer communicating through the backplane. The 
problem exists in the SSXC card, the reporting traffic card, or the backplane. If more than one traffic 
card on the shelf raises this alarm, the TSC card clears this alarm on the traffic cards and raises it alarm 
against SSXC-0. 

Note When an alarm includes a numeric or alphabetical designation, it indicates whether the alarm applies to 
the first or second card of a specific type on the shelf. A zero or A indicates that the alarm occurs against 
the first card of its type, from left to right, in the shelf. A one or B indicates that the alarm occurs against 
the second card of its type in the shelf.

Note If you insert a new TSC card that has the same version of software as the active and standby TSC card, 
it takes approximately three minutes for the standby TSC card to become available. 
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Note It takes approximately 20 minutes for the active TSC card to transfer the system software to the newly 
installed TSC card. Software transfer occurs in instances where different software versions exist on the 
two cards. When the transfer completes, the TSC card reboots and goes into standby mode after 
approximately three minutes.

Clear the CTNEQPT-PB-A Alarm

Step 1 If the alarm occurs against a single traffic (STM-N) card, continue with Step 2. If the alarm occurs 
against multiple traffic cards, it indicates a problem with the SSXC card. Continue with Step 6.

Step 2 If the traffic card ports are part of an SNCP, switch the single circuit on the span using instructions in 
the “Maintain the Node” chapter in the Cisco ONS 15600 SDH Procedure Guide. If the ports are part of 
a 1+1 protection group, complete the “Initiate a 1+1 Protection Port Force Switch Command” procedure 
on page 2-123.

Step 3 Complete the “Hard-Reset a Card Using CTC” procedure on page 2-131.

Step 4 If the CTC reset does not clear the alarm, complete the “Reset a Card with a Card Pull (Reseat)” 
procedure on page 2-133 for the reporting card. 

Caution Always use the supplied electrostatic discharge wristband when working with a powered 
ONS 15600 SDH. Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf 
assembly.

Step 5 If the alarm does not clear, complete the appropriate procedure in the “2.8.4 Physical Card Reseating, 
Resetting, and Replacement” section on page 2-133.

Note If the traffic card is implicated and you are able to continue using the traffic card with one port 
out of service, perform a bridge and roll to move the port traffic to a free port. Refer to the 
“Manage Circuits” chapter in the Cisco ONS 15600 SDH Procedure Guide for instructions. 
Label the bad port and take it out of service until the card can be replaced.

Step 6 If you replace the traffic card and the alarm does not clear, an SSXC card problem is indicated. If an 
automatic switch to the alternate copy SSXC card occurred, the SSXC card can be serviced. If traffic has 
not switched, request a preferred copy switch by completing the “Request a Cross-Connect Card 
Preferred Copy Switch” procedure on page 2-132.

To determine which SSXC card is the preferred copy and whether it is currently being used, in node view 
go to the Maintenance > Preferred Copy window. The Data Copy area Preferred field shows Copy A or 
Copy B. The Currently Used field shows the copy being used.

Note In CTC, Copy A refers to the SSXC card in Slot 6. Copy B refers to the SSXC card in Slot 8. 
Either copy might be chosen as the preferred copy SSXC card. The other SSXC card is called 
the alternate SSXC card in this chapter.

Continue with Step 7.

Step 7 Perform a CTC soft reset on the SSXC card by completing the following steps:

a. Display node view.
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b. Position the CTC cursor over the card.

c. Right-click and choose Soft-reset Card from the shortcut menu.

d. Click Yes in the Soft-reset Card dialog box.

Step 8 If the CTC reset does not clear the alarm, complete the “Reset a Card with a Card Pull (Reseat)” 
procedure on page 2-133 for the alarmed card. 

Step 9 If the alarm does not clear, complete the “Replace an SSXC Card” procedure on page 2-133.

Step 10 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447) to report a Service-Affecting (SA) problem.

Step 11 Depending on which card raised the alarm, perform the following actions:

• If traffic was manually switched in a 1+1 protection group, revert traffic to the original port by 
completing the “Clear a 1+1 Protection Port Force or Manual Switch Command” procedure on 
page 2-124. 

• If traffic was manually switched in an SNCP, revert traffic to the original path by completing the 
“Clear a SNCP Span External Switching Command” procedure on page 2-127.

Note If an automatic switch to the alternate copy SSXC card occurred, traffic is automatically restored 
to the preferred copy.

2.6.32 CTNEQPT-PB-B
Default Severity: Critical (CR), Service-Affecting (SA)

Logical Object: EQPT

The SSXC-1 Data Payload Bus Interconnect Failure alarm occurs when the data path interconnection 
fails between equipment from SSXC-1 (Slot 8) and traffic card slots. If more than one traffic card on the 
shelf raises this alarm, the TSC card clears the alarm on the traffic cards and raises the alarm against the 
SSXC-1. 

Note In CTC, Copy A refers to the SSXC card in Slot 6/7. Copy B refers to the SSXC card in Slot 8/9. Either 
copy might be chosen as the preferred copy SSXC card. The other SSXC card is called the alternate 
SSXC card in this chapter.

Clear the CTNEQPT-PB-B Alarm

Step 1 Complete the “Clear the CTNEQPT-PB-A Alarm” procedure on page 2-36. 

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447) to report a Service-Affecting (SA) problem.
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2.6.33 CXCHALT
Default Severity: Major (MJ), Service-Affecting (SA)

Logical Object: EQPT

An SSXC Operation Suspended alarm indicates that operation on the alternate SSXC card has halted 
because of problems in Fan Tray 2, which services controller cards including the SSXC cards.

The CXCHALT alarm occurs five minutes after a fan failure alarm such as the “FAN-DEGRADE” alarm 
on page 2-56, the “FAN-FAIL” alarm on page 2-57, the “IMPROPRMVL (EQPT, PIM, PPM)” alarm on 
page 2-71, or the “FAN-FAIL-PARTIAL” alarm on page 2-57 halts alternate SSXC operation. 

Caution If a CXCHALT occurs due to a fan failure, you should move a working fan assembly from Tray 1 or 3 
and install it in the Tray 2 position because the remaining working SSXC card can be damaged in as little 
as 15 minutes. If damage occurs to the remaining SSXC card, it restarts and then fails. Traffic is dropped 
until a replacement is installed.

Clear the CXCHALT Alarm

Step 1 Troubleshoot the fan alarm by following the “Clear the FAN-FAIL Alarm” procedure on page 2-57, 
which includes fan replacement.

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447) to report a Service-Affecting (SA) problem.

2.6.34 DATAFLT
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

Logical Object: NE

The Software Data Integrity Fault alarm occurs when the TSC exceeds its flash memory capacity.

Caution Configurations more than three minutes old are saved. Those newer than three minutes are not saved.

Clear the DATAFLT Alarm

Step 1 Complete the “Soft-Reset a Card Using CTC” procedure on page 2-130.

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447).
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2.6.35 DBOSYNC 
Default Severity: Major (MJ), Service-Affecting (SA)

Logical Object: NE

The Standby Database Out of Synchronization alarm occurs when the standby TSC card “To be Active” 
database does not synchronize with the active database on the active TSC card.

Caution If you reset the active TSC card while this alarm is raised, you lose current provisioning.

Clear the DBOSYNC Alarm

Step 1 Save a backup copy of the active TSC card database. Refer to the “Maintain the Node” chapter in the 
Cisco ONS 15600 SDH Procedure Guide for instructions.

Step 2 Make a minor provisioning change to the active database to see if applying a provisioning change clears 
the alarm by completing the following steps:

a. In node view, click the Provisioning > General > General tabs.

b. In the Description field, make a small change such as adding a period to the existing entry.

The change causes a database write but does not affect the node state. The write could take up to a 
minute.

Step 3 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447).

2.6.36 DISCONNECTED
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

Logical Object: SYSTEM

The Disconnected is raised when CTC has been disconnected from the node. The alarm is cleared when 
CTC is reconnected to the node.

Clear the DISCONNECTED Alarm

Step 1 Restart the CTC application.

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1-800-553-2447). 
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2.6.37 DUP-IPADDR 
Default Severity: Minor (MN), Non-Service Affecting (NSA)

Logical Object: NE

The Duplicate IP Address alarm indicates that the alarmed node IP address is already in use within the 
same DCC area. When this happens, CTC no longer reliably connects to either node. Depending on how 
the packets are routed, CTC could connect to either node (having the same IP address). If CTC has 
connected to both nodes before they shared the same address, it has two distinct NodeModel instances 
(keyed by the node ID portion of the MAC address). 

Clear the DUP-IPADDR Alarm

Step 1 Isolate the alarmed node from the other node having the same address by completing the following steps:

a. Connect to the alarmed node using the Craft port on the ONS 15600 SDH chassis.

b. Begin a CTC session.

c. In the login dialog box, uncheck the Network Discovery check box.

Step 2 In node view, click the Provisioning > Network > General tabs.

Step 3 In the IP Address field, change the IP address to a unique number.

Step 4 Click Apply.

Step 5 Restart any CTC sessions that are logged into either of the formerly duplicated node IDs. (For 
instructions to log in or log out, refer to the “Set Up PC and Log Into the GUI” chapter in the 
Cisco ONS 15600 SDH Procedure Guide.)

Step 6 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447).

2.6.38 DUP-NODENAME
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

Logical Object: NE

The Duplicate Node Name alarm indicates that the alarmed node alphanumeric name is already being 
used within the same DCC area.

Clear the DUP-NODENAME Alarm

Step 1 In node view, click the Provisioning > General > General tabs.

Step 2 In the Node Name field, enter a unique name for the node.

Step 3 Click Apply.

Step 4 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447).
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2.6.39 EHIBATVG 
Default Severity: Major (MJ), Service-Affecting (SA)

Logical Object: PWR

The Extreme High Voltage Battery alarm occurs in a –48 VDC environment when a battery lead input 
voltage exceeds the extreme high power threshold. This threshold, with a default value of –56.5 VDC, 
is user-provisionable. The alarm remains raised until the voltage remains under the threshold for 
120 seconds.

Clear the EHIBATVG Alarm

Step 1 The problem is external to the ONS 15600 SDH. Troubleshoot the power source supplying the battery 
leads.

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA) 
problem.

2.6.40 ELWBATVG 
Default Severity: Major (MJ), Service-Affecting (SA)

Logical Object: PWR

The Extreme Low Voltage Battery alarm occurs in a –48 VDC environment when a battery lead input 
voltage falls below the extreme low power threshold. This threshold, with a default value of –40.5 VDC, 
is user-provisionable. The alarm remains raised until the voltage remains over the threshold for 
120 seconds. 

Clear the ELWBATVG Alarm

Step 1 The problem is external to the ONS 15600 SDH. Troubleshoot the power source supplying the battery 
leads.

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA) 
problem.

2.6.41 ENCAP-MISMATCH-P
The ENCAP-MISMATCH-P alarm is not used in this platform in this release. It is reserved for 
development.
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2.6.42 EOC 
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

Logical Object: STMN

The SDH DCC Termination Failure alarm occurs when the ONS 15600 SDH loses its DCC. Although 
this alarm is primarily SDH, it can apply to dense wavelength division multiplexing (DWDM) in other 
platforms.

The Regenerator-Section DCC (RS-DCC) consists of three bytes, D1 through D3, in the SDH overhead. 
The bytes convey information about operation, administration, maintenance, and provisioning 
(OAM&P). The ONS 15600 SDH uses the DCC on the SDH Section layer to communicate network 
management information.

Warning Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector. 
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain 
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of 
100 mm could pose an eye hazard. Statement 1056 

Warning Use of controls, adjustments, or performing procedures other than those specified may result in 
hazardous radiation exposure. Statement 1057

Note If a circuit shows an incomplete state when this alarm is raised, the logical circuit is in place. The circuit 
is able to carry traffic when the connection issue is resolved. You do not need to delete the circuit when 
troubleshooting this alarm.

Clear the EOC Alarm

Step 1 If the “LOS (STMN)” alarm on page 2-86 is also reported, complete the “Clear the LOS (STMN) Alarm” 
procedure on page 2-86. (This procedure is also used for EOC.)

Step 2 If the “MS-EXC” condition on page 2-99 is reported, complete the “Clear the MS-DEG Condition” 
procedure on page 2-98. (This procedure is also used for EOC.)

Step 3 If the alarm does not clear on the reporting node, verify the physical connections between the cards and 
that the fiber-optic cables are configured to carry RS-DCC traffic. If they are not, correct them. For more 
information about fiber connections and terminations, refer to the “Install Cards and Fiber-Optic Cable” 
chapter in the Cisco ONS 15600 SDH Procedure Guide.

Caution Always use the supplied electrostatic discharge wristband when working with a powered 
ONS 15600 SDH. Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf 
assembly.

If the physical connections are correct and configured to carry DCC traffic, ensure that both ends of the 
fiber span have fully operational (Unlocked-enabled) ports. Verify that the SRV LED on each STM-N 
card is green.
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Step 4 When the LEDs on the STM-N cards are correctly illuminated, complete the “2.8.5 Verify or Create 
Node DCC Terminations” procedure on page 2-139.

Step 5 Repeat Step 4 at the adjacent nodes.

Step 6 If DCC is provisioned for the ends of the span, verify that the port is active and in service by completing 
the following steps:

a. Confirm that the STM-N card shows a green LED in CTC or on the physical card.

A green SRV LED indicates an active card. 

b. To determine whether the port is in service, double-click the card in CTC to display the card view.

c. Click the Provisioning > Line tabs.

d. Verify that the Admin State column lists the port as Unlocked.

e. If the Admin State column lists the port as Locked,maintenance or Locked,disabled, click the 
column and click Unlocked from the drop-down list. Click Apply.

Note If ports managed into Unlocked administrative state are not receiving signals, the LOS alarm 
is either raised or remains, and the port service state transitions to Unlocked-disabled,failed.

Step 7 For all nodes, if the card is in service, use an optical test set to determine whether signal failures are 
present on fiber terminations. For specific procedures to use the test set equipment, consult the 
manufacturer.

Caution Using an optical test set disrupts service on the STM-N card. It could be necessary to manually switch 
traffic carrying circuits over to a protection path. Refer to the “2.8.2 Protection Switching, Lock 
Initiation, and Clearing” section on page 2-123 for commonly used switching procedures.

Step 8 If no signal failures exist on terminations, measure power levels to verify that the budget loss is within 
the parameters of the receiver. See the “1.9.3 Optical Traffic Card Transmit and Receive Levels” section 
on page 1-74 for information.

Step 9 If budget loss is within parameters, ensure that fiber connectors are securely fastened and properly 
terminated. For more information refer to the “Install Cards and Fiber-Optic Cable” chapter in the 
Cisco ONS 15600 SDH Procedure Guide.

Step 10 If fiber connectors are properly fastened and terminated, complete the “Soft-Reset a Card Using CTC” 
procedure on page 2-130.

Wait ten minutes to verify that the card you reset completely reboots and becomes the standby card.

Resetting the active TSC card switches control to the standby TSC card. If the alarm clears when the 
ONS 15600 SDH node switches to the standby TSC card, the user can assume that the previously active 
card is the cause of the alarm.

Step 11 If the TSC card reset does not clear the alarm, delete the problematic RS-DCC termination by completing 
the following steps:

a. From card view, click View > Go to Previous View if you have not already done so.

b. Click the Provisioning > Comm Channels > RS-DCC tabs.

c. Highlight the problematic DCC termination.

d. Click Delete.

e. Click Yes in the Confirmation Dialog box.
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Step 12 Recreate the RS-DCC termination. Refer to the “Turn Up Network” chapter in the 
Cisco ONS 15600 SDH Procedure Guide for instructions.

Step 13 Verify that both ends of the DCC have been recreated at the optical ports.

Step 14 If the alarm has not cleared, call Cisco TAC (1 800 553-2447). If the Cisco TAC technician tells you to 
reseat the card, complete the “Reset a Card with a Card Pull (Reseat)” procedure on page 2-133. If the 
Cisco TAC technician tells you to remove the card and reinstall a new one, follow the “Replace a TSC 
Card” procedure on page 2-136.

2.6.43 EQPT (CAP)
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

Logical Object: CAP

An Equipment Failure alarm for the CAP indicates that the customer access panel has a physical failure. 
Log into the Technical Support Website at http://www.cisco.com/techsupport for more information or 
call Cisco TAC (1 800 553-2447).

2.6.44 EQPT (EQPT)
Default Severity: Critical (CR), Service-Affecting (SA) 

Logical Object: EQPT 

An Equipment Failure alarm indicates that a hardware failure has occurred on the reporting card. If the 
EQPT alarm occurs with a BKUPMEMP alarm, refer to the “2.6.19 BKUPMEMP” section on 
page 2-26. The BKUPMEMP procedure also clears the EQPT alarm. 

This alarm is also invoked if a diagnostic circuit detects a card application-specific integrated circuit 
(ASIC) failure. In this case, if the card is part of a protection group, an APS switch occurs. If the card is 
the protect card, switching is inhibited. The standby path generates a path-type alarm.

Clear the EQPT Alarm 

Step 1 Complete the appropriate procedure in the “2.8.3 CTC Card Resetting and Switching” section on 
page 2-130 section. 

Step 2 Verify that the reset is complete and error-free and that no new related alarms appear in CTC. For LED 
appearance, see the “2.7 LED Behavior” section on page 2-120. 

Step 3 If the CTC reset does not clear the alarm, complete the appropriate procedure in the “2.8.4 Physical 
Card Reseating, Resetting, and Replacement” section on page 2-133 section procedure for the reporting 
card. 

Caution Always use the supplied electrostatic discharge wristband when working with a powered 
ONS 15600 SDH. Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf 
assembly.

Step 4 If the physical reseat of the card fails to clear the alarm, complete the “Replace an I/O Card” section on 
page 2-134 procedure for the reporting card. 
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Caution Removing a card that currently carries traffic on one or more ports can cause a traffic hit. To avoid this, 
perform an external switch if a switch has not already occurred. See the “2.8.2 Protection Switching, 
Lock Initiation, and Clearing” section on page 2-123 for more information. 

Note When you replace a card with the identical type of card, you do not need to make any changes to the 
database. 

Step 5 If the alarm does not clear, log onto http://www.cisco.com/techsupport for more information or call 
Cisco TAC (1 800 553-2447) to report a Service-Affecting (SA) problem. 

2.6.45 EQPT (PIM)
Default Severity: Critical (CR), Service-Affecting (SA) (SA

Logical Object: PIM

The EQPT alarm for the ASAP card 4PIO module (or PIM) is raised when all ports on the four-port 
module fail.

Clear the EQPT (PIM) Alarm

Step 1 Complete the “Replace an ASAP 4PIO (PIM) Module” procedure on page 2-138.

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447) to report a Service-Affecting (SA) problem.

2.6.46 EQPT (PPM)
Default Severity: Critical (CR), Service-Affecting (SA)

Logical Object: PPM

The EQPT alarm for the SFP (PPM) is raised when one of the SFP (PPM) ports on a four-port 4PIO 
(PIM) module fails.

Clear the EQPT (PPM) Alarm

Step 1 Replace the alarmed SFP (PPM) by completing the “Replace an ASAP SFP (PPM) Module” procedure 
on page 2-138.

Step 2 If the alarm does not clear, move traffic off any active PPMs (SFPs). See the “Initiate a 1+1 Protection 
Port Force Switch Command” procedure on page 2-123. After switching traffic, replace the 4PIO (PIM) 
using the instructions in the “Install Cards and Fiber-Optic Cable” chapter in the Cisco ONS 15600 SDH 
Procedure Guide.
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Step 3 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447) to report a Service-Affecting (SA) problem.

2.6.47 EQPT-BOOT
Default Severity: Critical (CR), Service-Affecting (SA)

Logical Object: EQPT

An Equipment Boot Failure alarm occurs when a TSC card, SSXC card, or traffic (STM-N) card does 
not fully boot from the restart point after self-rebooting three times.

Clear the EQPT-BOOT Alarm

Step 1 Complete the “Clear the EQPT Alarm” procedure on page 2-44.

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447) to report a Service-Affecting (SA) problem.

2.6.48 EQPT-CC-PIM
Default Severity: Critical (CR), Service-Affecting (SA)

Logical Object: PIM

The EQPT Alarm on a Carrier or 4PIO (PIM) is raised when an LOF or LOS alarm is shown on an ASAP 
card but this alarm is not also shown against the 4PIO (PIM) that carries the affected traffic. If multiple 
four-port 4PIOs (PIMs) do not show this LOF or LOS alarm, the EQPT-CC-PIM alarm raises against the 
ASAP carrier card itself. 

Clear the EQPT-CC-PIM Alarm

Step 1 Complete the “Replace an ASAP 4PIO (PIM) Module” procedure on page 2-138.

Step 2 If the alarm does not clear, move traffic off any active 4PIOs (PIMs). Procedures and guidelines to do 
this are located in the “Maintain the Node” chapter in the Cisco ONS 15600 SDH Procedure Guide. Then 
complete the “Replace an ASAP Carrier Module” procedure on page 2-137 and reinstall the 4PIOs 
(PIMs) by completing the “Replace an ASAP 4PIO (PIM) Module” procedure on page 2-138. For more 
information about removing or installing these modules, refer to the “Install Cards and Fiber-Optic 
Cable” chapter in the Cisco ONS 15600 SDH Procedure Guide.

Step 3 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447) to report a Service-Affecting (SA) problem.
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2.6.49 EQPT-HITEMP
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

Logical Object: EQPT

The Equipment Failure High Temperature alarm occurs when the TSC card, SSXC card, or traffic 
(STM-N) card internal temperature exceeds 185 degrees Fahrenheit (85 degrees Celsius). 

Clear the EQPT-HITEMP Alarm

Step 1 Ensure that the room temperature is not abnormally high.

Step 2 If the room temperature is not the cause of the alarm, ensure that filler modules are installed in the 
ONS 15600 SDH empty slots. Filler modules help airflow.

Caution Always use the supplied electrostatic discharge wristband when working with a powered 
ONS 15600 SDH. Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf 
assembly.

Step 3 If the “FAN-DEGRADE” alarm on page 2-56 or the “FAN-FAIL” alarm on page 2-57 accompanies the 
alarm, complete the “Clear the FAN-FAIL Alarm” procedure on page 2-57.

Step 4 If the alarm does not clear, check the condition of the air filter to see if it needs cleaning or replacement. 
Replace the air filter using the procedure located in the “Maintain the Node” chapter in the 
Cisco ONS 15600 SDH Procedure Guide as needed.

Step 5 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447).

2.6.50 EQPT-PIM-PPM
Default Severity: Critical (CR), Service-Affecting (SA)

Logical Object: PPM

The EQPT alarm for an SFP (PPM) is raised when a 4PIO (PIM) is reporting low electrical amplitude 
from an SFP (PPM). If this symptom shows up from multiple SFPs (PPMs) then the alarm should be 
against the 4PIO (PIM). Otherwise the alarm will be against the SFP (PPM) creating the problem.

Clear the EQPT-PIM-PPM Alarm

Step 1 Move any traffic away from the affected SFP (PPM), using guidelines and instructions in the “Maintain 
the Node” chapter in the Cisco ONS 15600 SDH Procedure Guide, then replace the alarmed SFP (PPM) 
module using instructions in that guide.

Step 2 If the alarm does not clear, move any traffic away from the affected 4PIO (PIM), using the instructions 
in the “Install Cards and Fiber-Optic Cable” chapter in the Cisco ONS 15600 SDH Procedure Guide, and 
replace the 4PIO (PIM). 
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Step 3 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447) to report a Service-Affecting (SA) problem.

2.6.51 E-W-MISMATCH
Default Severity: Major (MJ), Service-Affecting (SA)

Logical Object: STMN

A Procedural Error Misconnect East/West Direction alarm occurs during MS-SPRing setup, or when 
nodes in a ring have slots misconnected. An east slot can be misconnected to another east slot, or a west 
slot can be misconnected to another west slot. In most cases, the user did not connect the fibers correctly 
or the ring provisioning plan was flawed. You can physically reconnect the cable to the correct slots to 
clear the E-W-MISMATCH alarm. Alternately, you can delete and recreate the span in CTC to change 
the west line and east line designations. The CTC method clears the alarm, but could change the 
traditional east-west node connection pattern of the ring.

Note The E-W-MISMATCH alarm also appears during the initial set up of a ring with its East-West slots 
configured correctly. If the alarm appears during the initial setup, the alarm clears itself shortly after the 
ring setup is complete.

Note The lower-numbered slot at a node is traditionally labeled the west slot and the higher numbered slot is 
labeled the east slot. For example, in the ONS 15600 SDH system, Slot 2 is west and Slot 12 is east.

Note The physical switch procedure is the recommend method of clearing the E-W-MISMATCH alarm. The 
physical switch method reestablishes the logical pattern of connection in the ring. However, you can also 
use CTC to recreate the span and identify the misconnected slots as east and west. The CTC method is 
useful when the misconnected node is not geographically near the troubleshooter.

Clear the E-W-MISMATCH Alarm with a Physical Switch

Step 1 Diagram the ring setup, including nodes and spans, on a piece of paper or white board.

Step 2 In node view, click View > Go to Network View.

Step 3 Label each of the nodes on the diagram with the same name that appears on the network map.

Step 4 Right-click each span to display the node name/slot/port for each end of the span.

Step 5 Label the span ends on the diagram with the same information. 

Step 6 Repeat Steps 4 and 5 for each span on your diagram.

Step 7 Label the highest slot at each node east and the lowest slot at each node west.

Step 8 Examine the diagram. You should see a clockwise pattern of west slots connecting to east slots for each 
span. Refer to the “Install Cards and Fiber-Optic Cable” chapter in the Cisco ONS 15600 SDH 
Procedure Guide for more information about cable installation in the system.
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Step 9 If any span has an east-to-east or west-to-west connection, physically switching the fiber connectors 
from the card that does not fit the pattern to the card that continues the pattern should clear the alarm.

Warning Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector. 
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain 
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of 
100 mm could pose an eye hazard. Statement 1056 

Warning Use of controls, adjustments, or performing procedures other than those specified may result in 
hazardous radiation exposure. Statement 1057

Step 10 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447) to report a Service-Affecting (SA) problem.

Clear the E-W-MISMATCH Alarm in CTC

Step 1 Log into the misconnected node. A misconnected node has both ring fibers connecting it to its neighbor 
nodes misconnected.

Step 2 Click the Maintenance > MS-SPRing tabs.

Step 3 From the row of information for the fiber span, complete the “Identify an MS-SPRing Ring ID or Node 
ID Number” procedure on page 2-122 to identify the node ID, ring name, and the slot and port in the 
East Line column and West Line column. Record the above information.

Step 4 Click View > Go to Network View.

Step 5 Delete and recreate the MS-SPRing by completing the following steps:

a. Click the Provisioning > MS-SPRing tabs.

b. Click the row from Step 3 to select it and click Delete.

c. Click Create.

d. Fill in the ring name and node ID from the information collected in Step 3.

e. Click Finish.

Step 6 Display node view and click the Maintenance > MS-SPRing tabs.

Step 7 Change the West Line drop-down list to the slot you recorded for the East Line in Step 3.

Step 8 Change the East Line drop-down list to the slot you recorded for the West Line in Step 3.

Step 9 Click OK.

Step 10 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447) to report a Service-Affecting (SA) problem.
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2.6.52 EXERCISE-RING-FAIL
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Object: STMN

The Exercise Ringcommand issues ring protection switching of the requested channel without 
completing the actual bridge and switch. The EXERCISE-RING-FAIL condition is raised if the 
command was issued and accepted but the exercise did not take place.

Note If the exercise command gets rejected due to the existence of a higher priority condition in the ring, 
EXERCISE-RING-FAIL is not reported.

Clear the EXERCISE-RING-FAIL Condition

Step 1 Look for and clear, if present, the “LOF (STMN)” alarm on page 2-82, the “LOS (STMN)” alarm on 
page 2-86, or a MS-SPRing alarm.

Step 2 Complete the “Initiate an Exercise Ring Switch on an MS-SPRing” procedure on page 2-129.

Step 3 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.6.53 EXERCISE-SPAN-FAIL 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Object: STMN

The Exercise Span command issues span switching of the requested channel without completing the 
actual bridge and switch. The EXERCISE-SPAN-FAIL alarm is raised if the command was issued and 
accepted but the exercise did not take place.

Note If the exercise command gets rejected due to the existence of a higher-priority condition in the span or 
ring, EXERCISE-SPAN-FAIL is not reported.

Clear the EXERCISE-SPAN-FAIL Condition

Step 1 Look for and clear, if present, the “LOF (STMN)” alarm on page 2-82, the “LOS (STMN)” alarm on 
page 2-86, or a MS-SPRing alarm.

Step 2 Complete the “Initiate an Exercise Ring Switch on an MS-SPRing” procedure on page 2-129.

Step 3 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).
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2.6.54 EXT
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

Logical Object: ENVALRM

A Failure Detected External to the NE alarm occurs because an environmental alarm is present. For 
example, a door could be open or flooding might have occurred.

Clear the EXT Alarm

Step 1 Click the Maintenance > Alarm Extenders > External Alarms tabs to gather further information about 
the EXT alarm.

Step 2 Follow your standard operating procedure to remedy environmental conditions that cause alarms. The 
alarm clears when the situation is remedied.

Step 3 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447).

2.6.55 EXTRA-TRAF-PREEMPT 
Default Severity: Major (MJ), Service-Affecting (SA) 

Logical Object: STMN

An Extra Traffic Preempted alarm occurs on STM-N cards in two-fiber and four-fiber MS-SPRings when 
low-priority traffic directed to the protect system has been preempted by a working system protection 
switch.

Clear the EXTRA-TRAF-PREEMPT Alarm

Step 1 Verify that the protection switch has occurred by checking the Conditions tab.

Step 2 If a ring switch has occurred, clear the ring switch on the working system by following the appropriate 
alarm in this chapter. For more information about protection switches, refer to the “Maintain the Node” 
chapter in the Cisco ONS 15600 SDH Procedure Guide.

Step 3 If the alarm occurred on a four-fiber MS-SPRing and the span switch occurred on this STM-N, clear the 
span switch on the working system.

Step 4 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447) to report a Service-Affecting (SA) problem.

2.6.56 FAILTOSW
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Object: STMN
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The Failure to Switch to Protection Facility condition occurs when a working or protect electrical facility 
switches to its companion port by using a MANUAL command. For example, if you attempt to manually 
switch traffic from an unused protect port to an in-service working port, the switch will fail (because 
traffic is already present on the working port) and you will see the FAILTOSW condition. 

Clear the FAILTOSW Condition

Step 1 Look up and troubleshoot the higher-priority alarm. Clearing the higher-priority condition frees the card 
and clears the FAILTOSW.

Step 2 If the condition does not clear, replace the working electrical (traffic) card that is reporting the higher 
priority alarm by following the correct replacement procedure in the “2.8.4 Physical Card Reseating, 
Resetting, and Replacement” procedure on page 2-133. This card is the working electrical card using the 
protect card and not reporting FAILTOSW.

Replacing the working electrical card that is reporting the higher-priority alarm allows traffic to revert 
to the working slot and the card reporting the FAILTOSW to switch to the protect card.

Note If an ONS 15600 SDH traffic (STM-N) card is implicated and you are able to continue using the 
traffic card with one port out of service, perform a bridge and roll to move the port traffic to a 
free port; refer to the “Manage Circuits” chapter in the Cisco ONS 15600 SDH Procedure Guide 
for instructions. Label the bad port, and place it out of service until such time as the card can be 
replaced.

Note When you replace a card with the identical type of card, you do not need to make any changes 
to the database.

Step 3 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.6.57 FAILTOSW-HO 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SDH Logical Objects: VCMON-HP

The High-Order Path Failure to Switch to Protection condition occurs when a high-order path circuit 
fails to switch to the working or protect electrical circuit using the MANUAL command. 

Clear the FAILTOSW-HO Condition

Step 1 Complete the “Clear the FAILTOSW Condition” procedure on page 2-52.
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Step 2 If the condition does not clear, log into the Cisco Technical Support Website at 
http://www.cisco.com/techsupport for more information or log into  
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free 
Technical Support numbers for your country.

2.6.58 FAILTOSWR
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Object: STMN 

The Fail to Switch to Protection Ring condition occurs when a ring switch did not complete because of 
internal APS problems.

FAILTOSWR clears in any of the following situations:

• A physical card pull of the active TSC card (done under Cisco TAC supervision).

• A node power cycle.

• A higher-priority event such as an external switch command.

• The next ring switch succeeds.

• The cause of the APS switch (such as the “MS-DEG” condition on page 2-98 or the “MS-EXC” 
condition on page 2-99) clears.

Warning Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector. 
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain 
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of 
100 mm could pose an eye hazard. Statement 1056 

Warning Use of controls, adjustments, or performing procedures other than those specified may result in 
hazardous radiation exposure. Statement 1057

Clear the FAILTOSWR Condition in a Two-Fiber MS-SPRing Configuration

Step 1 Perform the EXERCISE RING command on the reporting card by completing the following steps:

a. Click the Maintenance > MS-SPRing tabs.

b. Click the row of the affected ring under the West Switch column.

c. Select Exercise Ring from the drop-down list.

Step 2 If the condition does not clear, from the view menu, choose Go to Network View.

Step 3 Look for alarms on STM-N cards that make up the ring or span and troubleshoot these alarms.

Step 4 If clearing other alarms does not clear the FAILTOSW-RING condition, log into the near-end node.

Step 5 Click the Maintenance > MS-SPRing tabs.
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Step 6 Record the STM-N cards listed under West Line and East Line. Ensure that these STM-N cards and ports 
are active and in service by completing the following steps:

a. Verify the LED status: a green SRV LED indicates an active card. 

b. Double-click the card in CTC to display the card view.

c. Click the Provisioning > Line tabs.

d. Verify that the Admin State column lists the port as Unlocked.

e. If the Admin State column lists the port as Locked,maintenance or Locked,disabled, click the 
column and choose Unlocked. Click Apply.

Note If ports managed into Unlocked administrative state are not receiving signals, the LOS alarm 
is either raised or remains, and the port service state transitions to Unlocked-disabled,failed.

Step 7 If the STM-N cards are active and in service, verify fiber continuity to the ports on the recorded cards. 
To verify fiber continuity, follow site practices.

Step 8 If fiber continuity to the ports is good, use an optical test set to verify that a valid signal exists on the 
line. For specific procedures to use the test set equipment, consult the manufacturer. Test the line as close 
to the receiving card as possible.

Caution Using an optical test set disrupts service on the STM-N card. It could be necessary to manually switch 
traffic carrying circuits over to a protection path. Refer to the “2.8.2 Protection Switching, Lock 
Initiation, and Clearing” section on page 2-123 for commonly used switching procedures.

Step 9 If the signal is valid, clean the fiber according to site practice. If no site practice exists, complete the 
procedure in the “Maintain the Node” chapter in the Cisco ONS 15600 SDH Procedure Guide.

Step 10 If cleaning the fiber does not clear the condition, verify that the power level of the optical signal is within 
the STM-N card receiver specifications. The “1.9.3 Optical Traffic Card Transmit and Receive Levels” 
section on page 1-74 lists these specifications.

Step 11 Repeat Steps 7 through 10 for any other ports on the card.

Step 12 If the optical power level for all STM-N cards is within specifications, complete the “Replace an I/O 
Card” procedure on page 2-134 for the protect standby STM-N card.

Caution Removing a card that currently carries traffic on one or more ports can cause a traffic hit. To avoid this, 
perform an external switch if a switch has not already occurred. See the “2.8.2 Protection Switching, 
Lock Initiation, and Clearing” section on page 2-123 for commonly used traffic-switching procedures.

Note When you replace a card with the identical type of card, you do not need to make any changes 
to the database.

Step 13 If the condition does not clear after you replace the MS-SPRing cards on the node one by one, repeat 
Steps 4 through 12 for each of the nodes in the ring.

Step 14 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).
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2.6.59 FAILTOSWS
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Object: STMN

The Failure to Switch to Protection Span condition signals an APS span switch failure. For a four-fiber 
MS-SPRing, a failed span switch initiates a ring switch. If the ring switch occurs, the FAILTOSWS 
condition does not appear. If the ring switch does not occur, the FAILTOSWS condition appears. 
FAILTOSWS clears when one of the following situations occurs:

• A physical card pull of the active TSC card done under Cisco TAC supervision.

• A node power cycle.

• A higher-priority event such as an external switch command occurs.

• The next span switch succeeds.

• The cause of the APS switch (such as the “MS-DEG” condition on page 2-98 or the “MS-EXC” 
alarm on page 2-99) clears.

Clear the FAILTOSWS Condition

Step 1 Perform the EXERCISE SPAN command on the reporting card by completing the following steps:

a. Click the Maintenance > MS-SPRing tabs.

b. Determine whether the card you would like to exercise is the west card or the east card.

c. Click the row of the affected span under the East Switch or West Switch column.

d. Select Exercise Span in the drop-down list.

Step 2 If the condition does not clear, from the view menu, choose Go to Network View.

Step 3 Look for alarms on STM-N cards that make up the ring or span and troubleshoot these alarms.

Step 4 If clearing other alarms does not clear the FAILTOSWS condition, log into the near-end node.

Step 5 Click the Maintenance > MS-SPRing tabs.

Step 6 Record the STM-N cards listed under West Line and East Line. Ensure that these STM-N cards are active 
and in service by completing the following steps:

a. Verify the LED status: A green SRV LED indicates an active card. 

b. To determine whether the STM-N port is in service, double-click the card in CTC to display the card 
view.

c. Click the Provisioning > Line tabs.

d. Verify that the Admin State column lists the port as Unlocked.

e. If the Admin State column lists the port as Locked,maintenance or Locked,disabled, click the 
column and choose Unlocked. Click Apply.

Note If ports managed into Unlocked administrative state are not receiving signals, the LOS alarm 
is either raised or remains, and the port service state transitions to Unlocked-disabled,failed.

Step 7 If the STM-N cards are active and in service, verify fiber continuity to the ports on the recorded cards. 
To verify fiber continuity, follow site practices.
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Step 8 If fiber continuity to the ports is good, use an optical test set to verify that a valid signal exists on the 
line. For specific procedures to use the test set equipment, consult the manufacturer. Test the line as close 
to the receiving card as possible.

Caution Using an optical test set disrupts service on the STM-N card. It could be necessary to manually switch 
traffic carrying circuits over to a protection path. Refer to the “2.8.2 Protection Switching, Lock 
Initiation, and Clearing” section on page 2-123 for commonly used switching procedures.

Step 9 If the signal is valid, clean the fiber according to site practice. If no site practice exists, complete the 
procedure in the “Maintain the Node” chapter in the Cisco ONS 15600 SDH Procedure Guide.

Step 10 If cleaning the fiber does not clear the condition, verify that the power level of the optical signal is within 
the STM-N card receiver specifications. The “1.9.3 Optical Traffic Card Transmit and Receive Levels” 
section on page 1-74 lists these specifications.

Step 11 Repeat Steps 7 through 10 for any other ports on the card.

Step 12 If the optical power level for all STM-N cards is within specifications, complete the “Replace an I/O 
Card” procedure on page 2-134 for the protect standby STM-N card.

Caution Removing a card that currently carries traffic on one or more ports can cause a traffic hit. To avoid this, 
perform an external switch if a switch has not already occurred. See the “2.8.2 Protection Switching, 
Lock Initiation, and Clearing” section on page 2-123 for commonly used traffic-switching procedures.

Note When you replace a card with the identical type of card, you do not need to make any changes 
to the database.

Step 13 If the condition does not clear after you replace the MS-SPRing cards on the node one by one, follow 
Steps 4 through 12 for each of the nodes in the ring.

Step 14 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.6.60 FAN-DEGRADE
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

Logical Object: FAN

The Partial Fan Failure Speed Control Degradation alarm occurs if fan speed for one of the fans in the 
fan-tray assembly falls under 500 RPM when read by a tachometry counter.

Clear the FAN-DEGRADE Alarm

Step 1 Complete the “Clear the FAN-FAIL Alarm” procedure on page 2-57. 
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Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447).

2.6.61 FAN-FAIL
Default Severity: Critical (CR), Service-Affecting (SA)

Logical Object: FAN

The Fan Failure alarm occurs when two or more fans (out of a total of six) have failed. The 
ONS 15600 SDH has no standby fan. All fans should be active. The FAN-FAIL alarm can be 
accompanied by the “MFGMEM (FAN)” alarm on page 2-96 against the fan. This alarm can also be 
raised in conjunction with a “PWR” alarm on page 2-103.

Clear the FAN-FAIL Alarm

Step 1 If the “MFGMEM (FAN)” alarm on page 2-96 is also reported against the fan, complete the “Clear the 
MFGMEM (FAN) Alarm” procedure on page 2-96.

Step 2 If the alarm does not clear, check the condition of the air filter to see if it needs cleaning or replacement 
using the procedure located in the “Maintain the Node” chapter in the Cisco ONS 15600 SDH Procedure 
Guide.

Caution Always use the supplied electrostatic discharge wristband when working with a powered 
ONS 15600 SDH. Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf 
assembly.

Step 3 If the alarm does not clear and if the filter is clean, remove the reporting fan trays from the 
ONS 15600 SDH.

Step 4 Reinsert the fan trays, making sure you can hear the fans start operating.

Fans should run immediately when correctly inserted.

Step 5 If the alarm does not clear or if the fans do not run, replace the fan trays using the procedure located in 
the “Maintain the Node” chapter in the Cisco ONS 15600 SDH Procedure Guide.

Step 6 If the alarm does not clear or if the replacement fan trays do not operate correctly, log into the Technical 
Support Website at http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 
553-2447) to report a Service-Affecting (SA) problem.

2.6.62 FAN-FAIL-PARTIAL
Default Severity: Major (MJ), Non-Service-Affecting (NSA) 

Logical Object: FAN

The Partial Fan Failure alarm occurs when one of the six fans in the shelf fails. 
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Troubleshoot with the “Clear the FAN-FAIL Alarm” procedure on page 2-57 procedure. If the alarm 
does not clear, log on to http://www.cisco.com/tac for more information or call Cisco TAC at 
1-800-553-2447. 

2.6.63 FAN-PWR
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

Logical Object: FAN

The Fan Power Failure alarm occurs when a power feed (A or B) from the shelf to Fan Tray 1, 2, or 3 
fails. Because fans are not able to differentiate the power feeds, there is only one alarm for A or B failure.

Clear the FAN-PWR Alarm

Step 1 Remove the reporting fan trays from the ONS 15600 SDH.

Caution Always use the supplied electrostatic discharge wristband when working with a powered 
ONS 15600 SDH. Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf 
assembly.

Step 2 Reinsert the fan trays, making sure you hear the fans start to operate.

Fans should run immediately when correctly inserted.

Step 3 If the alarm does not clear or if the fans do not run, replace the fan trays using the procedure located in 
the “Maintain the Node” chapter in the Cisco ONS 15600 SDH Procedure Guide.

Step 4 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447).

2.6.64 FE-FRCDWKSWBK-SPAN
The FE-FRCDWKSWBK-SPAN condition is not used in this platform in this release. It is reserved for 
development.

2.6.65 FE-FRCDWKSWPR-RING
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Object: STMN

The Far End Ring Working Facility Forced to Switch to Protection condition occurs when a far-end node 
ring is forced from working to protect using the FORCE RING command. This condition is only visible 
on the network view Conditions tab.

The prefix FE means the main alarm is occurring at the far-end node and not at the node reporting the 
FE-FRCDWKSWPR-RING condition. Troubleshoot the FE condition by troubleshooting the main alarm 
at its source. The secondary alarms or conditions clear when the primary alarm clears.
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Clear the FE-FRCDWKSWPR-RING Condition

Step 1 To troubleshoot an FE condition, determine which node and card link directly to the card reporting the 
FE alarm. For example, an FE-AIS condition from the STM-16 card in Slot 12 of Node 1 could link to 
the main AIS condition from an STM-16 card in Slot 6 of Node 2.

Step 2 Log into the node that links directly to the card reporting the FE condition.

Step 3 Clear the main alarm. 

Step 4 If the FE-FRCDWKSWPR-RING condition does not clear, complete the “Clear a MS-SPRing External 
Switching Command” procedure on page 2-130.

Step 5 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.6.66 FE-FRCDWKSWPR-SPAN 
The FE-FRCDWKSWPR-SPAN condition is not used in this platform in this release. It is reserved for 
development.

2.6.67 FE-LOCKOUTOFPR-ALL 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Object: STMN

The Far End Lockout of Protection All condition occurs on far-end MS-SPRing nodes when traffic is 
locked on a node using the LKOUTPR-S command.

The prefix FE means the main alarm is occurring at the far-end node and not at the node reporting this 
condition. Troubleshoot the FE condition by troubleshooting the main alarm at its source. Both the 
alarms or conditions clear when the main alarm clears. 

Clear the FE-LOCKOUTOFPR-ALL Condition

Step 1 To troubleshoot an FE condition, determine which node and card link directly to the card reporting the 
FE alarm.

Step 2 Log into the node that links directly to the card reporting the FE condition.

Step 3 Ensure there is no lockout set. Complete the “Clear a MS-SPRing External Switching Command” 
procedure on page 2-130.

Step 4 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).
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2.6.68 FE-LOCKOUTOFPR-SPAN 
The FE-LOCKOUTOFPR-SPAN condition is not used in this platform in this release. It is reserved for 
development.

2.6.69 FE-MANWKSWBK-SPAN
The FE-MANWKSWBK-SPAN condition is not used in this platform in this release. It is reserved for 
development.

2.6.70 FE-MANWKSWPR-RING
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Object: STMN

The Far End Ring Manual Switch of Working to Protect condition occurs when a MS-SPRing working 
ring is switched from working to protect at a far-end node using the MANUAL RING command.

Clear the FE-MANWKSWPR-RING Condition

Step 1 To troubleshoot an FE condition, determine which node and card link directly to the card reporting the 
FE alarm. For example, an FE-AIS condition from the STM-16 card in Slot 12 of Node 1 could link to 
the main AIS condition from an STM-16 card in Slot 6 of Node 2.

Step 2 Log into the node that links directly to the card reporting the FE condition.

Step 3 Complete the “Clear a MS-SPRing External Switching Command” procedure on page 2-130.

Step 4 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.6.71 FE-MANWKSWPR-SPAN 
The FE-MANWKSWPR-SPAN condition is not used in this platform in this release. It is reserved for 
development.

2.6.72 FEPRLF 
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

Logical Object: STMN

The Far-End Protection Line Failure alarm occurs when there is an “MS-EXC” condition on page 2-99 
condition on the protect card’s APS channel coming into the node.
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Note The FEPRLF alarm occurs on the ONS 15600 SDH only when bidirectional protection is used on optical 
(traffic) cards in a 1+1 protection group configuration.

Clear the FEPRLF Alarm on an MS-SPRing

Step 1 To troubleshoot the FE alarm, determine which node and card is linked directly to the card reporting the 
FE alarm. 

Step 2 Log into the node that is linked directly to the card reporting the FE alarm.

Step 3 Clear the main alarm. Refer to the appropriate alarm section in this chapter for procedures.

Step 4 If the alarm does not clear, log into the Cisco Technical Support Website at 
http://www.cisco.com/techsupport for more information or log into  
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free 
Technical Support numbers for your country.

2.6.73 FE-SF-SPAN
The FE-SF-SPAN condition is not used in this platform in this release. It is reserved for development.

2.6.74 FORCED-REQ
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA) 

Logical Object: VCMON-HP

The Force Switch Request on Facility or Port condition occurs when you enter the Force command on a 
port to force traffic from a working port to a protect port or protection span (or from a protect port to a 
working port or span). You do not need to clear the condition if you want the Force switch to remain.

Clear the FORCED-REQ Condition

Step 1 Complete the “Clear a 1+1 Protection Port Force or Manual Switch Command” procedure on 
page 2-124. 

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.6.75 FORCED-REQ-RING
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Object: STMN
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The Force Switch Request Ring condition applies to optical trunk cards when the FORCE RING 
command is applied to MS-SPRings to move traffic from working to protect. This condition is visible 
on the network view Alarms, Conditions, and History tabs and is accompanied by WKSWPR. The port 
where the FORCE RING command originated is marked with an “F” on the network view detailed circuit 
map.

Clear the FORCED-REQ-RING Condition

Step 1 Complete the “Clear a MS-SPRing External Switching Command” procedure on page 2-130.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.6.76 FORCED-REQ-SPAN 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Object: STMN

The Force Switch Request Span condition applies to optical trunk cards in two-fiber or four-fiber 
MS-SPRings when the Force Span command is applied to a MS-SPRing SPAN to force traffic from 
working to protect or from protect to working. This condition appears on the network view Alarms, 
Conditions, and History tabs. The port where the FORCE SPAN command was applied is marked with 
an “F” on the network view detailed circuit map.

This condition can also be raised in 1+1 facility protection groups. If traffic is present on a working port 
and you use the FORCE command to prevent it from switching to the protect port (indicated by 
“FORCED TO WORKING”), FORCED-REQ-SPAN indicates this force switch. In this case, the force 
is affecting not only the facility, but the span.

Clear the FORCED-REQ-SPAN Condition

Step 1 Complete the “Clear a MS-SPRing External Switching Command” procedure on page 2-130.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.6.77 FRCDSWTOINT 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Object: NE-SREF

The Force Switch to Internal Timing condition occurs when the user issues a Force command to switch 
to an internal timing source.

Note FRCDSWTOINT is an informational condition and does not require troubleshooting.
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2.6.78 FRCDSWTOPRI
The FRCDSWTOPRI condition is not used in this platform in this release. It is reserved for development.

2.6.79 FRCDSWTOSEC
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA) 

Logical Objects: EXT-SREF, NE-SREF 

The Force Switch to Second Timing Source condition occurs when the user issues a Force command to 
switch to the second timing source. 

Note FRCDSWTOSEC is an informational condition. It does not require troubleshooting. 

2.6.80 FRCDSWTOTHIRD
The FRCDSWTOTHIRD condition is not used in this platform in this release. It is reserved for 
development.

2.6.81 FREQ-MISMATCH
Default Severity: Minor (MN), Non-Service-Affecting (NSA) 

Logical Object: EQPT

The Frequency Mismatch alarm occurs when one of the two TSC cards has a timing module failure that 
causes an inconsistency between the TSC card timing frequencies. This alarm can be caused by the active 
or standby TSC card.

The ONS 15600 SDH checks timing frequency synchronization in 83-minute (1 hour and 23 minutes) 
cycles. The FREQ-MISMATCH alarm occurs if two consecutive timing check cycles show frequency 
mismatches. The alarm is cleared if one cycle shows a timing frequency match between the TSC cards. 

Clear the FREQ-MISMATCH Alarm

Step 1 Complete the “Replace a TSC Card” procedure on page 2-136 for the standby TSC card.

Step 2 Wait for two intervals of 83 minutes (2 hours and 46 minutes) and check the node view Alarms tab to 
see whether the alarm is cleared.

During the initial 83-minute synchronization check cycle while the replacement standby TSC card is 
booting up, the replacement TSC card is attaining the timing from the BITS or internal source so it is 
normal that the two TSC cards are not synchronized. The ONS 15600 SDH system disregards the result 
of this check cycle and begins keeping track of synchronization in the second 83-minute cycle. If the 
result of the cycle shows that the TSC cards are synchronized properly, the alarm is cleared.

Step 3 If the FREQ-MISMATCH alarm did not clear after two timing check cycles, it means that the second 
timing cycle resulted in a mismatch. Wait a third 83-minute cycle and check the alarm again. 
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If the alarm has cleared, it means a third cycle showed that the TSC card timing modules were 
synchronized. If the alarm remains, it means that the ONS 15600 SDH system has had two frequency 
mismatch cycles, and indicates a problem with the other TSC card.

Step 4 If the FREQ-MISMATCH alarm remains after three 83-minute cycles, complete the “Soft-Reset a Card 
Using CTC” procedure on page 2-130 to make the TSC card standby.

Step 5 Complete the “Reset a Card with a Card Pull (Reseat)” procedure on page 2-133 for the standby TSC 
card.

The card removal and reboot temporarily clears the alarm. 

Step 6 Wait for three intervals of 83 minutes (4 hours and 9 minutes) and check CTC to see if the 
FREQ-MISMATCH alarm has recurred. If it has not recurred, the problem is solved.

Step 7 If the alarm has recurred after both TSC cards have been replaced, log into the Technical Support 
Website at http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.6.82 FRNGSYNC
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA) 

Logical Object: NE-SREF

The Free Running Synchronization Mode condition occurs when the reporting ONS 15600 SDH is in 
free-run synchronization mode. External timing sources have been disabled and the node is using its 
internal clock, or the node has lost its designated BITS timing source. After the 24-hour holdover period 
expires, timing slips could begin to occur on an ONS 15600 SDH node relying on an internal clock.

Note If the ONS 15600 SDH is configured to operate from its internal clock, disregard the FRNGSYNC 
condition.

Clear the FRNGSYNC Condition

Step 1 If the ONS 15600 SDH is configured to operate from an external timing source, verify that the BITS 
timing source is valid. Common problems with a BITS timing source include reversed wiring and bad 
timing cards. Refer to the “Timing” chapter in the Cisco ONS 15600 SDH Reference Manual for more 
information about it.

Step 2 If the BITS source is valid, clear alarms related to the failures of the primary and secondary reference 
sources, such as the “SYNCPRI” alarm on page 2-115 and the “SYNCSEC” alarm on page 2-115.

Step 3 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.6.83 FSTSYNC
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Object: EQPT
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The Fast Synchronization Mode condition occurs when the ONS 15600 SDH synchronizes its clock 
modules. Since the ONS 15600 SDH uses Stratum 3E timing, synchronization can take about 12 
minutes. This condition occurs on the TSC card where the timing distribution is sourced. Whenever this 
condition is active, any timing or controller switching might affect the traffic. Errorless switching is not 
guaranteed.The “UNPROT-SYNCCLK” alarm on page 2-116 can accompany this condition if there is 
no timing protection is available while the clock is synchronizing. 

If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.6.84 FULLPASSTHR-BI
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Object: STMN

The Bidirectional Full Pass-Through Active condition occurs on a nonswitching node in a MS-SPRing 
when the protect channels on the node are active and carrying traffic and a change is present in the 
receive K byte from “No Request.” (Both data and K bytes are in pass-through mode.)

Clear the FULLPASSTHR-BI Condition

Step 1 Complete the “Clear a MS-SPRing External Switching Command” procedure on page 2-130.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447) to report a 
Service-Affecting (SA) problem.

2.6.85 GFP-LFD
The GFP-LFD condition is not used in this platform in this release. It is reserved for development.

2.6.86 GFP-UP-MISMATCH
For information about this condition, refer to the “Alarm Troubleshooting” chapter of the 
Cisco ONS 15454 DWDM Troubleshooting Guide.

2.6.87 HELLO
Default Severity: Minor (MN), Non-Service-Affecting (NSA) 

Logical Object: STMN

The Open Shortest Path First (OSPF) Hello Fail alarm occurs when SDH DCC termination OSPF area 
IDs are mismatched between two DCC terminations for a span. On a span between two 
ONS 15600 SDHs, this alarm occurs at both nodes containing the mismatched DCC area IDs. On a span 
between an ONS 15600 SDH and an ONS 15454 SDH, this alarm is raised only on the ONS 15600 SDH 
node. Mismatched OSPF area IDs can cause CTC to lose management across the link.
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Clear the HELLO Alarm

Step 1 Log into both end nodes with the DCC terminations. 

Step 2 On the nodes where the alarm occurred, record the slot and port (from the Slot column and Port column 
in the Alarms window) that the Hello alarm occurs against. This information helps you determine which 
DCC termination is mismatched.

Tip You can log into another node by going to network view and double-clicking the node.

Step 3 On one node, in node view, click the Provisioning > Network > OSPF tabs.

Step 4 In the DCC OSPF Area ID Table area, locate the alarmed DCC termination by comparing slot and port 
numbers to the slot and port number indicated in the alarm on the node.

Step 5 Click the Area ID column cell for the mismatched DCC termination. 

Step 6 Change the area ID in the cell to the same ID as its partner DCC termination. (The ONS 15600 SDH 
defaults to 0.0.0.0 format addresses.) 

Step 7 Click Apply.

Step 8 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447).

2.6.88 HIBATVG
The HIBATVG condition is not used in this platform in this release. It is reserved for development.

2.6.89 HI-LASERBIAS 
For information about this condition, refer to the “Alarm Troubleshooting” chapter of the 
Cisco ONS 15454 DWDM Troubleshooting Guide.

2.6.90 HI-RXPOWER 
For information about this condition, refer to the “Alarm Troubleshooting” chapter of the 
Cisco ONS 15454 DWDM Troubleshooting Guide.

2.6.91 HI-TXPOWER 
For information about this condition, refer to the “Alarm Troubleshooting” chapter of the 
Cisco ONS 15454 DWDM Troubleshooting Guide.

2.6.92 HLDOVRSYNC
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA) condition
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Logical Object: NE-SREF

The Holdover Synchronization Mode condition is caused by loss of the primary and second timing 
references in the node. Timing reference loss occurs when line coding on the timing input is different 
from the configuration on the node, and it often occurs during the selection of a new node reference 
clock. The condition clears when primary or second timing is reestablished. After the 24-hour holdover 
period expires, timing slips could begin to occur on an ONS 15600 SDH relying on an internal clock.

Clear the HLDOVRSYNC Condition

Step 1 Clear additional alarms that relate to timing, such as:

• 2.6.82 FRNGSYNC, page 2-64

• 2.6.83 FSTSYNC, page 2-64 

• 2.6.116 LOF (BITS), page 2-81 

• 2.6.123 LOS (BITS), page 2-85 

• 2.6.135 MANSWTOINT, page 2-91 

• 2.6.136 MANSWTOPRI, page 2-92 

• 2.6.137 MANSWTOSEC, page 2-92 

• 2.6.138 MANSWTOTHIRD, page 2-92 

• 2.6.180 SWTOPRI, page 2-113 

• 2.6.181 SWTOSEC, page 2-113 

• 2.6.182 SWTOTHIRD, page 2-113 

• 2.6.185 SYNC-FREQ, page 2-114 

• 2.6.186 SYNCPRI, page 2-115 

• 2.6.187 SYNCSEC, page 2-115 

• 2.6.188 SYNCTHIRD, page 2-116

Step 2 Reestablish a primary and secondary timing source according to local site practice. If none exists, refer 
to the “Change Node Settings” chapter in the Cisco ONS 15600 SDH Procedure Guide to find one.

Step 3 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447) in order to 
report a Service-Affecting (SA) problem.

2.6.93 HP-DEG
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Object: VCMON-HP

The High-Order Path Signal Degrade condition occurs when the B3 error count in the SDH overhead 
exceeds the limit.
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Clear the HP-DEG Condition

Step 1 Troubleshoot using the “Clear the MS-DEG Condition” procedure on page 2-98.

Step 2 If the condition does not clear, log into the Cisco Technical Support Website at 
http://www.cisco.com/techsupport for more information or log into  
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free 
Technical Support numbers for your country.

2.6.94 HP-EXC
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Object: VCMON-HP

The High Order Path-Excessive BER condition occurs when the B3 error count in the SDH overhead 
exceeds the limit.

Clear the HP-DEG Condition

Step 1 Troubleshoot using the “Clear the MS-DEG Condition” procedure on page 2-98.

Step 2 If the condition does not clear, log into the Cisco Technical Support Website at 
http://www.cisco.com/techsupport for more information or log into  
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free 
Technical Support numbers for your country.

2.6.95 HP-PLM
The HP-PLM condition is not used in this platform in this release. It is reserved for development.

2.6.96 HP-RFI 
Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)

Logical Object: VCMON-HP

The High-Order Remote Failure Indication (RFI) condition indicates that there is a remote failure 
indication in the high-order (VC-4 or VC-3) path, and that the failure has persisted beyond the maximum 
time allotted for transmission system protection. The HP-RFI is sent as the protection switch is initiated. 
Resolving the fault in the adjoining node clears the HP-RFI condition in the reporting node.

Clear the HP-RFI Condition

Step 1 Log into the node at the far end of the reporting ONS 15600 SDH.

Step 2 Determine whether there are any related alarms, especially the “LOS (STMN)” alarm on page 2-86.
2-68
Cisco ONS 15600 SDH Troubleshooting Guide, R8.0

July 2010



Chapter 2 Alarm Troubleshooting
2.6.97  HP-TIM
Step 3 Clear the main alarm. See the appropriate alarm section in this chapter for procedures.

Step 4 If the condition does not clear, log into the Cisco Technical Support Website at 
http://www.cisco.com/techsupport for more information or log into  
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free 
Technical Support numbers for your country.

2.6.97 HP-TIM 
Default Severities: Minor (MN), Non-Service-Affecting (NSA)

SDH Logical Objects: VCMON-HP

The TIM High-Order TIM Failure alarm indicates that the trace identifier J1 byte of the high-order 
(VC-4 or VC-3) overhead is faulty. HP-TIM occurs when there is a mismatch between the transmitted 
and received J1 identifier byte in the SDH path overhead. The error can originate at the transmit end or 
the receive end.

Clear the HP-TIM Alarm

Step 1 Use an optical test set capable of viewing SDH path overhead to determine the validity of the J1 byte. 
For specific procedures to use the test set equipment, consult the manufacturer. Examine the signal as 
near to the reporting card as possible.

• Examine the signal as close as possible to the output card.

Step 2 If the output card signal is valid, complete the “Clear the SYNCPRI Alarm” procedure on page 2-115.

Step 3 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or log into  http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to 
obtain a directory of toll-free Technical Support numbers for your country. If the alarm applies to 
VCTRM-HP, it is a service-affecting problem.

2.6.98 HP-UNEQ 
Default Severity: Critical (CR), Service-Affecting (SA)

Logical ObjectS: VCMON-HP

The signal label mismatch fault (SLMF) Unequipped High-Order Path alarm applies to the C2 path 
signal label byte in the high-order (VC-4) path overhead. HP-UNEQ occurs when no C2 byte is received 
in the SDH path overhead.

Clear the HP-UNEQ Alarm

Step 1 From the View menu, choose Go to Network View.

Step 2 Right-click the alarm to display the Select Affected Circuits shortcut menu.

Step 3 Click Select Affected Circuits.
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Step 4 When the affected circuits appear, look in the Type column for a virtual circuit (VC).

Step 5 If the Type column does not contain a VC, there are no VCs. Go to Step 7.

Step 6 If the Type column does contain a VC, attempt to delete these row(s) by completing the following steps:

Note The node does not allow you to delete a valid VC.

a. Click the VC row to highlight it. Delete the circuit.

b. If an error message dialog box appears, the VC is valid and not the cause of the alarm.

c. If any other rows contain VT, repeat Steps a through b.

Step 7 If all ONS nodes in the ring appear in the CTC network view, verify that the circuits are all complete by 
completing the following steps:

a. Click the Circuits tab.

b. Verify that INCOMPLETE is not listed in the Status column of any circuits.

Step 8 If you find circuits listed as incomplete, verify that these circuits are not working circuits that continue 
to pass traffic, using an appropriate optical test set and site-specific procedures. For specific procedures 
to use the test set equipment, consult the manufacturer.

Step 9 If the incomplete circuits are not needed or are not passing traffic, delete the incomplete circuits.

Step 10 Recreate the circuit with the correct circuit size. Refer to the “Create Circuits and Tunnels” chapter in 
the Cisco ONS 15600 SDH Procedure Guide for circuit procedures.

Step 11 Log back in and verify that all circuits terminating in the reporting card are active by completing the 
following steps:

a. Click the Circuits tab.

b. Verify that the Status column lists all circuits as active.

Step 12 If the alarm does not clear, clean the far-end optical fiber according to site practice. If no site practice 
exists, complete the procedure in the “Maintain the Node” chapter in the Cisco ONS 15600 SDH 
Procedure Guide.

Warning On the OC192 LR/STM64 LH 1550 card, the laser is on when the card is booted and the safety key is in 
the on position (labeled 1). The port does not have to be in service for the laser to be on. The laser is 
off when the safety key is off (labeled 0). Statement 293

Warning Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector. 
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain 
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of 
100 mm could pose an eye hazard. Statement 1056 

Warning Use of controls, adjustments, or performing procedures other than those specified could result in 
hazardous radiation exposure. Statement 1057

Step 13 If the alarm does not clear, replace the optical and/or Ethernet cards.
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Caution Removing a card that currently carries traffic on one or more ports can cause a traffic hit. To avoid this, 
perform an external switch if a switch has not already occurred. Refer to the “Maintain the Node” chapter 
in the Cisco ONS 15600 SDH Procedure Guide for information.

Note When you replace a card with the identical type of card, you do not need to make any changes 
to the database.

Step 14 If the alarm does not clear, log into the Cisco Technical Support Website at 
http://www.cisco.com/techsupport for more information or log into  
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free 
Technical Support numbers for your country in order to report a Service-Affecting (SA) problem.

2.6.99 IMPROPRMVL (CAP)
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

Logical Object: CAP

The Improper Removal CAP alarm occurs when a CAP is not correctly installed on the backplane or is 
missing altogether. The problem is not user serviceable. Contact the Cisco TAC at 1-800-553-2447.

2.6.100 IMPROPRMVL (EQPT, PIM, PPM)
Default Severity: Critical (CR), Service-Affecting (SA)

Logical Objects: EQPT, PIM, PPM

The Improper Removal equipment (IMPROPRMVL (EQPT, PIM, PPM)) alarm occurs under the 
following conditions:

• A card is removed when the card was rebooting. It is recommended that after the card completely 
reboots, delete the card in CTC and only then remove the card physically. When you delete the card, 
CTC loses connection with the node view (single-shelf mode) or shelf view (multishelf mode), and 
goes to network view.

• When a card is physically removed from its slot before it is deleted from CTC. It is recommended 
that any card be deleted in CTC before physically removing the card from the chassis.

Note CTC provides the user approximately 15 seconds to physically remove the card before it begins 
rebooting the card.
It can take up to 30 minutes for software to be updated on a standby TSC card.

• A card is inserted into a slot but is not fully plugged into the backplane.

• A PPM (SFP) is provisioned but the physical module is not inserted into the port, or if no PPM is 
inserted into the 4PIO (PIM).

• Electrical issues such as short circuit or failure of DC-DC conversion.
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Clear the IMPROPRMVL (EQPT, PIM, PPM) Alarm

Step 1 In node view, right-click the card reporting the IMPROPRMVL.

Step 2 Choose Delete from the shortcut menu.

Note CTC does not allow you to delete the reporting card if the card is in service, does have circuits 
mapped to it, is paired in a working protection scheme, has DCC enabled, or is used as a timing 
reference. However if none of these services is provisioned, you can delete an Unlocked card.

Step 3 If any ports on the card are in service, place them out of service (Locked,maintenance) by completing 
the following steps:

Caution Before placing a port out of service (Locked,maintenance or Locked,disabled), ensure that no live traffic 
is present.

a. In node view, double-click the reporting card to display the card view.

b. Click the Provisioning > Line tabs.

c. Click the Admin State column of any in-service (Unlocked) ports.

d. Choose Locked,maintenance to take the ports out of service.

Step 4 If a circuit has been mapped to the card, delete it using the procedure in the “Manage Circuits” chapter 
in the Cisco ONS 15600 SDH Procedure Guide.

Caution Before deleting the circuit, ensure that the circuit does not carry live traffic.

Step 5 If the card is paired in a protection scheme, delete the protection group by completing the following 
steps:

a. Click View > Go to Previous View to return to node view.

b. If you are already in node view, click the Provisioning > Protection tabs.

c. Click the protection group of the reporting card.

d. Click Delete.

Step 6 If the card is provisioned for DCC, delete the DCC provisioning by completing the following steps:

a. Click the node view Provisioning > Comm Channels > RS-DCC tabs. 

b. Click the slots and ports listed in DCC terminations.

c. Click Delete and click Yes in the dialog box that appears.

Step 7 If the card is used as a timing reference, change the timing reference by completing the following steps:

a. Click the Provisioning > Timing > General tabs.

b. Under NE Reference, click the drop-down arrow for Ref-1.

c. Change Ref-1 from the listed STM-N card to Internal Clock.

d. Click Apply.
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Step 8 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA) 
problem. 

2.6.101 IMPROPRMVL (EQPT for the SSXC or TSC Card)
Default Severity: Critical (CR), Service-Affecting (SA)

Logical Object: EQPT

The Improper Removal SSXC, Traffic Card, or TSC card alarm occurs when a TSC card, SSXC card, or 
traffic (STM-N) card is physically removed from its slot. This alarm can occur if the card is recognized 
by CTC and the active TSC card but is not in service. For example, it could be inserted in the slot but 
not fully plugged into the backplane.

If the removed TSC card or SSXC card is the last one on the shelf, the severity is Critical (CR) and traffic 
is affected. Otherwise, the alarm is Minor (MN).

Caution Do not remove and reinsert (reseat) a card during a card reboot. If CTC begins to reboot a card before 
you remove the card, allow the card to finish rebooting. After the card reboots, delete the card in CTC 
again and physically remove the card before it begins to reboot.

Note After deleting a card in CTC, the software allows you approximately 15 seconds to physically remove 
the card before CTC begins a card reboot.

Clear the IMPROPRMVL (SSXC, TSC) Alarm

Step 1 Complete the “Reset a Card with a Card Pull (Reseat)” procedure on page 2-133 for the TSC card or 
SSXC. (The procedure is similar for both.)

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447).

2.6.102 IMPROPRMVL (FAN)
Default Severity: Critical (CR), Service-Affecting (SA)

Logical Object: FAN

The Improper Removal Fan alarm occurs when Fan Tray 1, 2, or 3 is physically removed from its slot.

Clear the IMPROPRMVL (FAN) Alarm

Step 1 Refer to the “Maintain the Node” chapter in the Cisco ONS 15600 SDH Procedure Guide for procedures 
to replace the fan-tray assembly.
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Caution Always use the supplied electrostatic discharge wristband when working with a powered 
ONS 15600 SDH. Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf 
assembly.

Step 2 If the fan tray does not run immediately, troubleshoot with the “Clear the FAN-FAIL Alarm” procedure 
on page 2-57.

Step 3 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447).

2.6.103 IMPR-XC 
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

Logical Object: NE

The Improper Cross-Connect Card alarm indicates that the CXC card is being used rather than the SSXC 
(the preferred cross-connect card for Software R5.0 and later). The alarm remains standing as long as a 
CXC is present on the node. Since a CXC card is still capable of passing traffic, the alarm is not 
Service-Affecting (SA). However, a system containing a CXC card and the current software release is 
not fully guaranteed for functionality.

Note IMPR-XC is an informational alarm and does not require troubleshooting. However, if you are 
experiencing cross-connect related problems at this site, also report this alarm to the Cisco TAC.

2.6.104 INCOMPATIBLE-SEND-PDIP
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

Logical Object: SYSTEM

The Incompatible Send-PDIP alarm is raised when CTC’s send-PDIP provisioning differs from the host 
node's provisioning.

Clear the INCOMPATIBLE-SEND-PDIP Alarm

Step 1 Reconfigure CTC’s send-PDI-P alarm capability to align with the host node settings.

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1-800-553-2447). 

2.6.105 INCOMPATIBLE-SW
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

Logical Object: SYSTEM
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The Incompatible Software alarm is raised when CTC cannot connect to the NE due to incompatible 
versions of software between CTC and the NE. The alarm is cleared by restarting CTC in order to 
redownload the CTC JAR files from the NE.

Clear the INCOMPATIBLE-SW Alarm

Step 1 Restart the CTC application.

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1-800-553-2447). 

2.6.106 INTRUSION-PSWD
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Object: NE

The Security Intrusion Incorrect Password condition occurs after a user attempts a provisionable (by 
Superuser) number of unsuccessful logins, a login with an expired password, or an invalid password. The 
alarmed user is locked out of the system, and INTRUSION-PSWD condition is raised. This condition is 
only shown in Superuser login sessions, not in login sessions for lower-level users. The 
INTRUSION-PSWD condition is automatically cleared when a provisionable lockout timeout expires, 
or it can be manually cleared in CTC by the Superuser if lockout is permanent.

Clear the INTRUSION-PSWD Condition

Step 1 Click the Provisioning > Security > Users tabs.

Step 2 Click Clear Security Intrusion Alarm.

Step 3 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.6.107 INVMACADR
Default Severity: Major (MJ), Non-Service-Affecting (NSA) 

Logical Object: BPLANE

The Invalid MAC Address alarm occurs when the ONS 15600 SDH MAC address retrieval fails and the 
node does not have a valid MAC address to support the operating system (OS). Do not attempt to 
troubleshoot an INVMACADR alarm. Contact the Cisco TAC at (1-800-553-2447).

Clear the INVMACADR Alarm 

Step 1 Check for any outstanding alarms that were raised against the active and standby TSC and resolve them. 

Step 2 At the earliest maintenance window, reset the standby TSC: 
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Note The reset requires approximately five minutes. Do not perform any other step until the reset is complete. 

a. Log into a node on the network. If you are already logged in, continue with Step b. 

b. Identify the active TSC. 

A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card. 

c. Right-click the standby TSC. 

d. Choose Reset Card from the shortcut menu. 

e. Click Yes in the Are You Sure dialog box. 

The card resets, the FAIL LED blinks on the physical card, and connection to the node is lost. CTC 
switches to network view. 

f. Verify that the reset is complete and error-free, and that no new related alarms appear in CTC. A 
green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card. 

g. Double-click the node and ensure that the reset TSC is still in standby mode and that the other TSC 
is active. 

A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card. 

h. Ensure that no new alarms associated with this reset appear in the CTC Alarms window. 

If the standby TSC fails to boot into standby mode, then open a case with Cisco TAC (1 800 553-2447) 
for assistance. 

Step 3 If the standby TSC rebooted successfully into standby mode, complete the “Reset a Card with a Card 
Pull (Reseat)” procedure. 

Resetting the active TSC causes the standby TSC to become active. The standby TSC keeps a copy of 
the chassis MAC address. If its stored MAC address is valid, the alarm should clear. 

Step 4 After the reset, note whether or not the INVMACADR alarm has cleared or is still present. 

Step 5 Complete the “Soft-Reset a Card Using CTC” procedure again to place the standby TSC back into active 
mode. 

After the reset, note whether or not the INVMACADR alarm has cleared or is still present. If the 
INVMACADR alarm remains standing through both TSC resets, proceed to Step 7. 

If the INVMACADR was raised during one TSC reset and cleared during the other, the TSC that was 
active while the alarm was raised needs to be replaced. Continue with Step 6. 

Step 6 If the faulty TSC is currently in standby mode, complete the “Replace a TSC Card” procedure for this 
card. If the faulty TSC is currently active, during the next available maintenance window complete the 
“Soft-Reset a Card Using CTC” procedure and then complete the “Replace a TSC Card” procedure. 

Note If the replacement TSC is loaded with a different software version from the current TSC, the card bootup 
could take up to 30 minutes. During this time, the card LEDs flicker between Fail and Act/Sby as the 
active TSC version software is copied to the new standby card. 

Step 7 Open a case with Cisco TAC (1 800 553-2447) for assistance with determining the node's previous MAC 
address. 
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Step 8 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC 1 800 553-2447. 

2.6.108 ISIS-ADJ-FAIL
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

Logical Object: STMN

The Open System Interconnection (OSI) Intermediate System to Intermediate-System (IS-IS) Adjacency 
Failure alarm is raised by an intermediate system (node routing IS Level 1 or Level 1 and 2) when no IS 
or end system (ES) adjacency is established on a point-to-point subnet. The Intermediate-System 
Adjacency Failure alarm is not supported by ES. It is also not raised by IS for disabled routers.

The alarm is typically caused by a misconfigured router manual area adjacency (MAA) address. For 
more information about IS-IS OSI routing and MAA configuration, refer to the “Management Network 
Connectivity” chapter in the Cisco ONS 15600 SDH Reference Manual. For more information about 
configuring OSI, refer to the “Turn Up Node” chapter in the Cisco ONS 15600 SDH Procedure Guide.

Clear the ISIS-ADJ-FAIL Alarm

Step 1 Ensure that both ends of the comm channel are using the correct Layer 2 protocol and settings (LAPD 
or PPP). To do this, complete the following steps:

a. At the local node, in node view, click the Provisioning > Comm Channels > RS-DCC tabs.

b. Click the row of the circuit. Click Edit.

c. In the Edit RS-DCC termination dialog box, view and record the following selections: Layer 2 
protocol (LAPD or PPP); Mode radio button selection (AITS or UITS); Role radio button selection 
(Network or User); MTU value; T200 value; and T203 selections.

d. Click Cancel.

e. Log in to the remote node and follow the same steps, also recording the same information for this 
node.

Step 2 If both nodes do not use the same Layer 2 settings, you will have to delete the incorrect termination and 
recreate it. To delete it, click the termination and click Delete. To recreate it, refer to the “Turn Up Node” 
chapter in the Cisco ONS 15600 SDH Procedure Guide for the procedure.

Step 3 If the nodes use Point-to-Point Protocol (PPP) Layer 2, complete the “Clear the EOC Alarm” procedure 
on page 2-42. If the alarm does not clear, go to Step 7.

Step 4 If both nodes use the LAPD Layer 2 protocol but have different Mode settings, change the incorrect 
node’s entry by clicking the correct setting radio button in the Edit RS-DCC termination dialog box and 
clicking OK.

Step 5 If the Layer 2 protocol and Mode settings are correct, ensure that one node is using the Network role and 
the other has the User role. If not (that is, if both have the same mode settings), correct the incorrect one 
by clicking the correct radio button in the Edit RS-DCC termination dialog box and clicking OK.

Step 6 If the Layer 2, Mode, and Role settings are correct, compare the MTU settings for each node. If one is 
incorrect, choose the correct value in the Edit RS-DCC dialog box and click OK. 
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Step 7 If all of the preceding settings are correct, ensure that OSI routers are enabled for the communication 
channels at both ends by completing the following steps: 

a. Click the Provisioning > OSI > Routers > Setup tabs.

b. View the router entry under the Status column. If the status is Enabled, check the other end. 

c. If the Status is Disabled, click the router entry and click Edit.

d. Check the Enabled check box and click OK.

Step 8 If the routers on both ends are enabled and the alarm still has not cleared, ensure that both ends of the 
comm channel have a common MAA by completing the following steps:

a. Click the Provisioning > OSI > Routers > Setup tabs.

b. Record the primary MAA and secondary MAAs, if configured.

Tip You can record long strings of information such as the MAA address by using the CTC export and print 
functions. Export it by choosing File > Export > html. Print it by choosing File > Print.

c. Log into the other node and record the primary MAA and secondary MAAs, if configured.

d. Compare this information. There should be at least one common primary or secondary MAA in 
order to establish an adjacency.

e. If there is no common MAA, one must be added to establish an adjacency. Refer to the “Turn Up 
Node” chapter in the Cisco ONS 15600 SDH Procedure Guide for instructions to do this.

Step 9 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447).

2.6.109 KB-PASSTHR
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Object: STMN

The K Byte Pass Through Active condition occurs on a nonswitching node in a MS-SPRing when the 
protect channels on the node are not active and the node is in K Byte pass-through state. It also occurs 
when a MS-SPRing ring is being exercised using the Exercise Ring command.

Clear the KB-PASSTHR Condition

Step 1 Complete the “Clear a MS-SPRing External Switching Command” procedure on page 2-130.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.6.110 KBYTE-APS-CHANNEL-FAILURE 
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
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Logical Object: STMN

The APS Channel Failure alarm is raised when a span is provisioned for different APS channels on each 
side. For example, the alarm is raised if K3 is selected on one end and F1, E2, or Z2 is selected on the 
other end.

This alarm is also raised during checksum failure if the K1 and K2 bytes are overwritten by test 
equipment. It is not raised in bidirectional full pass-through or K-byte pass-through states. The alarm is 
overridden by AIS-P, LOF, LOS, or SF-BER alarms.

Clear the KBYTE-APS-CHANNEL-FAILURE Alarm

Step 1 The alarm is most frequently raised due to mismatched span provisioning. In this case, reprovision one 
side of the span with the same parameters. To do this, refer to the “Manage Circuits” chapter in the 
Cisco ONS 15600 SDH Procedure Guide for procedures.

Step 2 If the error is not caused by incorrect provisioning, it is because of checksum errors within an STM-N, 
cross-connect, or TSC card. In this case, complete the “Request a Cross-Connect Card Preferred Copy 
Switch” procedure on page 2-132 to allow CTC to resolve the issue. 

Step 3 If third-party equipment is involved, ensure that it is configured for the same APS channel as the 
Cisco ONS equipment.

Step 4 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447).

2.6.111 LASER-BIAS
Default Severity: Critical (CR), Service- Affecting (SA)

Logical Objects: EQPT, PPM

The High Laser Bias Current alarm occurs when a port on an STM-64 card is transmitting a laser current 
outside of the acceptable preset range. The alarm occurs at the card level rather than at the port level. 
The alarm is typically accompanied by signal or bit errors on the downstream node.

Note The difference between this alarm and the laser bias current performance-monitoring parameter is that 
the alarm indicates a serious physical condition in the transmitter.

Clear the LASER-BIAS Alarm

Step 1 If the alarm is reported against the working STM-64 facility and traffic has not automatically switched 
to protect, initiate a Force switch. If it is part of an SNCP, complete the “Initiate a Force Switch for All 
Circuits on a SNCP Span” procedure on page 2-126. If is part of a 1+1 protection group, complete the 
“Initiate a 1+1 Protection Port Force Switch Command” procedure on page 2-123.

Step 2 Complete the “Replace an I/O Card” procedure on page 2-134 for the reporting card.

Step 3 If the alarm does not clear after replacing the card, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447) to report a 
Service-Affecting (SA) problem.
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Step 4 Traffic reverts to the working port if working port if an automatic switch occurred. If the alarm cleared 
and traffic was switched in Step 1, revert traffic by completing the “Clear a 1+1 Protection Port Force or 
Manual Switch Command” procedure on page 2-124. If traffic was manually switched in an SNCP, 
revert traffic to the original path by completing the “Clear a SNCP Span External Switching Command” 
procedure on page 2-127.

2.6.112 LASER-OVER-TEMP
Default Severity: Critical (CR), Service-Affecting (SA)

Logical Objects: EQPT, PPM

The Port-Level High Temperature STM-64 equipment alarm accompanies a fault in one of the four 
STM-64 ports. The fault causes output signal bit errors that are detected by the downstream node, which 
performs an APS. 

If more than one card has this condition, troubleshoot with the “Clear the EQPT-HITEMP Alarm” 
procedure on page 2-47. Any time an STM-64 card or port reports an over-temperature condition, follow 
the “Clear the LASER-BIAS Alarm” procedure on page 2-79. If the alarm does not clear, log into the 
Technical Support Website at http://www.cisco.com/techsupport for more information or call Cisco TAC 
(1 800 553-2447) to report a Service-Affecting (SA) problem.

2.6.113 LKOUTPR-S
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Object: STMN

The Lockout of Protection Span condition occurs on a BSLR node when traffic is locked out of a protect 
span using the LOCKOUT SPAN command. This condition is visible on the network view Alarms, 
Conditions, and History tabs after the lockout has occurred and accompanies the 
FE-LOCKOUTPR-SPAN condition. The port where the lockout originated is marked by an “L” on the 
network view detailed circuit map.

Clear the LKOUTPR-S Condition

Step 1 Complete the “Clear a MS-SPRing External Switching Command” procedure on page 2-130.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.6.114 LOCKOUT-REQ
Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Objects: STMN, VCMON-HP
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2.6.115  LOCKOUT-REQ-RING
The Lockout Switch Request on Facility or Equipment condition occurs when a user initiates a lockout 
switch request for an STM-N port in a 1+1 facility protection group. This can be accomplished by 
locking traffic onto the working port with the Lock On command (thus locking it off the protect port), 
or locking it off the protect port with the Lock Out command. In either case, the protect port will show 
“Lockout of Protection,” and the Conditions window will show the LOCKOUT-REQ condition.

A lockout prevents protection switching. Clearing the lockout allows protection switching and clears the 
LOCKOUT-REQ condition. 

Clear the LOCKOUT-REQ Condition

Step 1 Complete the “Clear a Card or Port Lock On or Lock Out Command” procedure on page 2-125.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.6.115 LOCKOUT-REQ-RING
Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Object: STMN

The Lockout Switch Request on Ring condition occurs when a user initiates a lockout switch request for 
an STM-N card or a lockout switch request on the MS-SPRing ring level. A lockout prevents protection 
switching. Clearing the lockout again allows protection switching and clears the LOCKOUT-REQ-RING 
condition.

Clear the LOCKOUT-REQ-RING Condition

Step 1 Complete the “Clear a MS-SPRing External Switching Command” procedure on page 2-130.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.6.116 LOF (BITS)
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

Logical Object: BITS

The Loss of Frame (BITS) alarm is Major (MJ) if there is no backup TSC card BITS source and 
Minor (MN) if one of the TSC cards BITS sources fails. If one of the pair fails, a timing APS is activated 
on the second source.
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2.6.117  LOF (STMN)
Clear the LOF (BITS) Alarm

Step 1 Verify that the framing and coding match between the BITS input and the TSC card by completing the 
following steps:

a. Find the coding and framing formats of the external BITS timing source. This should be in the user 
documentation for the external BITS timing source or on the external timing source itself.

b. Click the node view Provisioning > Timing > BITS Facilities tabs.

c. Verify that the Coding setting matches the Coding setting of the BITS timing source (either B8ZS 
or AMI).

d. If the coding does not match, click Coding to display a drop-down list. Choose the appropriate 
coding.

e. Verify that the Framing matches the framing of the BITS timing source (either ESF or SF [D4]).

f. If the framing does not match, click Framing to display the drop-down list. Choose the appropriate 
framing.

Note In the Timing window, the B8ZS coding field is normally paired with ESF in the Framing 
field, and the AMI coding field is normally paired with SF (D4) in the Framing field. 

Step 2 Ensure that the BITS clock is operating properly.

Caution Always use the supplied electrostatic discharge wristband when working with a powered 
ONS 15600 SDH. Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf 
assembly.

Step 3 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447).

2.6.117 LOF (STMN)
Default Severity: Critical (CR), Service-Affecting (SA) 

Logical Object: STMN

The Line Loss of Frame Alignment alarm occurs when a port on the reporting traffic (STM-N) card has 
an LOF. LOF indicates that the receiving ONS 15600 SDH has lost frame delineation in the incoming 
data and when the SDH overhead loses a valid framing pattern for three milliseconds. Receiving two 
consecutive valid A1/A2 framing patterns clears the alarm.

LOF on a traffic card is sometimes an indication that the port reporting the alarm expects a specific line 
rate and the input line rate source does not match the input line rate of the optical receiver.

If the port is in 1+1 protection and successfully switches, the alarm severity is MN, NSA. If the port is 
unprotected or if protection switching is prevented, the severity is CR, SA.
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2.6.118  LOGBUFR90
Clear the LOF (STMN) Alarm

Step 1 Verify that the automatic protection switch to the protect port was successful.

• A SNCP APS is identified by an AUTOSW-type alarm or condition (such as AUTOSW-AIS, 
AUTOSW-LOP, AUTOSW-PDI, AUTOSW-SDBER, AUTOSW-SFBER, or AUTOSW-UNEQ).

• A 1+1 APS is identified on the node view Maintenance > Protection tab. If you click the protection 
group, under the Selected Group list, the ports are designated as Working/Standby and 
Protect/Active.

Step 2 Verify that the traffic (STM-N) card and port on the upstream node is in service.

• On an in-service traffic card, the green SRV and Laser On LEDs are illuminated.

• If the card ports are in service, in the card view Provisioning tab, the Status column for the port(s) 
show In Service. If the ports are not in service, click the port column and choose In Service, then 
click Apply.

Step 3 If the alarm does not clear, clean the optical fiber connectors by completing the following steps:

Caution Always use the supplied electrostatic discharge wristband when working with a powered 
ONS 15600 SDH. Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf 
assembly.

a. Clean the fiber connectors according to local site practice.

b. If no local practice exists, use a CLETOP Real-Type or equivalent fiber-optic cleaner and follow the 
instructions accompanying the product and/or refer to the procedures in the “Maintain the Node” 
chapter in the Cisco ONS 15600 SDH Procedure Guide.

Step 4 If you continue to receive the LOF alarm, see the “1.9.3 Optical Traffic Card Transmit and Receive 
Levels” section on page 1-74 for acceptable standards.

Step 5 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447) to report a Service-Affecting (SA) problem.

2.6.118 LOGBUFR90
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

Logical Object: SYSTEM

The Log Buffer Over 90 alarm indicates that the per-NE queue of incoming alarm, event, or update 
capacity of 5,000 entries is over 90 percent full. LOGBUFR90 will clear if CTC recovers. If it does not 
clear, LOGBUFROVFL occurs.

Note LOGBUFR90 is an informational alarm and does not require troubleshooting.
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2.6.119 LOGBUFROVFL
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

Logical Object: SYSTEM

The Log Buffer Overflow alarm indicates that the CTC per-NE queue of incoming alarm, event, or 
updates, which has a capacity of 5,000 entries, has overflowed. This happens only very rarely. However 
if it does, you must restart the CTC session. It is likely that some updates will have been missed if this 
alarm occurs.

Clear the LOGBUFROVFL Alarm

Step 1 Restart the CTC session.

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1-800-553-2447). 

2.6.120 LO-LASERBIAS 
For information about this condition, refer to the “Alarm Troubleshooting” chapter of the 
Cisco ONS 15454 DWDM Troubleshooting Guide.

2.6.121 LOP-P 
Default Severity: Critical (CR), Service-Affecting (SA) 

Logical Object: VCMON-HP

A Loss of Pointer Path alarm indicates that the transmitted optical circuit size is different from the 
provisioned optical circuit size. LOP-P occurs when valid H1/H2 pointer bytes are missing from the 
SDH overhead. Receiving equipment monitors the H1/H2 pointer bytes to locate the SDH payload. An 
LOP-P alarm means that eight, nine, or ten consecutive frames do not have valid pointer values. The 
alarm clears when three consecutive valid pointers are received.

One of the conditions that can cause this alarm is a transmitted VC circuit that is different from the 
provisioned VC. This condition causes a mismatch of the path type on the concatenation facility. It 
occurs when there are eight to ten new data flags received, or eight to ten invalid pointers. For example, 
if an VC4 or VC3 is sent across a path provisioned for VC4-4c, an LOP alarm occurs.

Clear the LOP-P Alarm

Step 1 Complete the “Initiate a Force Switch for All Circuits on a SNCP Span” procedure on page 2-126 or the 
“Initiate a 1+1 Protection Port Force Switch Command” procedure on page 2-123 as appropriate.

Step 2 Use a test set to verify that the incoming signal is valid; refer to the “Create Circuits” chapter in the 
Cisco ONS 15600 SDH Procedure Guide for instructions on testing optical circuits. If the upstream 
signal is not valid, troubleshoot upstream. 
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Caution Always use the supplied electrostatic discharge wristband when working with a powered 
ONS 15600 SDH. Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf 
assembly.

Step 3 If the incoming signal is valid, complete the “Replace an I/O Card” procedure on page 2-134 for the 
reporting card.

Note If the traffic (STM-N) card is implicated and you are able to continue using the traffic card with 
one port out of service, perform a bridge and roll to move the port traffic to a free port. Refer to 
the “Manage Circuits” chapter in the Cisco ONS 15600 SDH Procedure Guide for instructions. 
Label the bad port, and place it out of service until the card can be replaced.

Step 4 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447) to report a Service-Affecting (SA) problem.

2.6.122 LO-RXPOWER 
For information about this condition, refer to the “Alarm Troubleshooting” chapter of the 
Cisco ONS 15454 DWDM Troubleshooting Guide.

2.6.123 LOS (BITS)
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

Logical Object: BITS

The Loss of Signal BITS alarm is Major (MJ) if there is no backup TSC card BITS source, and 
Minor (MN) if one of the TSC card BITS sources fails. If one of the pair fails, a timing APS is activated 
on the second source.

Clear the LOS (BITS) Alarm

Step 1 Check the wiring connection from the ONS 15600 SDH backplane BITS clock pin fields to the timing 
source. For more information about backplane wiring connections, refer to the “Install the Bay and 
Backplane Connections” chapter in the Cisco ONS 15600 SDH Procedure Guide.

Caution Always use the supplied electrostatic discharge wristband when working with a powered 
ONS 15600 SDH. Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf 
assembly.

Step 2 Ensure that the BITS clock is operating properly.

Step 3 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447) to report a Service-Affecting (SA) problem.
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2.6.124 LOS (STMN)
Default Severity: Critical (CR), Service-Affecting (SA)

Logical Object: STMN

A Loss of Signal Line alarm for either an STM-16 or STM-64 port occurs when the port on the card is 
in service but no signal is being received. The cabling might not be correctly connected to the ports, or 
no signal exists on the line. Possible causes for a loss of signal include upstream equipment failure or a 
fiber cut. It clears when two consecutive valid frames are received.

Clear the LOS (STMN) Alarm

Step 1 Verify fiber continuity to the port. To verify cable continuity, follow site practices.

Caution Always use the supplied electrostatic discharge wristband when working with a powered 
ONS 15600 SDH. Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf 
assembly.

Step 2 If the cabling is good, verify that the correct port is in service by completing the following steps:

a. Confirm that the LED is correctly illuminated on the physical card.

A green SRV LED indicates an active card. 

b. To determine whether the STM-N port is in service, double-click the card in CTC to display the card 
view by completing the following steps:

c. Click the Provisioning > Line tabs.

d. Verify that the Admin State column lists the port as Locked.

e. If the Admin State column lists the port as Locked,maintenance or Locked,disabled, click the 
column and choose Locked. 

f. Click Apply.

Note If ports managed into Unlocked administrative state are not receiving signals, the LOS alarm 
is either raised or remains, and the port service state transitions to Unlocked-disabled,failed.

Step 3 If the correct port is in service, clean the fiber according to site practice. If no site practice exists, 
complete the procedure in the “Maintain the Node” chapter in the Cisco ONS 15600 SDH Procedure 
Guide.

Step 4 If the alarm does not clear, verify that the power level of the optical signal is within the STM-N card 
receiver specifications. The “1.9.3 Optical Traffic Card Transmit and Receive Levels” section on 
page 1-74 lists these specifications for each STM-N card. 

Step 5 If the optical power level is within specifications, use an optical test set to verify that a valid signal exists 
on the line. For specific procedures to use the test set equipment, consult the manufacturer. Test the line 
as close to the receiving card as possible.

Step 6 If a valid signal exists, replace the connector on the backplane.

Step 7 Repeat Steps 1 to 6 for any other port on the card reporting the LOS (STM-N).
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Step 8 If the alarm does not clear, look for and troubleshoot any other alarm that could identify the source of 
the problem.

Step 9 If no other alarms exist that could be the source of the LOS, or if clearing an alarm did not clear the LOS, 
complete the “Replace an I/O Card” procedure on page 2-134 for the reporting card.

Caution Removing a card that currently carries traffic on one or more ports can cause a traffic hit. To avoid this, 
perform an external switch if a switch has not already occurred. See the “2.8.2 Protection Switching, 
Lock Initiation, and Clearing” section on page 2-123 for commonly used traffic-switching procedures.

Note When you replace a card with the identical type of card, you do not need to make any changes 
to the database.

Step 10 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA) 
problem.

2.6.125 LO-TXPOWER 
For information about this condition, refer to the “Alarm Troubleshooting” chapter of the 
Cisco ONS 15454 DWDM Troubleshooting Guide.

2.6.126 LPBKCRS
Default Severity: Not Alarmed (NA), Service-Affecting (SA)

Logical Object: VCMON-HP

The Loopback Cross-Connect condition indicates that a software cross-connect loopback is active 
between a traffic (STM-N) card and a cross-connect card.

Loopback is a commonly used troubleshooting technique. A signal is sent out on a link or section of the 
network and returned to the sending device. If the signal does not return or returns with errors, the test 
confirms that the problem is present in the tested link. By setting up loopbacks on various parts of the 
node and excluding other parts, you can logically isolate the source of the problem. For more information 
about loopbacks, see the “Troubleshooting Optical Circuits with Loopbacks” procedure in Chapter 1.

Four types of loopbacks are available: Cross-Connect, Facility, Terminal, and Payload. Cross-connect 
loopbacks troubleshoot any kind of VC (meaning there must be a cross connect) on any card type. 
Facility loopbacks troubleshoot STM-16-16 and ASAP ports only and are generally performed locally 
or at the near end. Payload loopbacks troubleshoot STM-64-4 ports only and are generally performed 
locally or at the near end. Terminal loopbacks are performed only on the ASAP card.

Clear the LBKCRS Condition

Step 1 To remove the loopback cross-connect condition, double-click the traffic (STM-N) card in node view. 

Step 2 Click the Provisioning > VC3 or VC4 tabs.
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2.6.127  LPBKFACILITY (GIGE)
Step 3 In the XC Loopback column, deselect the check box for the port.

Step 4 Click Apply.

Step 5 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.6.127 LPBKFACILITY (GIGE) 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Object: GIGE

A Loopback Facility condition for a Gigabit Ethernet (GE) port occurs when a software facility (line) 
loopback is active for an ASAP card client 4PIO (PIM) provisioned at the ONE_GE port rate.

For information about troubleshooting these circuits with loopbacks, refer to the “1.3 Troubleshooting 
an Ethernet Circuit Path With Loopbacks” section on page 1-29.

Note For more information about ASAP cards, refer to the Cisco ONS 15600 SDH Reference Manual.

Clear the LPBKFACILITY (GIGE) Condition

Step 1 Complete the “Clear the LBKFACILITY (STMN) Condition” procedure on page 2-88.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.6.128 LPBKFACILITY (STMN)
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Object: STMN

A Facility Loopback Active condition for an STM-N occurs on STM-16 cards when a software facility 
loopback is active for a port on the reporting card, and the facility entity is out of service.

Caution Before performing a facility loopback on an STM-16 card, make sure the card contains at least two 
section DCC paths to the node where the card is installed. A second section DCC path provides a 
nonlooped path to log into the node after the loopback is applied, thus enabling you to remove the facility 
loopback. Ensuring a second section DCC is not necessary if you are directly connected to the 
ONS 15600 SDH containing the loopback STM-N.

Clear the LBKFACILITY (STMN) Condition

Step 1 To remove the loopback facility condition, double-click the reporting card in node view. 
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Step 2 Click the Maintenance > Loopback tabs.

Step 3 In the Loopback Type column, click the correct row for the port and choose None from the drop-down 
list.

Step 4 Click Apply.

Step 5 Click the Provisioning > Line tabs.

Step 6 In the Admin State column, click the correct row for the port and choose Unlocked from the drop-down 
list.

Note If ports managed into Unlocked administrative state are not receiving signals, the LOS alarm is 
either raised or remains, and the port service state transitions to Unlocked-disabled,failed.

Step 7 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.6.129 LPBKPAYLOAD
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Object: STMN

A Payload Loopback Active condition occurs on STM-64 cards when a software payload loopback is 
active for a port on the STM-64 card, and the facility entity is out of service.

Clear the LPBKPAYLOAD Condition

Step 1 To remove the loopback payload condition, double-click the reporting card in node view. 

Step 2 Click the Maintenance > Loopback tabs.

Step 3 In the Loopback Type column, click the correct row for the port and choose None from the drop-down 
list.

Step 4 Click Apply.

Step 5 Click the Provisioning > Line tabs.

Step 6 In the Admin State column, click the correct row for the port and choose Unlocked from the drop-down 
list.

Note If ports managed into Unlocked administrative state are not receiving signals, the LOS alarm is 
either raised or remains, and the port service state transitions to Unlocked-disabled,failed.

Step 7 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).
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2.6.130 LPBKTERMINAL (GIGE)
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Object: GIGE

A Loopback Terminal condition for a Gigabit Ethernet port occurs when a software terminal (inward) 
loopback is active for an ASAP card client SFP (PPM) provisioned at the ONE_GE port rate. 

For information about troubleshooting these circuits with loopbacks, refer to the “1.3 Troubleshooting 
an Ethernet Circuit Path With Loopbacks” section on page 1-29].

Clear the LPBKTERMINAL (GIGE) Condition

Step 1 Complete the “Clear the LBKTERMINAL (STMN) Condition” procedure on page 2-90.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.6.131 LPBKTERMINAL (STMN)
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Object: STMN

A Terminal Loopback Active condition for STM-N occurs on STM-16 cards or ASAP cards when a 
software facility loopback is active for a port on the reporting card, and the facility entity is out of 
service.

Caution Before performing a terminal loopback on an STM-16 card, make sure the card contains at least two 
section DCC paths to the node where the card is installed. A second section DCC path provides a 
nonlooped path to log into the node after the loopback is applied, thus enabling you to remove the 
terminal loopback. Ensuring a second section DCC is not necessary if you are directly connected to the 
ONS 15600 SDH containing the loopback STM-N.

Clear the LBKTERMINAL (STMN) Condition

Step 1 To remove the loopback facility condition, double-click the reporting card in node view. 

Step 2 Click the Maintenance > Loopback tabs.

Step 3 In the Loopback Type column, click the correct row for the port and choose None from the drop-down 
list.

Step 4 Click Apply.

Step 5 Click the Provisioning > Line tabs.

Step 6 In the Admin State column, click the correct row for the port and choose Unlocked from the drop-down 
list.
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Note If ports managed into Unlocked administrative state are not receiving signals, the LOS alarm is 
either raised or remains, and the port service state transitions to Unlocked-disabled,failed.

Step 7 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.6.132 LWBATVG 
The LWBATVG condition is not used in this platform in this release. It is reserved for development.

2.6.133 MAN-REQ
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA) 

Logical Object: VCMON-HP

The Manual Switch Request condition occurs when a user initiates a Manual switch request on an 
STM-N port. Clearing the Manual switch clears the MAN-REQ condition. You do not need to clear the 
switch if you want the manual switch to remain.

Clear the MAN-REQ Condition

Step 1 Complete the “Initiate a 1+1 Protection Port Manual Switch Command” procedure on page 2-124.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.6.134 MANRESET
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA) 

Logical Objects: EQPT, PIM, PPM

A Manual System Reset condition occurs when you right-click a TSC card, SSXC card, or traffic 
(STM-N) card in CTC and choose Hard-reset Card or Soft-reset Card. 

Note The hard-reset option is enabled only when the card is placed in the Locked-enabled,maintenance 
service state.

2.6.135 MANSWTOINT
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Object: NE-SREF
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2.6.136  MANSWTOPRI
The Manual Synchronization Switch to Internal Clock condition occurs when the NE (node) timing 
source is manually switched to an internal timing source.

Note MANSWTOINT is an informational condition and does not require troubleshooting.

2.6.136 MANSWTOPRI
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA) 

Logical Objects: EXT-SREF, NE-SREF

The Manual Synchronization Switch to Primary Reference condition occurs when the NE (node) timing 
source is manually switched to the primary source.

Note MANSWTOPRI is an informational condition and does not require troubleshooting.

2.6.137 MANSWTOSEC
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA) 

Logical Objects: EXT-SREF, NE-SREF

The Manual Synchronization Switch to Second Reference condition occurs when the NE (node) timing 
source is manually switched to a second source.

Note MANSWTOSEC is an informational condition and does not require troubleshooting.

2.6.138 MANSWTOTHIRD
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA) 

Logical Objects: EXT-SREF, NE-SREF

The Manual Synchronization Switch to Third Reference condition occurs when the NE (node) timing 
source is manually switched to a third source.

Note MANSWTOTHIRD is an informational condition and does not require troubleshooting.

2.6.139 MANUAL-REQ-RING
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Object: STMN

The Manual Switch Request on Ring condition occurs when a user initiates a MANUAL RING command 
on a MS-SPRing ring to switch from working to protect. This condition is visible on the network view 
Alarms, Conditions, and History tabs and is accompanied by WKSWPR. The port where the MANUAL 
RING command originated is marked with an “M” on the network view detailed circuit map. 
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2.6.140  MANUAL-REQ-SPAN
When you release the manual ring request, traffic automatically switches back to working—even if the 
ring is set to nonrevertive switching.

Clear the MANUAL-REQ-RING Condition

Step 1 Complete the “Clear a MS-SPRing External Switching Command” procedure on page 2-130.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.6.140 MANUAL-REQ-SPAN
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Object: STMN

The Manual Switch Request on Ring condition occurs on MS-SPRings when a user initiates a Manual 
Span command to move MS-SPRing traffic from a working span to a protect span. This condition 
appears on the network view Alarms, Conditions, and History tabs. The port where the MANUAL SPAN 
command was applied is marked with an “M” on the network view detailed circuit map.

Clear the MANUAL-REQ-SPAN Condition

Step 1 Complete the “Clear a MS-SPRing External Switching Command” procedure on page 2-130.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.6.141 MATECLK
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

Logical Object: EQPT

The Mate Clock alarm occurs when the active TSC card cannot detect the clock from the standby TSC 
card.

Clear the MATECLK Alarm

Step 1 In CTC, check for any alarms that indicate that there are faulty clock references, such as the 
“HLDOVRSYNC” alarm on page 2-66 or the “FRNGSYNC” alarm on page 2-64, and resolve these 
alarms.

Step 2 If the MATECLK persists, complete the “Reset a Card with a Card Pull (Reseat)” procedure on 
page 2-133 for the standby TSC card and wait 15 minutes.
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2.6.142  MEA
Caution Always use the supplied electrostatic discharge wristband when working with a powered 
ONS 15600 SDH. Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf 
assembly.

Step 3 If the MATECLK still persists, complete the “Replace a TSC Card” procedure on page 2-136 for the 
active TSC card, using the standby TSC card to replace the active TSC card.

Step 4 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447) to report a Service-Affecting (SA) problem.

2.6.142 MEA
Default Severity: Critical (CR), Service-Affecting (SA)

Logical Objects: EQPT, PIM, PPM

The Mismatch Between Equipment Type and Provisioned Attributes alarm is reported against a card slot 
when the physical card or port does not match the card type provisioned in CTC. Deleting the 
incompatible card or port, SFP (PPM), or 4PIO (PIM) in CTC or physically removing the card clears the 
alarm.

Clear the MEA Alarm

Step 1 Physically verify the type of card that sits in the slot reporting the MEA alarm.

Step 2 In CTC, click the node view Inventory tab to display the provisioned card type.

Step 3 If you prefer the card type depicted by CTC, complete the “Replace an I/O Card” procedure on 
page 2-134 for the reporting card and replace it with the card type depicted by CTC (provisioned for that 
slot).

Note CTC does not allow you to delete a card if at least one port on the card is in service, has a path 
mapped to it, is paired in a working-protection scheme, has DCC enabled, or is used as a timing 
reference.

Step 4 If you want to leave the installed card in the slot but it is not in service, delete any circuits mapped to it. 
Refer to the “Manage Circuits” chapter in the Cisco ONS 15600 SDH Procedure Guide for procedures.

Step 5 Place the cursor over the provisioned card in CTC and right-click to choose Delete Card.

When the card is deleted in CTC, the card that physically occupies the slot automatically reboots and 
appears in CTC.

Step 6 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447) to report a Service-Affecting (SA) problem.
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2.6.143  MEM-GONE
2.6.143 MEM-GONE
Default Severity: Major (MJ), Service-Affecting (SA)

Logical Object: EQPT

The Memory Gone alarm occurs when data generated by software operations exceeds the memory 
capacity of the TSC card. The TSC cards which exceed the memory capacity reboot to avoid failure of 
card operations. 

Note The alarm does not require user intervention. The MEM-LOW alarm always preceeds the MEM-GONE 
alarm.

2.6.144 MEM-LOW
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

Logical Object: EQPT

The Free Memory of Card Almost Gone alarm occurs when data generated by software operations is 
close to exceeding the memory capacity of the TSC card. The alarm clears when additional memory 
becomes available. If additional memory is not made available and the memory capacity of the card is 
exceeded, CTC ceases to function.

Note For assistance with this alarm, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.6.145 MFGMEM (CAP)
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

Logical Object: CAP

The Manufacturing Data Memory Failure CAP alarm occurs if the ONS 15600 SDH cannot access the 
data in the EEPROM on the backplane. MFGMEM is caused by EEPROM failure on the backplane, or 
fuse failure for the EEPROM. 

The EEPROM stores manufacturing data that is needed for compatibility and inventory issues. If the 
alarm is accompanied by the “PWR-FA” alarm on page 2-103, the 5-VDC fuse for the EEPROM might 
be tripped. If that is the case, use the procedure below to eliminate the TSC card as the cause of the alarm, 
but do not attempt to troubleshoot it further. Contact the Cisco TAC at 1-800-553-2447.

Clear the MFGMEM Alarm on the CAP by Resetting the TSC Card

Step 1 Complete the “Soft-Reset a Card Using CTC” procedure on page 2-130.

Wait for the “FSTSYNC” condition on page 2-64 to clear.

Step 2 If the alarm does not clear, complete the “Soft-Reset a Card Using CTC” procedure on page 2-130.
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2.6.146  MFGMEM (FAN)
If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447). The standby TSC card might also need 
replacement. If the alarm continues after both TSC cards have been replaced, the problem lies in the 
EEPROM on the CAP, and this must be replaced. 

Step 3 When the alarm is cleared, you can make the standby TSC card active again by completing the 
“Soft-Reset a Card Using CTC” procedure on page 2-130.

2.6.146 MFGMEM (FAN)
Default Severity: Critical (CR), Service-Affecting (SA)

Logical Object: FAN

The Manufacturing Data Memory Fan alarm occurs if the ONS 15600 SDH EEPROM on a fan tray fails. 
MFGMEM can be accompanied by the “FAN-FAIL” alarm on page 2-57.

Clear the MFGMEM (FAN) Alarm

Step 1 Pull out the fan tray.

Step 2 Reinsert the fan trays, making sure you can hear the fans start operating. Fans should run immediately 
when correctly inserted.

Step 3 If a fan does not run or the alarm persists, refer to the “Maintain the Node” chapter in the 
Cisco ONS 15600 SDH Procedure Guide for instructions to replace the fan tray.

Step 4 If a replacement fan tray does not operate correctly, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447) to report a 
Service-Affecting (SA) problem.

2.6.147 MFGMEM (for the PIM, PPM, SSXC, Traffic Card, or TSC Card)
Default Severity: Critical (CR), Service-Affecting (SA)

Logical Objects: EQPT, PIM, PPM

The Manufacturing Data Memory Failure SSXC, Traffic (STM-N), or TSC Card alarm occurs if the 
ONS 15600 SDH EEPROM on one of these cards fails.

Clear the MFGMEM Alarm (for the PIM,PPM, SSXC, Traffic Card, or TSC Card)

Step 1 If the alarm is reported against a TSC card, troubleshoot with the “Clear the MFGMEM Alarm on the 
CAP by Resetting the TSC Card” procedure on page 2-95. 

Step 2 If the reporting card is an active traffic line port in a 1+1 protection group or an SNCP, ensure that an 
APS traffic switch has occurred to move traffic to the protect port. 

• A SNCP APS is identified by an AUTOSW-type alarm or condition (such as AUTOSW-AIS, 
AUTOSW-PDI, AUTOSW-SDBER, AUTOSW-SFBER, or AUTOSW-UNEQ).
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2.6.148  MS-AIS
• A 1+1 APS is identified on the node view Maintenance > Protection tab. If you click the protection 
group, under the Selected Group list, the ports are designated as Working/Standby and 
Protect/Active.

Step 3 If the reporting port is part of an SNCP, complete the “Initiate a Force Switch for All Circuits on a SNCP 
Span” procedure on page 2-126. If the port is part of a 1+1 protection group, complete the “Initiate a 1+1 
Protection Port Force Switch Command” procedure on page 2-123.

Step 4 If the reporting card is a SSXC card and an automatic switch to the preferred copy SSXC card occurred, 
traffic automatically switches to the alternate copy. 

Complete a “Hard-Reset a Card Using CTC” procedure on page 2-131 for the reporting card (or 
“Soft-Reset a Card Using CTC” procedure on page 2-130 for the SSXC.

Step 5 If the reset does not clear the alarm, complete the “Reset a Card with a Card Pull (Reseat)” section on 
page 2-133 for the TSC card, or complete the “Request a Cross-Connect Card Preferred Copy Switch” 
section on page 2-132 for the SSXC.

Step 6 If the physical reseat of the card or switch does not clear the alarm, complete the appropriate procedure 
in the “Replace a TSC Card” section on page 2-136 or “Replace an SSXC Card” section on page 2-133 
as needed.

Note If the traffic (STM-N) card is implicated and you are able to continue using the traffic card with 
one port out of service, perform a bridge and roll to move the port traffic to a free port using the 
“Bridge and Roll Traffic” procedure in the “Manage Circuits” chapter in the 
Cisco ONS 15600 SDH Procedure Guide. Label the bad port, and place it out of service until 
such time as the card can be replaced.

Step 7 If the MFGMEM alarm continues to report after you replaced the card, the problem lies in the EEPROM. 
Log into the Technical Support Website at http://www.cisco.com/techsupport for more information or 
call Cisco TAC (1 800 553-2447).

Step 8 If the alarm clears and it was reported by a traffic card, traffic reverts to the working port if an automatic 
switch occurred. If traffic was manually switched in a 1+1 protection group, revert traffic to the original 
port by completing the “Clear a 1+1 Protection Port Force or Manual Switch Command” procedure on 
page 2-124. If traffic was manually switched in an SNCP, revert traffic to the original path by completing 
the “Clear a SNCP Span External Switching Command” procedure on page 2-127.

If an automatic switch to the alternate copy SSXC card occurred, traffic is automatically restored to the 
preferred copy. 

Step 9 If the reporting card is a TSC card and you want to make the standby TSC card active again, complete 
the “Soft-Reset a Card Using CTC” procedure on page 2-130.

2.6.148 MS-AIS 
Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)

Logical Object: STMN

The Multiplex Section (MS) AIS condition indicates that there is a defect in the multiplexing section 
layer of the SDH overhead. The multiplex section refers to the segment between two SDH devices in the 
circuit and is also known as a maintenance span. The multiplex section layer of the SDH overhead deals 
with payload transport, and its functions include multiplexing and synchronization.
2-97
Cisco ONS 15600 SDH Troubleshooting Guide, R8.0

July 2010



Chapter 2 Alarm Troubleshooting
2.6.149  MS-DEG
Generally, any AIS is a special SDH signal that communicates to the receiving node when the transmit 
node does not send a valid signal. AIS is not considered an error. It is raised by the receiving node on 
each input when it detects the AIS instead of a real signal. In most cases when this condition is raised, 
an upstream node is raising an alarm to indicate a signal failure; all nodes downstream from it only raise 
some type of AIS. This condition clears when you resolved the problem on the upstream node.

Clear the MS-AIS Condition

Step 1 Complete the “Clear the AIS Condition” procedure on page 2-15.

Step 2 If the condition does not clear, log into the Cisco Technical Support Website at 
http://www.cisco.com/techsupport for more information or log into  
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free 
Technical Support numbers for your country.

2.6.149 MS-DEG
Default Severity:Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Object: STMN

The Multiplex Section Signal Degrade condition occurs when the multiplex section overhead of the 
STMN object falls within the degrade threshold set on the node.

Clear the MS-DEG Condition

Step 1 Determine the threshold. If adjustment is acceptable in site practices, adjust the threshold.

Using an optical test set, measure the input power level of the line and ensure that the level is within the 
guidelines. For specific procedures to use the test set equipment, consult the manufacturer.

Step 2 Verify the input fiber cable connections to the reporting card.

Step 3 Clean the input fiber cable ends according to site practice.

Step 4 If the condition does not clear, log into the Cisco Technical Support Website at 
http://www.cisco.com/techsupport for more information or log into  
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free 
Technical Support numbers for your country.

2.6.150 MS-EOC 
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

Logical Object: STMN
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2.6.151  MS-EXC
The MS-DCC Termination Failure alarm occurs when the ONS 15600 SDH loses its data 
communications channel. The DCC is three bytes, D1 through D3, in the SDH overhead. The bytes 
convey information about Operation, Administration, Maintenance, and Provisioning (OAM&P). The 
ONS 15600 SDH uses the DCC on the SDH section overhead to communicate network management 
information.

Clear the MS-EOC Alarm

Step 1 Complete the “Clear the EOC Alarm” procedure on page 2-42.

Step 2 If the condition does not clear, log into the Cisco Technical Support Website at 
http://www.cisco.com/techsupport for more information or log into  
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free 
Technical Support numbers for your country.

2.6.151 MS-EXC
Default Severity:Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Object: STMN

The Multiplex Section Excessive Errors condition occurs when the multiplex section overhead of the 
STM1E object falls past the fail threshold set on the node.

Clear the MS-EXC Condition

Step 1 Determine the threshold. If adjustment is acceptable in site practices, adjust the threshold.

Using an optical test set, measure the input power level of the line and ensure that the level is within the 
guidelines. For specific procedures to use the test set equipment, consult the manufacturer.

Step 2 Verify the input fiber cable connections to the reporting card.

Step 3 Clean the input fiber cable ends according to site practice.

Step 4 If the condition does not clear, log into the Cisco Technical Support Website at 
http://www.cisco.com/techsupport for more information or log into  
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free 
Technical Support numbers for your country.

2.6.152 MS-RFI 
Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)

SDH Logical Objects: STMN 

The MS Remote Fault Indication (RFI) condition indicates that there is an RFI occurring at the SDH 
overhead multiplexing section level.
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2.6.153  MSSP-SW-VER-MISM
An RFI occurs when the ONS 15600 SDH detects an RFI in the SDH overhead because of a fault in 
another node. Resolving the fault in the adjoining node clears the MS-RFI condition in the reporting 
node.

Clear the MS-RFI Condition

Step 1 Log into the far-end node of the reporting ONS 15600 SDH.

Step 2 Determine whether there are other alarms, especially the “LOS (STMN)” alarm on page 2-86.

Step 3 Clear the main alarm. See the appropriate alarm section in this chapter for the procedure.

Step 4 If the condition does not clear, log into the Cisco Technical Support Website at 
http://www.cisco.com/techsupport for more information or log into  
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free 
Technical Support numbers for your country.

2.6.153 MSSP-SW-VER-MISM
Default Severity: Major (MJ), Service-Affecting (SA)

SDH Logical Object: STMN

The MS-SPRing Software Version Mismatch alarm is by the TSC card when it checks all software 
versions for all nodes in a ring and discovers a mismatch in versions.

Clear the MSSP-SW-VER-MISM Alarm

Step 1 Clear the alarm by loading the correct software version on the TSC card with the incorrect load. To 
download software, refer to the release-specific software download document. 

Step 2 If the condition does not clear, log into the Cisco Technical Support Website at 
http://www.cisco.com/techsupport for more information or log into  
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free 
Technical Support numbers for your country to report a Service-Affecting (SA) problem.

2.6.154 MS-SQUELCH-HP
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA) 

SDH Logical Object: STMN

The Multiplex Section Ring is Squelching High-Order Path Traffic condition is raised on an STM-N 
facility. If the node failure scenario includes the source node, the node that drops the signal will squelch 
traffic. The condition resolves when the node recovers.

This condition is raised with an NA severity by default. However, it indicates that traffic is squelched 
due to node failure (traffic outage). Traffic outages can be caused by different problems, such as multiple 
LOS alarms, MS-AIS, or node power outages. MS-SQUELCH-HP is symptomatic and indicates that the 
user must investigate which node in a ring is being isolated and what is causing the node isolation.
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2.6.155  NOT-AUTHENTICATED
Note MS-SQUELCH-HP is an informational condition.

2.6.155 NOT-AUTHENTICATED
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

Logical Object: SYSTEM

The NOT-AUTHENTICATED alarm is raised by CTC (not by the NE) when it fails to log into a node. 
This alarm only displays in CTC where the login failure occurred. This alarm differs from the 
“INTRUSION-PSWD” alarm on page 2-75 in that INTRUSION-PSWD occurs when a user exceeds the 
login failures threshold. 

Note NOT-AUTHENTICATED is an informational alarm and is resolved when CTC successfully logs into the 
node.

2.6.156 NON-CISCO-PPM 
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

Logical Object: PPM

The Non-Cisco PPM Inserted condition occurs when a PPM that is plugged into a card’s port fails the 
security code check. The check fails when the PPM used is not a Cisco PPM.

Clear the NON-CISCO-PPM Condition

Step 1 Obtain the correct Cisco PPM and replace the existing PPM with the new one. 

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.6.157 OPEN-SLOT
Default Severity: Minor (MN), Non-Service-Affecting (NSA) 

Logical Object: EQPT

The OPEN-SLOT alarm indicates that one of the I/O slots (Slot 1 through 4 and 11 through 14) does not 
contain a traffic card or filler card.

Clear the OPEN-SLOT Alarm

Step 1 Insert a filler card or STM-N card into the empty slot.
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2.6.158  PRC-DUPID
Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447).

2.6.158 PRC-DUPID
Default Severity: Major (MJ), Service-Affecting (SA) 

Logical Object: STMN

The Procedural Error Duplicate Node ID alarm indicates that two identical node IDs exist in the same 
MS-SPRing. The ONS 15600 SDH requires each node in the MS-SPRing to have a unique node ID.

Clear the PRC-DUPID Alarm

Step 1 Log into a node on the ring.

Step 2 Find the node ID by completing the “Identify an MS-SPRing Ring ID or Node ID Number” procedure 
on page 2-122.

Step 3 Repeat Step 2 for all the nodes on the ring.

Step 4 If two nodes have an identical node ID number, complete the “Change an MS-SPRing Node ID Number” 
procedure on page 2-122 so that each node ID is unique.

Step 5 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447).

2.6.159 PROV-MISMATCH
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

Logical Object: PPM

The Provisioning Mismatch for an SFP alarm is raised against an SFP (PPM) connector on the ASAP 
card under one of the following circumstances:

• The physical SFP (PPM) range or wavelength does not match the provisioned value. PPMs (SFPs) 
have static wavelength values which must match the wavelengths provisioned for the port.

• The SFP (PPM) reach (loss) value does not meet the reach value needed for the port.

Clear the PROV-MISMATCH Alarm

Step 1 Determine what the SFP (PPM) wavelength range should be by viewing the frequency provisioned for 
the card by completing the following steps:

a. Double-click the card to display the card view.

b. Click the Provisioning > Optical tabs (or Ethernet tab, as appropriate).

c. Record the values shown in the Reach and Wavelength columns.

Step 2 Complete the “Replace an ASAP SFP (PPM) Module” procedure on page 2-138.
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2.6.160  PWR
Step 3 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.6.160 PWR
Default Severity: Major (MJ), Non-Service Affecting (NSA) 

Logical Object: PWR

The NE Power Failure at Connector alarm occurs when one of the two power supplies (A or B) is not 
detected. This could be because the supply is removed or is not operational. The alarm does not 
distinguish between the individual power supplies, so onsite information about the alarm is necessary 
for troubleshooting. 

Effects of this alarm depend upon the shutdown order of the two power supplies. If PWR B of the 
right-side power feed and PWR A of the left-side power feed are shut down, this causes all three fans to 
turn off and a “FAN-FAIL” alarm on page 2-57 to be raised. In this case, after power is restored all three 
fans work in high-speed mode for a few minutes until CTC returns them to normal speed. All alarms are 
cleared.

Clear the PWR Alarm

Step 1 At the site, determine which battery is not present or operational. 

Step 2 Remove the power cable from the faulty supply. For instructions, refer to the “Install the Bay and 
Backplane Cable” chapter in the Cisco ONS 15600 SDH Procedure Guide and reverse the power cable 
installation procedure. 

Step 3 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447).

2.6.161 PWR-FA
Default Severity: Minor (MN), Non-Service-Affecting (NSA) 

Logical Object: BPLANE

The Backplane Power Fuse Failure alarm indicates that the backplane EEPROM memory 5-VDC fuse 
fails, but the equipment is still in service. Service is not currently affected, but network management can 
be affected because the ONS 15600 SDH system uses a default NE (node) IP address instead of a 
programmed one in this case. This alarm might be accompanied by the “INVMACADR” alarm on 
page 2-75, which appears in the alarm history when network management capability is restored. 

Do not attempt to troubleshoot the alarm. If the alarm does not clear, log into the Technical Support 
Website at http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.6.162 PWR-FAIL-A
Default Severity: Minor (MN), Non-Service-Affecting (NSA) 
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2.6.162  PWR-FAIL-A
Logical Objects: CAP, EQPT

The Equipment Power Failure at Connector A alarm occurs when there is no power supply from the main 
power connector to the equipment. This alarm occurs on the CAP, SSXC card, traffic (STM-N) cards, or 
TSC card.

Warning The power supply circuitry for the equipment can constitute an energy hazard. Before you install or 
replace the equipment, remove all jewelry (including rings, necklaces, and watches). Metal objects 
can come into contact with exposed power supply wiring or circuitry inside the DSLAM equipment. 
This could cause the metal objects to heat up and cause serious burns or weld the metal object to the 
equipment. Statement 207

Clear the PWR-FAIL-A Alarm

Step 1 If a single card has reported the alarm, take one of the following actions depending what kind of card 
reported it:

• If the reporting card is an active traffic line port in a 1+1 protection group or part of an SNCP, ensure 
that an APS traffic switch has occurred to move traffic to the protect port. 

– A SNCP APS is identified by an AUTOSW-type alarm or condition (such as AUTOSW-AIS, 
AUTOSW-PDI, AUTOSW-SDBER, AUTOSW-SFBER, or AUTOSW-UNEQ).

– A 1+1 APS is identified on the node view Maintenance > Protection tab. If you click the 
protection group, under the Selected Group list, the ports are designated as Working/Standby 
and Protect/Active.

– If the reporting port is part of an SNCP, complete the “Initiate a Force Switch for All Circuits 
on a SNCP Span” procedure on page 2-126. If the port is part of a 1+1 protection group, 
complete the “Initiate a 1+1 Protection Port Force Switch Command” procedure on page 2-123. 
Continue with Step 3.

• If an automatic switch to the alternate copy SSXC card occurred, the SSXC card can be serviced. If 
the switch has not occurred, complete the “Request a Cross-Connect Card Preferred Copy Switch” 
procedure on page 2-132. Continue with Step 3.

To determine which SSXC card is the preferred copy and if it is currently being used, open the node 
view Maintenance > Preferred Copy window. The Data Copy area Preferred field shows Copy A or 
Copy B. The Currently Used field shows the copy being used.

Note In CTC, Copy A refers to the SSXC card in Slot 6/7. Copy B refers to the SSXC card in 
Slot 8/9. Either copy might be chosen as the preferred copy SSXC card. The other SSXC 
card is called the alternate SSXC card in this chapter.

Step 2 Complete the “Soft-Reset a Card Using CTC” procedure on page 2-130 for the reporting card.

Step 3 If the alarm does not clear, complete the “Reset a Card with a Card Pull (Reseat)” procedure on 
page 2-133.

Step 4 Check the pins on the backplane connector, including the power pins on the edge of the card. Also 
inspect the pins on the backplane. A bent pin can cause power failure.

Caution If a backplane pin is bent, do not insert another card in the slot until the problem is remedied.
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Step 5 If the alarm does not clear, complete the “Replace an SSXC Card” procedure on page 2-133, “Replace 
an I/O Card” procedure on page 2-134, or “Replace a TSC Card” procedure on page 2-136 as needed.

Step 6 If the single card reseat and replacement does not clear the alarm, or if multiple cards report the alarm, 
verify the office power; refer to the “Install the Bay and Backplane Connections” chapter in the 
Cisco ONS 15600 SDH Procedure Guide for power installation instructions.

Step 7 If the alarm does not clear, reseat the power cable connection to the connector. For more information 
about ONS 15600 SDH power connections, refer to the “Install the Bay and Backplane Connections” 
chapter in the Cisco ONS 15600 SDH Procedure Guide.

Step 8 If the alarm does not clear, physically replace the power cable connection to the connector.

Step 9 If the alarm does not clear, a problem with the power distribution unit (PDU) is indicated and it could 
need to be replaced. Complete the procedure located in the “Maintain the Node” chapter in the 
Cisco ONS 15600 SDH Procedure Guide.

Step 10 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447). 

Step 11 If the alarm clears and it was reported by a traffic (STM-N) card, traffic reverts to the working port if an 
automatic switch occurred. If traffic was manually switched to a 1+1 protect port, revert traffic by 
completing the “Clear a 1+1 Protection Port Force or Manual Switch Command” procedure on 
page 2-124. If traffic was manually switched in an SNCP, revert traffic to the original path by completing 
the “Clear a SNCP Span External Switching Command” procedure on page 2-127. 

Step 12 If the alarm was reported by a SSXC card and an automatic switch to the alternate copy SSXC card 
occurred, traffic is automatically restored to the preferred copy.

Step 13 If the reporting card was reported by a TSC card and you want to make the standby card active, complete 
the “Soft-Reset a Card Using CTC” procedure on page 2-130.

2.6.163 PWR-FAIL-B
Default Severity: Minor (MN), Non-Service-Affecting (NSA) 

Logical Objects: CAP, EQPT

The Equipment Power Failure at Connector B alarm occurs when there is no power supplied to the 
backup power connector on the shelf. This alarm occurs on the CAP, SSXC card, traffic (STM-N) cards, 
or TSC card.

Troubleshoot this alarm with the “Clear the PWR-FAIL-A Alarm” procedure on page 2-104.

2.6.164 PWR-FAIL-RET-A
Default Severity: Minor (MN), Non-Service-Affecting (NSA) 

Logical Object: EQPT

The Equipment Power Failure at Power Return A alarm occurs when the main power return path is not 
available. This alarm occurs on the TSC card, SSXC card, or traffic (STM-N) cards. Troubleshoot using 
the “Clear the PWR-FAIL-A Alarm” procedure on page 2-104.
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2.6.165 PWR-FAIL-RET-B
Default Severity: Minor (MN), Non-Service-Affecting (NSA) 

Logical Object: EQPT

The Equipment Power Failure at Power Return B alarm occurs when the main power return path is not 
available. This alarm occurs on the TSC card, SSXC card, or traffic (STM-N) cards.

Troubleshoot using the “Clear the PWR-FAIL-A Alarm” procedure on page 2-104.

2.6.166 PWRRESTART
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Object: EQPT

The Power-Up Restart condition occurs when the shelf is restarted while no CTC connection is present. 
The Slot 5 TSC card on the shelf does not report this condition because the card is inactive when the 
condition occurs. You can see this condition in the Alarm History window when the CTC connection 
resumes.

2.6.167 RING-MISMATCH
Default Severity: Major (MJ), Service-Affecting (SA) 

Logical Object: STMN

At least one node in the MS-SPRing has an incorrect node ID. The RING-MISMATCH alarm clears 
when all nodes in the MS-SPRing have the correct node IDs.

Clear the RING-MISMATCH Alarm

Step 1 Complete the “Identify an MS-SPRing Ring ID or Node ID Number” procedure on page 2-122 to verify 
each node’s ID number.

Step 2 Repeat Step 1 for all nodes in the ring.

Step 3 If one node has an incorrect node ID number, complete the “Change an MS-SPRing Node ID Number” 
procedure on page 2-122 to change one node’s ID number so that each node ID is unique.

Step 4 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.6.168 RING-SW-EAST
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Object: STMN
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The Ring Switch Is Active East Side condition occurs when a ring switch occurs at the east side of a 
MS-SPRing using a Force Ring command. The condition clears when the switch is cleared. 
RING-SW-EAST is visible on the network view Alarms, Conditions, and History tabs. The port where 
the Force Ring was applied shows an “F” on the network view detailed circuit map.

Note RING-SW-EAST is an informational condition and does not require troubleshooting.

2.6.169 RING-SW-WEST
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Object: STMN

The Ring Switch Is Active West Side condition occurs when a ring switch occurs at the west side of a 
MS-SPRing using a Force Ring command. The condition clears when the switch is cleared. 
RING-SW-WEST is visible on the network view Alarms, Conditions, and History tabs. The port where 
the Force Ring was applied shows an “F” on the network view detailed circuit map.

Note RING-SW-WEST is an informational condition and does not require troubleshooting.

2.6.170 ROLL
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA) 

Logical Object: VCMON-HP

The ROLL condition indicates that circuits are being rolled. This is typically carried out to move traffic 
for a maintenance operation or to perform bandwidth grooming. The condition indicates that a good 
signal has been received on the roll destination leg, but the roll origination leg has not yet been dropped. 
The condition clears when the roll origination leg is dropped. 

Note ROLL is an informational condition and does not require troubleshooting.

2.6.171 ROLL-PEND
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Object: VCMON-HP

ROLL-PEND indicates that a roll process has been started, but a good signal has not been received yet 
by the roll destination leg. This condition can be raised individually by each path in a bulk circuit roll.

The condition clears when a good signal has been received on the roll destination leg.

Note ROLL-PEND is an informational condition and does not require troubleshooting.
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2.6.172 RS-EOC
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SDH Logical Objects: STMN

DWDM Logical Object: TRUNK 

The SDH Data Communications Channel (DCC) Termination Failure alarm occurs when the 
ONS 15600 SDH loses its data communications channel. Although this alarm is primarily SDH, it can 
apply to DWDM. For example, the OSCM card can raise this alarm on its STM-1 section overhead.

The RS-DCC consists of three bytes, D1 through D3, in the SDH overhead. The bytes convey 
information about operation, administration, maintenance, and provisioning (OAM&P). The 
ONS 15600 SDH uses the DCC on the SDH section overhead to communicate network management 
information.

Warning Class 1 laser product. Statement 1008

Warning Class 1M laser radiation when open. Do not view directly with optical instruments. Statement 1053

Warning On the OC192 LR/STM64 LH 1550 card, the laser is on when the card is booted and the safety key is in 
the on position (labeled 1). The port does not have to be in service for the laser to be on. The laser is 
off when the safety key is off (labeled 0). Statement 293

Warning Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector. 
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain 
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of 
100 mm could pose an eye hazard. Statement 1056 

Warning Use of controls, adjustments, or performing procedures other than those specified could result in 
hazardous radiation exposure. Statement 1057

Note If a circuit shows an incomplete state when this alarm is raised, the logical circuit is in place. The circuit 
is able to carry traffic when the connection issue is resolved. You do not need to delete the circuit when 
troubleshooting this alarm.

Note For information about DWDM cards, refer to the Cisco ONS 15454 DWDM Reference Manual. 

Clear the RS-EOC Alarm

Step 1 If the “LOS (STMN)” alarm on page 2-86 is also reported, complete the “Clear the LOS (STMN) Alarm” 
procedure on page 2-86. 
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Step 2 If the “LOF (STMN)” condition on page 2-82 is reported, complete the “Clear the LOF (STMN) Alarm” 
procedure on page 2-83.

Step 3 If the alarm does not clear on the reporting node, verify the physical connections between the cards and 
that the fiber-optic cables are configured to carry RS-DCC traffic. If they are not, correct them. For more 
information about STM-N fiber connections and terminations, refer to the “Install Cards and Fiber-Optic 
Cable” chapter in the Cisco ONS 15600 SDH Procedure Guide. For more information about OSCM fiber 
connections and terminations, refer to the Cisco ONS 15454 DWDM Troubleshooting Guide.

Caution Always use the supplied electrostatic discharge wristband when working with a powered 
ONS 15600 SDH. Plug the wristband cable into the ESD jack located lower-right edge of the shelf 
assembly.

If the physical connections are correct and configured to carry DCC traffic, ensure that both ends of the 
fiber span have unlocked ports. Verify that the ACT/SBY LED on each card is green.

Step 4 When the LEDs on the cards are correctly illuminated, complete the “2.8.5 Verify or Create Node DCC 
Terminations” procedure on page 2-139 to verify that the DCC is provisioned for the ports at both ends 
of the fiber span.

Step 5 Repeat Step 4 at the adjacent nodes.

Step 6 If DCC is provisioned for the ends of the span, verify that the port is active and in service by completing 
the following steps:

a. Confirm that the card shows a green LED in CTC or on the physical card.

A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card. 

b. To determine whether the port is in service, double-click the card in CTC to display the card view.

c. For an STM-N card, click the Provisioning > Line tabs. For the OSCM card, click the 
Provisioning > STM-1 Line tabs.

d. Verify that the Admin State column lists the port as Locked.

e. If the Admin State column lists the port as Locked,maintenance or Locked,disabled, click the 
column and click Locked from the drop-down list. Click Apply.

Note If a port in the unlocked admin state does not receive a signal, the LOS alarm is raised and 
the port service state transitions to Locked-disabled, automaticInService & failed.

Step 7 For all nodes, if the card is in service, use an optical test set to determine whether signal failures are 
present on fiber terminations. For specific procedures to use the test set equipment, consult the 
manufacturer.

Caution Using an optical test set disrupts service on an STM-N card. It could be necessary to manually switch 
traffic carrying circuits over to a protection path. Refer to the “2.8.2 Protection Switching, Lock 
Initiation, and Clearing” section on page 2-123 for commonly used switching procedures.

Step 8 If no signal failures exist on terminations, measure power levels to verify that the budget loss is within 
the parameters of the receiver. See the “1.9.3 Optical Traffic Card Transmit and Receive Levels” section 
on page 1-74 for non-DWDM card levels and refer to the Cisco ONS 15454 DWDM Reference Manual 
for DWDM card levels.
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Step 9 If budget loss is within parameters, ensure that fiber connectors are securely fastened and properly 
terminated. For more information refer to “Install Cards and Fiber-Optic Cables” chapter in the 
Cisco ONS 15600 SDH Procedure Guide.

Step 10 If fiber connectors are properly fastened and terminated, complete the “Soft-Reset a Card Using CTC” 
procedure on page 2-130.

Wait ten minutes to verify that the card you reset completely reboots and becomes the standby card.

Resetting the active TSC card switches control to the standby TSC card. If the alarm clears when the 
ONS 15600 SDH node switches to the standby TSC card, the user can assume that the previously active 
card is the cause of the alarm.

Step 11 If the TSC card reset does not clear the alarm, delete the problematic RS-DCC termination by completing 
the following steps:

a. From card view, click View > Go to Previous View if you have not already done so.

b. Click the Provisioning > Comm Channels > RS-DCC tabs.

c. Highlight the problematic DCC termination.

d. Click Delete.

e. Click Yes in the Confirmation Dialog box.

Step 12 Recreate the RS-DCC termination. Refer to the “Turn Up Network” chapter in the 
Cisco ONS 15600 SDH Procedure Guide for procedures.

Step 13 Verify that both ends of the DCC have been recreated at the optical ports.

Step 14 If the alarm has not cleared, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or log into  http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to 
obtain a directory of toll-free Technical Support numbers for your country. If the Technical Support 
technician tells you to reseat the card, complete the “Reset a Card with a Card Pull (Reseat)” procedure 
on page 2-133. If the Technical Support technician tells you to remove the card and reinstall a new one, 
follow the “Replace a TSC Card” procedure on page 2-136.

2.6.173 SFTWDOWN
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

Logical Object: EQPT

A Software Download in Progress condition occurs when a TSC card is downloading or transferring 
software. No action is necessary. Wait for the transfer or the software download to complete. If the alarm 
does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport for more 
information or call Cisco TAC (1 800 553-2447).

Note It takes approximately 20 minutes for the active TSC card to transfer the system software to the newly 
installed TSC card. Software transfer occurs in instances where different software versions exist on the 
two cards. When the transfer completes, the TSC card reboots and goes into standby mode after 
approximately three minutes.
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Note If the active and standby TSC cards have the same versions of software, it takes approximately three 
minutes for software to be updated on a standby TSC card.

2.6.174 SNTP-HOST
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

Logical Object: NE

The Simple Network Timing Protocol (SNTP) Host Failure alarm indicates that an ONS node serving as 
an IP proxy for the other ONS nodes in the ring is not forwarding SNTP information to the other ONS 
nodes in the network. The forwarding failure can result from two causes, either the IP network attached 
to the ONS proxy node is experiencing problems, or the ONS proxy node itself is not functioning 
properly.

Clear the SNTP-HOST Alarm

Step 1 Ping the SNTP host from a workstation in the same subnet to ensure that communication is possible 
within the subnet by completing the “Ping the ONS 15600” procedure on page 1-56.

Step 2 If the ping fails, contact the network administrator who manages the IP network that supplies the SNTP 
information to the proxy and determine whether the network is experiencing problems which might 
affect the SNTP server/router connecting to the proxy ONS 15600 SDH.

Step 3 If no network problems exist, ensure that the ONS 15600 SDH proxy is provisioned correctly by 
completing the following steps:

a. In node view for the ONS node serving as the proxy, click the Provisioning > General tabs.

b. Ensure that the Use NTP/SNTP Server check box is checked.

c. If the Use NTP/SNTP Server check box is not checked, click it.

d. Ensure that the Use NTP/SNTP Server field contains a valid IP address for the server.

Step 4 If proxy is correctly provisioned, refer to the “Management Network Connectivity” chapter in the 
Cisco ONS 15600 SDH Reference Manual for more information on SNTP Host.

Step 5 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447).

2.6.175 SSM-DUS
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Objects: BITS, STMN

The Synchronization Status Messaging (SSM) Changed to Do Not Use (DUS) condition occurs when 
the synchronization status message quality level changes to DUS. 

The port that reports the condition is not at fault. The condition applies to the timing source. SSM-DUS 
prevents timing loops by providing a termination point for the signal usage.
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2.6.176 SSM-FAIL
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

Logical Objects: BITS, STMN

The SSM Failed to Receive Synchronization alarm occurs when SSM received by the ONS 15600 SDH 
fails. The problem is external to the ONS 15600 SDH. If one of two sources fails, the alarm is 
Minor (MN). If there is no backup source, the alarm is Major (MJ). This alarm indicates that although 
the ONS 15600 SDH is set up to receive SSM, the timing source is not delivering valid SSM messages.

Clear the SSM-FAIL Alarm

Step 1 Verify that SSM is enabled on the external timing source.

Step 2 Use an optical test set to determine whether the external timing source is delivering SSM; refer to the 
“Create Circuits” chapter in the Cisco ONS 15600 SDH Procedure Guide for circuit test procedures.

Step 3 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447).

2.6.177 SSM-OFF
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Objects: BITS, STMN

The SSM Changed to Off condition occurs when SSM is disabled by a user.

SSM communicates information about the quality of the timing source. SSM is carried on the S1 byte of 
the SDH line layer. It enables SDH devices to automatically select the highest quality timing reference 
and to avoid timing loops. Troubleshoot with the “Clear the SSM-FAIL Alarm” procedure on page 2-112 
if desired.

2.6.178 SSM-SMC
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Objects: BITS, NE-SREF, STMN

The SSM Quality Level Changed to SDH Minimum Clock Traceable (SMC) condition occurs when the 
synchronization message quality level changes to SMC. 

2.6.179 SSM-STU
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Objects: BITS, NE-SREF, STMN
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The SSM Synchronization Traceability Unknown condition occurs when the reporting node is timed to 
a reference that does not support SSM, but the ONS 15600 SDH has SSM support enabled. SSM-STU 
can also be raised if the timing source is sending out SSM messages but SSM is not enabled on the 
ONS 15600 SDH.

Clear the SSM-STU Condition

Step 1 Click the node view Provisioning > Timing > BITS Facilities tabs.

Step 2 If the Sync. Messaging Enabled check box is checked, click the box to deselect it.

Step 3 If the Sync. Messaging Enabled check box is unchecked, click the box to select it.

Step 4 Click Apply.

Step 5 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.6.180 SWTOPRI
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Objects: EXT-SREF, NE-SREF

The Synchronization Switched to Primary Reference condition occurs when the ONS 15600 SDH 
switches to the primary timing source (reference 1). The ONS 15600 SDH uses three ranked timing 
references. The timing references are typically two BITS-level or line-level sources and an internal 
reference. 

2.6.181 SWTOSEC
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA) 

Logical Objects: EXT-SREF, NE-SREF

The Synchronization Switched to Second Reference condition occurs when the ONS 15600 SDH has 
switched to a second timing source (reference 2). To clear the SWTOSEC condition, complete the “Clear 
the SYNCPRI Alarm” procedure on page 2-115.

2.6.182 SWTOTHIRD
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA) 

Logical Objects: EXT-SREF, NE-SREF

The Synchronization Switched to Third Reference condition occurs when the ONS 15600 SDH has 
switched to a third timing source (reference 3). To clear the SWTOTHIRD condition, complete the 
“Clear the SYNCPRI Alarm” procedure on page 2-115.
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2.6.183 SW-VER
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA) 

Logical Object: EQPT

The Software Version condition is reported when a new software version is activated on the 
ONS 15600 SDH. When a new version of software is uploaded, it results in the active TSC card running 
the new version and the standby TSC card running the old version. This situation raises the SW-VER 
condition. It remains until the user accepts the new version in the CTC. The acceptance causes the 
standby TSC card to reboot and upload the new version. 

If the user does not accept the version, the active TSC card switches to the standby TSC card with the 
original version. After the switch, the new standby TSC card reverts to the previous version. 

2.6.184 SYNCCLK
Default Severity: Critical (CR), Service-Affecting (SA)

Logical Object: NE

A Synchronization Clock Unavailable alarm occurs when both TSC cards lose their timing function. 

Clear the SYNCCLK Alarm

Step 1 From node view, click the Provisioning > Timing > General tabs.

Step 2 Check the current configuration for REF-1 of the NE Reference.

Step 3 If the primary reference is a BITS input, complete the “Clear the LOF (BITS) Alarm” procedure on 
page 2-82.

Step 4 If the primary reference clock is an incoming port on the ONS 15600 SDH, complete the “Clear the LOF 
(STMN) Alarm” procedure on page 2-83.

Step 5 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447).

2.6.185 SYNC-FREQ
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Objects: BITS, STMN

The Synchronization Reference Frequency Out of Bounds alarm occurs when the synchronization 
frequency reference for the NE (node) is not within acceptable boundaries.

Clear the SYNC-FREQ Alarm

Step 1 Verify that the internal or BITS timing reference is stable. The timing reference is located on the active 
TSC card. Check for any alarms against this card and troubleshoot them.

Step 2 If the alarm does not clear, complete the “Soft-Reset a Card Using CTC” procedure on page 2-130. 
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Step 3 If the alarm clears, complete the “Replace a TSC Card” procedure on page 2-136.

Note It takes approximately 20 minutes for the active TSC card to transfer the system software to the 
newly installed TSC card. Software transfer occurs in instances where different software 
versions exist on the two cards. When the transfer completes, the TSC card reboots and goes into 
standby mode after approximately three minutes.

Note If the active and standby TSC cards have the same versions of software, it takes approximately 
three minutes for software to be updated on a standby TSC card. 

Step 4 If the SYNC-FREQ alarm continues to report after replacing the TSC card, log into the Technical 
Support Website at http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 
553-2447).

2.6.186 SYNCPRI
Default Severity: Minor (MN), Non-Service-Affecting (NSA) for EXT-SREF; Major (MJ), 
Service-Affecting (SA) for NE-SREF

Logical Objects: EXT-SREF, NE-SREF

A Primary Synchronization Reference Failure alarm occurs at the NE (node) level when the 
ONS 15600 SDH loses the primary timing source (reference 1). The ONS 15600 SDH uses three ranked 
timing references. The timing references are typically two BITS-level or line-level sources and an 
internal reference. If SYNCPRI occurs, the ONS 15600 SDH should switch to its second timing source 
(reference 2). This switch also triggers the SWTOSEC alarm.

Clear the SYNCPRI Alarm

Step 1 From node view, click the Provisioning > Timing > General tabs and identify the timing source in 
REF-1 of the NE Reference.

Step 2 If REF-1 is Internal, this refers to the active TSC card. Look for any alarms related to the TSC card and 
troubleshoot them.

Step 3 If REF-1 is BITS, follow the “Clear the LOF (BITS) Alarm” procedure on page 2-82.

Step 4 If the primary reference clock is an incoming port on the ONS 15600 SDH, follow the “Clear the LOF 
(STMN) Alarm” procedure on page 2-83. 

Step 5 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447).

2.6.187 SYNCSEC
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
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Logical Objects: EXT-SREF, NE-SREF

A Second Synchronization Reference Failure Alarm occurs at the NE (node) level when the 
ONS 15600 SDH loses the second timing source (reference 2). If SYNCSEC occurs, the 
ONS 15600 SDH should switch to a third timing source (reference 3) to obtain valid timing for the 
ONS 15600 SDH. This switch also triggers the “SWTOTHIRD” condition on page 2-113.

Clear the SYNCSEC Alarm

Step 1 From node view, click the Provisioning > Timing > General tabs.

Step 2 Check the current configuration of REF-2 for the NE Reference.

Step 3 If the second reference is a BITS input, follow the “Clear the LOS (BITS) Alarm” procedure on 
page 2-85.

Step 4 If the second timing source is an incoming port on the ONS 15600 SDH, follow the “Clear the LOF 
(STMN) Alarm” procedure on page 2-83.

Step 5 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447).

2.6.188 SYNCTHIRD 
The SYNCTHIRD condition is not used in this platform in this release. It is reserved for development.

2.6.189 SYSBOOT
Default Severity: Major (MJ), Service-Affecting (SA)

Logical Object: NE

The System Reboot alarm indicates that new software is booting on the node or shelf TSC card. No 
action is required. The alarm clears when all cards finish rebooting the new software. The reboot takes 
approximately three minutes. 

2.6.190 TPTFAIL
The TPTFAIL alarm for packet over SDH (POS) is not used in this platform in this release. It is reserved 
for development.

2.6.191 UNPROT-SYNCCLK
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

Logical Object: NE

The Unprotected Synchronization or Clock Equipment alarm indicates that only one TSC card has 
acquired the primary timing reference. The alarm is reported if there is no standby TSC card, or if the 
standby TSC card has restarted and 700 seconds (in FSTSYNC mode) have not elapsed.
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This condition is normal following a change to the system timing reference (such as BITS to Line or 
Line to BITS). Changing the clock reference causes both TSC cards to raise the “FSTSYNC” condition 
on page 2-64, for 700 seconds. The UNPROT-SYNCCLK alarm occurs during this period. If both TSC 
cards are reset within 700 seconds of each other, this alarm occurs also and remains until both TSC cards 
attains the clock reference. If the alarm does not clear, follow the “Clear the UNPROT-SYNCCLK 
Alarm” procedure on page 2-117.

Clear the UNPROT-SYNCCLK Alarm

Step 1 Determine whether one or both TSC cards have the “FSTSYNC” condition on page 2-64 raised. If either 
TSC card has a FSTSYNC condition, wait 700 seconds for the condition and the UNPROT-SYNCCLK 
alarm to clear.

Step 2 If FSTSYNC was reported and continues after 700 seconds, replace the standby TSC card. Continue with 
Step 7.

Step 3 If FSTSYNC is not reported, from node view, click the Provisioning > Timing > General tabs.

Step 4 Verify the current configuration for REF-1 of the NE Reference.

If the primary reference clock is an incoming port on the ONS 15600 SDH, follow the “Clear the LOF 
(STMN) Alarm” procedure on page 2-83.

Step 5 If no protect TSC card is installed, install one. Refer to the “Install Cards and Fiber-Optic Cable” chapter 
in the Cisco ONS 15600 SDH Procedure Guide for instructions.

Step 6 If the alarm persists, remove and reinsert (reseat) the standby TSC card by completing the following 
steps and wait 700 seconds for the TSC card to acquire the reference.

a. Open the card ejectors.

b. Slide the card out of the slot.

c. Slide the card into the slot along the guide rails.

d. Close the ejectors.

Step 7 If the alarm reappears after you perform the switch, complete the “2.8.5 Verify or Create Node DCC 
Terminations” procedure on page 2-139 on the standby TSC card and wait 700 seconds for the TSC card 
to acquire the reference.

Note It takes approximately 20 minutes for the active TSC card to transfer the system software to the 
newly installed TSC card. Software transfer occurs in instances where different software 
versions exist on the two cards. When the transfer completes, the TSC card reboots and goes into 
standby mode after approximately three minutes.

Note If the active and standby TSC cards have the same versions of software, it takes approximately 
three minutes for software to be updated on a standby TSC card. 

2.6.192 UNPROT-XCMTX
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
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Logical Object: NE

The Unprotected Cross-Connection Matrix Equipment alarm indicates that only one functional SSXC 
card on the node supports the cross-connection. The alarm clears if the redundant SSXC card is installed. 
This alarm could be accompanied by the “IMPROPRMVL (EQPT for the SSXC or TSC Card)” alarm 
on page 2-73 or the “EQPT (EQPT)” alarm on page 2-44.

Clear the UNPROT-XCMTX Alarm

Step 1 If there is no protect SSXC card installed, install one.

Allow the newly installed SSXC card to boot. 

Step 2 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447).

2.6.193 UNQUAL-PPM
Default Severity: Minor (MN), Non-Service-Affecting (NSA)

SDH Logical Objects: PPM

The Unqualified PPM Inserted condition occurs when a PPM with a nonqualified product ID is plugged 
into the card’s port; that is, the PPM passes the security code check as a Cisco PPM but is not qualified 
for use on the particular card.

Clear the UNQUAL-PPM Condition

Step 1 Obtain the correct Cisco PPM and replace the existing PPM with the new one.

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.6.194 UNROUTEABLE-IP
The UNROUTEABLE-IP is not used in this platform in this release. It is reserved for development.

2.6.195 UPGRADE
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Object: NE

The System Upgrade in Progress condition indicates that a system upgrade is occurring on the TSC card. 

When software is downloaded, it is loaded into the available code volume on the active TSC card. The 
software is copied to the available code volume on the standby TSC card next. The “SFTWDOWN” 
condition on page 2-110 occurs at that time. When the user activates the load, the UPGRADE condition 
occurs. 
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2.6.196  VOLT-MISM
Note Whenever TSC cards are changed from active to standby, it takes approximately 12 minutes to 
completely synchronize to the timing source because the Stratum 3E timing module is being adopted.

2.6.196 VOLT-MISM
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Object: PWR

The Power Monitoring Mismatch Between Control Cards alarm is raised against the shelf when the 
power voltages of both TSC cards are out of range of each other by more than 5Vdc. 

Clear the VOLT-MISM Condition

Step 1 Check the incoming voltage level to the shelf using a voltmeter. Follow site practices or consult the 
“Install the Shelf and FMECs” chapter in the Cisco ONS 15600 SDH Procedure Guide for power 
installation procedures.

Step 2 Correct any incoming voltage issues.

Step 3 If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport 
for more information or call Cisco TAC (1 800 553-2447).

2.6.197 WKSWPR 
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Objects: VCMON-HP

The Working Switched To Protection condition occurs when a line has a failure, the “LOS (STMN)” 
alarm on page 2-86 or the “MS-DEG” condition on page 2-98. 

This condition is also raised when you use the FORCE RING, FORCE SPAN, or MANUAL SPAN 
command at the network level. WKSWPR is visible on the network view Alarms, Conditions, and 
History tabs.

Clear the WKSWPR Condition

Step 1 Complete the “Clear the LOF (STMN) Alarm” procedure on page 2-83. (It is also used for LOS.)

Step 2 If the condition does not clear, log into the Technical Support Website at 
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.6.198 WTR
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
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2.6.199  XCMTX
Logical Objects: STMN, VCMON-HP

The Wait to Restore condition indicates that revertive switching is specified and that a switch to 
protection occurred. When the working path is viable, this condition occurs while the wait to restore 
timer has not expired. The condition clears when the timer expires and traffic switches back to the 
working path.

2.6.199 XCMTX
Default Severity: Critical (CR), Service-Affecting (SA)

Logical Object: NE

The Unavailable Cross-Connection Matrix Equipment alarm indicates no cross-connection matrix on the 
NE (node). If there was previously a single SSXC card running in unprotected mode, that card fails. If 
there were two cards running in protected mode, the matrix has become unavailable on both. 
Troubleshoot with the “Clear the UNPROT-XCMTX Alarm” procedure on page 2-118.

2.7 LED Behavior
The following the subsections describe LED behaviors of the TSC card, SSXC card, and STM-N cards.

2.7.1 TSC Card-Level Indicators
Table 2-13 lists typical card-level TSC card LED behaviors. 

2.7.2 TSC Card Network-Level Indicators
Table 2-14 lists typical network-level TSC card LED behaviors.

Table 2-13 TSC Card-Level Indicators

Indicator LED Color Definition

STAT Red Indicates a hardware fault; this LED is off during normal operation. 
Replace the card if the STAT LED persists. During diagnostics, the LED 
flashes quickly during initialization and slowly during configuration 
synchronization.

SRV Green The service mode of the card; green indicates that the card is in use and 
no light indicates that the card can be removed for service.

ACT/STBY Green The ACT/STBY (Active/Standby) LED indicates that the TSC card is 
active (green) or standby (off). It is not present on the optical cards.

Table 2-14 TSC Card Network-Level Indicators

Indicator LED Color Definition

LINE Green Node timing is synchronized to a line timing reference.

EXTERNAL Green Node timing is synchronized to an external timing reference.
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2.7.3 SSXC Card-Level Indicators
Table 2-15 describes the functions of the card-level LEDs on the SSXC card faceplate.

2.7.4 STM-N Card Indicators
Table 2-16 describes the functions of the card-level LEDs on the STM-16 and STM-64 cards.

Note STM-N card SF and SD card-level LEDs are not displayed in CTC.

FREE RUN Green The node is not using an external timing reference. Indicated when the 
timing mode is set to an internal reference or after all external references 
are lost.

HOLDOVER Amber External/line timing references have failed. The TSC card has switched 
to internal timing and the 24-hour holdover period has not elapsed.

ACO Amber The alarm cutoff (ACO) push button has been activated. After pressing 
the ACO button, the amber ACO LED turns on. The ACO button opens 
the audible closure on the backplane. The ACO state is stopped if a new 
alarm occurs. After the originating alarm is cleared, the ACO LED and 
audible alarm control are reset.

Table 2-14 TSC Card Network-Level Indicators (continued)

Indicator LED Color Definition

Table 2-15 SSXC Card-Level Indicators

Indicators LED Color Definition

STAT Red Indicates a hardware fault; this LED is off during normal operation. 
Replace the card if the STAT LED persists. During diagnostics, the LED 
flashes quickly during initialization and flashes slowly during 
configuration synchronization.

SRV Green The service mode of the card. Green indicates the card is in use; no light 
indicates that the card can be removed for service.

Amber The service mode of the card. Amber indicates the card is in use; no light 
indicates that the card can be removed for service.

Table 2-16 STM-N Card-Level Indicators 

Indicators Color Description

STAT LED Red Indicates a hardware fault; this LED is off during normal operation. 
Replace the card if the STAT LED persists. During diagnostics, the LED 
flashes quickly during initialization and flashes slowly during 
configuration synchronization.
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2.8 Frequently Used Alarm Troubleshooting Procedures
This section gives common procedures that are frequently used when troubleshooting alarms. Most of 
these procedures are summarized versions of more detailed procedures in the Cisco ONS 15600 SDH 
Procedure Guide. 

2.8.1 Node and Ring Identification, Change, Visibility, and Termination
The following procedures relate how to identify or change MS-SPRing names and node IDs, and how to 
verify visibility from other nodes.

Identify an MS-SPRing Ring ID or Node ID Number

Step 1 In node view, click View > Go to Network View.

Step 2 Click the Provisioning > MS-SPRing tabs.

Step 3 From the Ring ID column, record the Ring ID, or in the nodes column, record the Node IDs in the 
MS-SPRing. The Node IDs are the numbers in parentheses next to the node name.

Change an MS-SPRing Ring ID Number

Step 1 In node view, click View > Go to Network View.

Step 2 Click the Provisioning > MS-SPRing tabs.

Step 3 Highlight the ring and click Edit.

Step 4 In the MS-SPRing window, enter the new ID in the Ring ID field.

Step 5 Click Apply.

Step 6 Click Yes in the Changing Ring ID dialog box.

Change an MS-SPRing Node ID Number

Step 1 In node view, click View > Go to Network View.

Step 2 Click the Provisioning > MS-SPRing tabs.

SRV LED Green The service mode of the card; green indicates that the card is in use and 
no light indicates that the card can be removed for service.

LASER ON Green The green LASER ON LED indicates that at least one of the card’s lasers 
is active.

Table 2-16 STM-N Card-Level Indicators  (continued)

Indicators Color Description
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Step 3 Highlight the ring and click Edit.

Step 4 In the MS-SPRing window, right-click the node on the ring map.

Step 5 Select Set Node ID from the shortcut menu.

Step 6 Enter the new ID in the field.

Step 7 Click Apply.

Verify Node Visibility for Other Nodes

Step 1 In node view, click the Provisioning > MS-SPRing tabs.

Step 2 Highlight an MS-SPRing.

Step 3 Click Ring Map.

Step 4 Verify that each node in the ring appears on the ring map with a node ID and IP address.

Step 5 Click Close.

2.8.2 Protection Switching, Lock Initiation, and Clearing
The following sections give instructions for port, ring, and span switching and switch-clearing 
commands, as well as lock-ons and lockouts.

Initiate a 1+1 Protection Port Force Switch Command

This procedure switches 1+1 protection group traffic from one port in the group to the other using a 
Force switch. 

Caution The Force command overrides normal protective switching mechanisms. Applying this command 
incorrectly can cause traffic outages.

Caution Traffic is not protected during a Force protection switch.

Note A Force command switches traffic on a working path even if the path has signal degrade (SD) or signal 
fail (SF) conditions. A Force switch does not switch traffic on a protect path. A Force switch preempts 
a Manual switch. 

Step 1 In node view, click the Maintenance > Protection tabs. 

Step 2 In the Protection Groups area, select the protection group with the port you want to switch. 
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Step 3 In the Selected Groups area, select the port belonging to the card you are replacing. You can carry out 
this command for the working or protect port. For example, if you need to replace the card with the 
Protect/Standby port, click this port.

Step 4 In the Switch Commands area, click Force.

Step 5 Click Yes in the Confirm Force Operation dialog box.

Step 6 If the switch is successful, the group says “Force to working” in the Selected Groups area.

Initiate a 1+1 Protection Port Manual Switch Command

This procedure switches 1+1 protection group traffic from one port in the group to the other using a 
Manual switch. 

Note A Manual command switches traffic if the path has an error rate less than the signal degrade. A Manual 
switch is preempted by a Force switch. 

Step 1 In node view, click the Maintenance > Protection tabs. 

Step 2 In the Protection Groups area, select the protection group with the port you want to switch. 

Step 3 In the Selected Groups area, select the port belonging to the card you are replacing. You can carry out 
this command for the working or protect port. For example, if you need to replace the card with the 
protect/standby port, click this port.

Step 4 In the Switch Commands area, click Manual.

Step 5 Click Yes in the Confirm Force Operation dialog box.

Step 6 If the switch is successful, the group now says “Manual to working” in the Selected Groups area.

Clear a 1+1 Protection Port Force or Manual Switch Command

Note If the 1+1 protection group is configured as revertive, clearing a Force switch to protect (or working) 
moves traffic back to the working port. In revertive operation, the traffic always switches back to 
working. There is no revert to protect. If ports are not configured as revertive, clearing a Force switch to 
protect does not move traffic back.

Note If the Force Switch was user-initiated, the reversion occurs immediately when the clear command is 
issued. The five-minute WTR period is not needed in this case. If the Force was system-initiated, allow 
the five-minute waiting period (during WTR) before the reversion occurs.

Step 1 In node view, click the Maintenance > Protection tabs.

Step 2 In the Protection Groups area, choose the protection group containing the port you want to clear.

Step 3 In the Selected Group area, choose the port you want to clear.
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Step 4 In the Switching Commands area, click Clear.

Step 5 Click Yes in the Confirmation Dialog box. 

The Force switch is cleared. Traffic immediately reverts to the working port if the group was configured 
for revertive switching.

Initiate a Card or Port Lock On Command

Note For a 1+1 optical protection group, only the working port can be placed in the Lock On state.

Step 1 In node view, click the Maintenance > Protection tabs.

Step 2 In the Protection Groups list, click the protection group where you want to apply a lock-on.

Step 3 If you determine that the protect card is in standby mode and you want to apply the lock-on to the protect 
card, make the protect card active if necessary by completing the following steps:

a. In the Selected Group list, click the protect card.

b. In the Switch Commands area, click Force.

Step 4 In the Selected Group list, click the active card where you want to lock traffic.

Step 5 In the Inhibit Switching area, click Lock On.

Step 6 Click Yes in the confirmation dialog box.

Initiate a Card or Port Lock Out Command

Note For a 1+1 optical protection group, only the protect port can be placed in the Lock Out state.

Step 1 In node view, click the Maintenance > Protection tabs.

Step 2 In the Protection Groups list, click the protection group that contains the card you want to lock out.

Step 3 In the Selected Group list, click the card that you want to lock traffic out of.

Step 4 In the Inhibit Switching area, click Lock Out.

Step 5 Click Yes in the confirmation dialog box.

The lockout has been applied and traffic is switched to the opposite card. 

Clear a Card or Port Lock On or Lock Out Command

Step 1 In node view, click the Maintenance > Protection tabs.

Step 2 In the Protection Groups list, click the protection group that contains the card that you want to clear.
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Step 3 In the Selected Group list, click the card that you want to clear.

Step 4 In the Inhibit Switching area, click Unlock.

Step 5 Click Yes in the confirmation dialog box.

The lock-on or lockout is cleared.

Initiate a Force Switch for All Circuits on a SNCP Span 

This procedure forces all circuits in a SNCP from the working span to the protect. It is used to remove 
traffic from a card that originates or terminates SNCP circuits. 

Caution The Force command overrides normal protective switching mechanisms. Applying this command 
incorrectly can cause traffic outages.

Caution Traffic is not protected during a Force protection switch.

Step 1 Log into a node on the network. If you are already logged in, continue with Step 3.

Step 2 Click View > Go to Network View.

Step 3 Right-click a network span and choose Circuits.

The Circuits on Span dialog box shows the SNCP circuits, including circuit names, locations, and a color 
code showing which circuits are active on the span.

Step 4 Click the Perform SNCP span switching field. 

Step 5 Choose Force Switch Away from the drop-down list. 

Step 6 Click Apply. 

Step 7 In the Confirm SNCP Switch dialog box, click Yes.

Step 8 In the Protection Switch Result dialog box, click OK.

In the Circuits on Span dialog box, the switch state for all circuits is FORCE. Unprotected circuits do 
not switch.

Initiate a Manual Switch for All Circuits on a SNCP Span 

This procedure manually switches all circuits in an SNCP from the working span to the protect. It is used 
to remove traffic from a card that originates or terminates SNCP circuits. 

Caution The Manual command does not override normal protective switching mechanisms. 

Step 1 Log into a node on the network. If you are already logged in, continue with Step 2.

Step 2 Right-click a network span and choose Circuits.
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The Circuits on Span dialog box shows the SNCP circuits, including circuit names, locations, and a color 
code showing which circuits are active on the span.

Step 3 Click the Perform SNCP span switching field. 

Step 4 Choose Manual from the drop-down list. 

Step 5 Click Apply. 

Step 6 In the Confirm SNCP Switch dialog box, click Yes.

Step 7 In the Protection Switch Result dialog box, click OK.

In the Circuits on Span dialog box, the switch state for all circuits is Manual. Unprotected circuits do 
not switch.

Initiate a Lock Out of Protect Switch for All Circuits on an SNCP Span 

This procedure prevents all circuits in an SNCP working span from switching to the protect span. It is 
used to keep traffic off cards that originate or terminate SNCP circuits. 

Caution The Lock Out of Protect overrides normal protective switching mechanisms. 

Step 1 Log into a node on the network. If you are already logged in, continue with Step 2.

Step 2 Right-click a network span and choose Circuits.

The Circuits on Span dialog box shows the SNCP circuits, including circuit names, locations, and a color 
code showing which circuits are active on the span.

Step 3 Click the Perform SNCP span switching field. 

Step 4 Choose Lock Out of Protect from the drop-down list. 

Step 5 Click Apply. 

Step 6 In the Confirm SNCP Switch dialog box, click Yes.

Step 7 In the Protection Switch Result dialog box, click OK.

In the Circuits on Span dialog box, the switch state for all circuits is FORCE. Unprotected circuits do 
not switch.

Clear a SNCP Span External Switching Command 

Note If the ports terminating a span are configured as revertive, clearing a Force or Manual switch to protect 
moves traffic back to the working port. If ports are not configured as nonrevertive, clearing a Force 
switch to protect does not move traffic back.

Step 1 Log into a node on the network. If you are already logged in, continue with Step 2.

Step 2 Right-click a network span and choose Circuits.
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The Circuits on Span dialog box shows the SNCP circuits, including circuit names, locations, and a color 
code showing which circuits are active on the span.

Step 3 Initiate a Force switch for all circuits on the span by completing the following steps:

a. Click the Perform SNCP span switching field. 

b. Choose Clear from the drop-down list. 

c. Click Apply. 

d. In the Confirm SNCP Switch dialog box, click Yes.

e. In the Protection Switch Result dialog box, click OK.

In the Circuits on Span dialog box, the switch state for all circuits is Clear. Unprotected circuits do 
not switch.

Initiate a Force Ring Switch on an MS-SPRing

Step 1 Log into a node on the network. If you are already logged in, continue with Step 2.

Step 2 From the View menu, choose Go to Network View.

Step 3 In network view, click the Provisioning > MS-SPRing tabs.

Step 4 Click the row of the MS-SPRing you are switching, then click Edit. 

Step 5 Right-click a MS-SPRing node west port and choose Set West Protection Operation. 

Step 6 In the Set West Protection Operation dialog box, choose Force Ring from the drop-down list.

Step 7 Click OK.

Step 8 Click Yes in the two Confirm MS-SPRing Operation dialog boxes that appear.

Initiate a Manual Span Switch on a MS-SPRing

Step 1 From the View menu, choose Go to Network View. 

Step 2 Click the Provisioning > MS-SPRing tabs.

Step 3 Choose the MS-SPRing and click Edit. 

Step 4 Right-click the MS-SPRing node channel (port) and choose Set West Protection Operation (if you 
chose a west channel) or Set East Protection Operation (if you chose an east channel).

Step 5 In the Set West Protection Operation dialog box or the Set East Protection Operation dialog box, choose 
Manual Span from the drop-down list. 

Step 6 Click OK.

Step 7 Click Yes in the two Confirm MS-SPRing Operation dialog boxes.
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Initiate a Manual Ring Switch on a MS-SPRing

Step 1 From the View menu, choose Go to Network View. 

Step 2 Click the Provisioning > MS-SPRing tabs.

Step 3 Choose the MS-SPRing and click Edit. 

Step 4 Right-click the MS-SPRing node channel (port) and choose Set West Protection Operation.

Step 5 In the Set West Protection Operation dialog box or the Set East Protection Operation dialog box, choose 
Manual Ring from the drop-down list. 

Step 6 Click OK.

Step 7 Click Yes in the two Confirm MS-SPRing Operation dialog boxes.

Initiate a Lock Out on a MS-SPRing Protect Span

Step 1 From the View menu, choose Go to Network View. 

Step 2 Click the Provisioning > MS-SPRing tabs.

Step 3 Choose the MS-SPRing and click Edit. 

Step 4 Right-click the MS-SPRing node channel (port) and choose Set West Protection Operation (if you 
chose a west channel) or Set East Protection Operation (if you chose an east channel).

Step 5 In the Set West Protection Operation dialog box or the Set East Protection Operation dialog box, choose 
Lockout Protect Span from the drop-down list. 

Step 6 Click OK.

Step 7 Click Yes in the two Confirm MS-SPRing Operation dialog boxes.

Initiate an Exercise Ring Switch on an MS-SPRing

Step 1 Log into a node on the network. If you are already logged in, continue with Step 2.

Step 2 Click View > Go to Network View.

Step 3 Click the Provisioning > MS-SPRing tabs.

Step 4 Click the row of the MS-SPRing you are exercising, then click Edit. 

Step 5 Right-click the west port of a node and choose Set West Protection Operation. 

Step 6 In the Set West Protection Operation dialog box, choose Exercise Ring from the drop-down list. 

Step 7 Click OK.

Step 8 Click Yes in the Confirm MS-SPRing Operation dialog box.
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Initiate an Exercise Ring Switch on a Four Fiber MS-SPRing

Step 1 Log into a node on the network. If you are already logged in, continue with Step 2.

Step 2 Click View > Go to Network View.

Step 3 Click the Provisioning > MS-SPRing tabs.

Step 4 Click the row of the MS-SPRing you are exercising, then click Edit. 

Step 5 Right-click the west port of a node and choose Set West Protection Operation. 

Step 6 In the Set West Protection Operation dialog box, choose Exercise Span from the drop-down list. 

Step 7 Click OK.

Step 8 Click Yes in the Confirm MS-SPRing Operation dialog box.

Clear a MS-SPRing External Switching Command

Step 1 Log into a node on the network. If you are already logged in, continue with Step 2.

Step 2 Click View > Go to Network View.

Step 3 Click the Provisioning > MS-SPRing tabs.

Step 4 Click the MS-SPRing you want to clear.

Step 5 Right-click the west port of the MS-SPRing node where you invoked the switch and choose Set West 
Protection Operation. 

Step 6 In the Set West Protection Operation dialog box, choose Clear from the drop-down list. 

Step 7 Click OK. 

Step 8 Click Yes in the Confirm MS-SPRing Operation dialog box.

2.8.3 CTC Card Resetting and Switching
This section gives instructions for TSC cards and SSXC cross-connect cards.

Soft-Reset a Card Using CTC

A soft reset on the active TSC causes the standby TSC card to become active. A soft reset on the 
preferred copy SSXC causes the alternate copy to come into service. If a line card is reset, there is no 
resulting traffic switch. 

Warning Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed 
circuitry could constitute an energy hazard. Statement 206
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Note Whenever TSC cards are changed from active to standby, it takes approximately 12 minutes to 
completely synchronize to the timing source because the Stratum 3E timing module is being adopted.

Step 1 If you are resetting a TSC card, determine whether it is active and which is standby by positioning the 
cursor over the active card. An active TSC card has a green ACT/STBY LED illuminated.

Step 2 Right-click the card to display the shortcut menu.

Step 3 Click Soft-reset Card.

Step 4 Click Yes when the confirmation dialog box appears.

Step 5 Click OK when the “Lost connection to node, changing to Network View” dialog box appears.

Note The TSC card takes several minutes to reboot. Refer to the “Card Features and Functions” 
chapter in the Cisco ONS 15600 SDH Reference Manual for more information about LED 
behavior during TSC card reboots.

Step 6 If you reset a TSC card, confirm that it is in standby mode after the reset.

Tip If you run the cursor over the TSC card in CTC, a popup displays the card’s status (whether active or 
standby).

Hard-Reset a Card Using CTC

This procedure is used to force system control from the active TSC card to the standby TSC card, or it 
is used to reset the SSXC or an optical (traffic) card. This kind of reset reboots the card and clears the 
flash memory, making it appear like a newly inserted card.

Warning Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed 
circuitry could constitute an energy hazard. Statement 206

Caution Use hard resets with caution. There could be up to 15 other sets of bandwidth affected by a hard reset.

Note The hard-reset option is enabled only when the card is placed in the Locked-enabled,maintenance 
service state.

Note When a TSC card changes from active to standby, the node takes approximately 12 minutes to 
synchronize completely to the timing source because of the more accurate Stratum 3E timing module 
being adopted.
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Step 1 If you are resetting a TSC card, determine which one is the active card and which is the standby card. 
(Position the cursor over the active card. An active TSC card has a green ACT/STBY LED illuminated.)

Step 2 Right-click the card (or active TSC card) to display the shortcut menu.

Step 3 Click Hard-reset Card.

Step 4 Click Yes when the confirmation dialog box appears.

Step 5 Click OK when the “Lost connection to node, changing to Network View” dialog box appears.

Note The TSC card takes several minutes to reboot. Refer to the “Card Features and Functions” 
chapter in the Cisco ONS 15600 SDH Reference Manual for more information about LED 
behavior during TSC card reboots.

Step 6 If you reset a TSC card, confirm that this TSC card you reset is in standby mode.

Tip If you run the cursor over the TSC card in CTC, a popup displays the card’s status (whether active or 
standby).

Request a Cross-Connect Card Preferred Copy Switch

Warning Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed 
circuitry could constitute an energy hazard. Statement 206

Step 1 Determine which SSXC card is the preferred copy and which is currently in use.

In node view, click the Maintenance > Preferred Copy tabs.

Step 2 In the Set Preferred drop-down list, select the alternate copy. (For example, if the Slot 8 Copy B is 
preferred and in use, select the Slot 6 Copy A.)

Caution Do not select the copy that you want to replace.

Step 3 Click Apply.

Step 4 Click Yes in the confirmation dialog box.

Note If you attempt a preferred copy switch and the switch is unsuccessful, it indicates a problem on 
the alternate SSXC card.

Step 5 Click Refresh until the tab shows that the alternate copy you selected is now the preferred copy. The 
Currently Used field dynamically changes to display the newly selected preferred copy.

.
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2.8.4 Physical Card Reseating, Resetting, and Replacement
This section gives instructions for physically reseating and replacing TSC card, SSXC cards, and traffic 
cards.

Reset a Card with a Card Pull (Reseat)

Note If you are pulling a TSC card, determine whether a TSC card is active or standby by positioning the 
cursor over the TSC card graphic to view the status.

Note Resetting a standby TSC card does not change its status to active.

Step 1 Ensure that the card you want to reset is in standby mode.

(A TSC card that is ready for service has a green SRV LED illuminated. An active TSC card has a green 
ACT/STBY LED illuminated, but a standby card does not have this LED illuminated.)

If you run the cursor over the TSC card in CTC, a popup displays the card’s status (whether active or 
standby).

Step 2 Unlatch the top and bottom ejector levers on the card.

Step 3 Physically pull the card at least partly out of the slot until the lighted LEDs turn off.

Step 4 Wait 30 seconds. Reinsert the card and close the ejector levers.

Note The TSC card takes several minutes to reboot. Refer to the “Card Features and Functions” 
chapter in the Cisco ONS 15600 SDH Reference Manual for more information about LED 
behavior during TSC card reboots.

Note When a standby TSC card is removed and reinserted (reseated), all three fan lights might 
momentarily illuminate, indicating that the fan controller cards have also reset. 

Replace an SSXC Card

Warning Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed 
circuitry could constitute an energy hazard. Statement 206

Note The ONS 15600 SDH system dynamically changes the preferred copy status from one SSXC to the 
redundant copy if an error is detected on a card port. You can see this change in the CTC node view 
Maintenance > Preferred Copy window Currently Used field. If errors are detected on both SSXC 
copies, the Currently Used field says Both.
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Note You do not need to make any changes to the database if you are replacing it with a card of exactly the 
same type. 

Note Card removal raises an IMPROPRMVL alarm, but this clears after the card replacement is complete.

Step 1 Physically remove the card to be replaced from the ONS 15600 SDH shelf by completing the following 
steps:

a. Open the card ejectors.

b. Slide the card out of the slot. 

Step 2 Physically replace the SSXC card in the shelf by completing the following steps:

a. Open the ejectors on the replacement card.

b. Slide the replacement card into the slot along the guide rails until it contacts the backplane.

c. Close the ejectors.

Note When you replace a card with the identical type of card, you do not need to make any 
changes to the database.

.

Replace an I/O Card

Warning Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed 
circuitry could constitute an energy hazard. Statement 206

Note Card removal raises an IMPROPRMVL alarm, but this clears after the card replacement is completed.

Step 1 Ensure that the card you are replacing does not carry traffic in a 1+1 protection group by completing the 
following steps:

a. In node view, click the Maintenance > Protection tabs.

b. Choose the first group listed under Protection Groups.

c. Verify that the slot number for the card you are replacing does not appear in the Selected Groups 
list. For example, if you are replacing the STM-16 card in Slot 3, ensure Selected Groups does not 
contain any entries that start with s3, regardless of the port.

d. Repeat Steps b and c for each protection group.

e. If any of the groups contain a port on the card you want to replace, complete the “Initiate a 1+1 
Protection Port Force Switch Command” procedure on page 2-123.

Step 2 Ensure that the card you are replacing does not carry SNCP circuit traffic by completing the following 
steps:
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Note A port can be part of a 1+1 protection group or part of an SNCP, but it cannot be configured for 
both. However, different ports on one card can be configured in different ways. If you move all 
of the traffic off some 1+1 ports, you still need to check whether the remaining ports are carrying 
SNCP traffic.

a. From the View menu, choose Go to Parent View.

b. Click the Circuits tab.

c. View the circuit source and destination ports and slots. If any circuits originate or terminate in the 
slot containing the card you are replacing, perform the “Initiate a Force Switch for All Circuits on 
a SNCP Span” procedure on page 2-126. 

Note If the card you are replacing is not configured for any port or circuit protection, but does 
carry traffic, bridge and roll this traffic onto another card. Follow the “Bridge and Roll 
Traffic” procedure in the “Manage Circuits” chapter in the Cisco ONS 15600 SDH 
Procedure Guide.

Step 3 Ensure that the card you are replacing does not carry MS-SPRing circuit traffic by completing the 
following steps.

a. In CTC node view, click View > Go to Parent View.

b. Click the Circuits tab.

c. View the circuit source and destination ports and slots. If any circuits originate or terminate in the 
slot containing the card you are replacing, perform the “Initiate a Manual Span Switch on a 
MS-SPRing” procedure on page 2-128. 

Note If the card you are replacing is not configured for any port or circuit protection, but does 
carry traffic, bridge and roll this traffic onto another card. Refer to the “Manage Circuits” 
chapter in the Cisco ONS 15600 SDH Procedure Guide.

Step 4 Remove any fiber optic cables from the ports.

Step 5 Physically remove the card that you want to replace from the ONS 15600 SDH shelf by completing the 
following steps:

a. Open the card ejectors.

b. Slide the card out of the slot. 

Step 6 Physically replace the STM-16 or STM-64 card in the shelf by completing the following steps:

a. Open the ejectors on the replacement card.

b. Slide the replacement card into the slot along the guide rails until it contacts the backplane.

c. Close the ejectors.

Note When you replace a card with the identical type of card, you do not need to make any 
changes to the database.

Step 7 Clear the Force switches.
2-135
Cisco ONS 15600 SDH Troubleshooting Guide, R8.0

July 2010



Chapter 2 Alarm Troubleshooting
2.8.4  Physical Card Reseating, Resetting, and Replacement
• To clear 1+1 Force switches, complete the “Clear a 1+1 Protection Port Force or Manual Switch 
Command” procedure on page 2-124.

• To clear SNCP Force switches, complete the “Clear a SNCP Span External Switching Command” 
procedure on page 2-127.

Step 8 When the card is in service and receiving traffic, reset the card’s physical receive power level threshold 
in CTC by completing the following steps:

a. Double-click the newly installed card in CTC node view.

b. Click the Provisioning > Threshold tabs.

c. Click the Physical radio button. 

d. Click Set OPM for each port on the card. 

Replace a TSC Card

Warning Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed 
circuitry could constitute an energy hazard. Statement 206

Note When an error is detected on a TSC card, the ONS 15600 SDH system switches control to the second 
TSC card; therefore, so it should not be necessary to change control when you replace the card.

Note You do not need to make any changes to the database if you are replacing it with a card of exactly the 
same type. 

Note Card removal raises an IMPROPRMVL alarm, but this clears after the card replacement is completed.

Step 1 Ensure that the card you are replacing is not the active TSC card: Run the mouse over the card in CTC. 
If the card says Active, switch it to Standby by completing the following steps:

a. Right-click the active TSC card to display the shortcut menu.

b. Click Soft-reset Card.

c. Click Yes when the confirmation dialog box appears.

d. Click OK when the “Lost connection to node, changing to Network View” dialog box appears.

Note The TSC card takes several minutes to reboot. Refer to the “Card Features and Functions” 
chapter in the Cisco ONS 15600 SDH Reference Manual for more information about LED 
behavior during TSC card reboots.
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Note Whenever TSC cards are changed from active to standby, it takes approximately 12 minutes 
to completely synchronize to the new system clock source due to the more accurate Stratum 
3E timing module being adopted.

Step 2 Confirm that the TSC card you reset is in standby mode after the reset.

A TSC card that is ready for service has a green SRV LED illuminated. An active TSC card has a green 
ACT/STBY LED illuminated, but a standby card does not have this LED illuminated.

Tip If you run the cursor over the TSC card in CTC, a popup displays the card’s status (whether active or 
standby).

Step 3 Physically remove the card you want to replace from the ONS 15600 SDH by completing the following 
steps:

a. Open the card ejectors.

b. Slide the card out of the slot. 

Step 4 Insert the replacement TSC card into the empty slot by completing the following steps:

a. Open the ejectors on the replacement card.

b. Slide the replacement card into the slot along the guide rails until it contacts the backplane.

c. Close the ejectors.

Step 5 If you want to make the replaced TSC card active, complete Steps b through d in Step 2 again.

Replace an ASAP Carrier Module

Warning Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed 
circuitry could constitute an energy hazard. Statement 206

Note You do not need to make any changes to the database if you are replacing it with a card of exactly the 
same type. 

Note Card removal raises an IMPROPRMVL alarm, but this clears after the card replacement is completed.

Step 1 Verify that the card is not carrying any traffic. If it is, switch it using the appropriate procedure.

Step 2 Physically remove the ASAP carrier module from the ONS 15600 SDH by completing the following 
steps:

a. Open the card ejectors.

b. Slide the card out of the slot. 
2-137
Cisco ONS 15600 SDH Troubleshooting Guide, R8.0

July 2010



Chapter 2 Alarm Troubleshooting
2.8.4  Physical Card Reseating, Resetting, and Replacement
Step 3 Insert the replacement carrier module into the empty slot by completing the following steps:

a. Open the ejectors on the replacement card.

b. Slide the replacement card into the slot along the guide rails until it contacts the backplane.

c. Close the ejectors.

Replace an ASAP 4PIO (PIM) Module

Warning Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed 
circuitry could constitute an energy hazard. Statement 206

Note You do not need to make any changes to the database if you are replacing it with a card of exactly the 
same type. 

Note Card removal raises an IMPROPRMVL alarm, but this clears after the card replacement is completed.

Step 1 Use a Phillips screwdriver to loosen the screws at the top right and bottom left of the 4PIO (PIM) module.

Step 2 Carefully slide the motherboard of the module along the top and bottom guide rails out of the slot. 

Step 3 Carefully slide the motherboard of the new module into the slot. 

Step 4 Tighten the screws at the top right and bottom left of the 4PIO (PIM) module.

Note The 4PIO (PIM) LEDs do not light until a fixed-rate PIM is installed in the associated slot or a 
multirate optical (MRO) PIM is installed and an optical rate is provisioned. 

Note If you insert a card into a slot provisioned for a different card, all red LEDs turn on and you will 
see an MEA alarm for that slot when you open CTC. 

Step 5 After you have logged into CTC, verify that the card appears in CTC card view. 

Replace an ASAP SFP (PPM) Module

Warning Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed 
circuitry could constitute an energy hazard. Statement 206
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Note You do not need to make any changes to the database if you are replacing it with a card of exactly the 
same type. 

Note Card removal raises an MPROPRMVL alarm, but this clears after the card replacement is completed.

Step 1 Unlatch the bail clasp by moving it to the left before removing the bad SFP (PPM) from the slot.

Step 2 Slide the SFP (PPM) out of the slot.

Step 3 Verify that the new SFP (PPM) is correct for your network and ASAP card. Refer to the 
Cisco ONS 15600 SDH Reference Manual for more information. 

Step 4 Orient the new SFP so that the Cisco serial number label is facing away from the shelf (to the right).

Step 5 Slide the SFP into the slot and move the bail clasp to the right to secure the SFP.

Caution Do not remove the protective caps until you are ready to attach the network fiber-optic cable.

Note Multirate SFPs (PPMs) must be provisioned in CTC; single-rate SFPs (PPMs) do not need to be 
provisioned. Refer to the “Install Cards and Fiber-Optic Cable” chapter in the 
Cisco ONS 15600 SDH Procedure Guide for provisioning instructions.

2.8.5 Verify or Create Node DCC Terminations

Step 1 In node view, click the Provisioning > Comm Channels > RS-DCC tabs (or Provisioning > 
Comm Channels > MS-DCC tabs as appropriate).

Step 2 View the Port column entries to see where terminations are present for a node. If terminations are 
missing, proceed to Step 3.

Step 3 If necessary, create a DCC termination by completing the following steps:

a. Click Create.

b. In the Create RS-DCC Terminations dialog box, click the ports where you want to create the DCC 
termination. To select more than one port, press the Shift key.

c. In the Port State area, click the Set to Unlocked radio button.

d. Verify that the Disable OSPF on Link check box is unchecked.

e. Click OK.

Set the Optical Power Received Nominal Value

Step 1 In node view, double-click the STM-N card that you want to provision. The card view appears.
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Step 2 For a fixed-rate card, click the Provisioning > SDH Thresholds tabs. For the ASAP card, click the 
Provisioning > Optical >Optics Thresholds tabs.

Step 3 From the Types list, choose Physical and click Refresh.

Step 4 For the port you want to provision, click the Set button in the Set OPR column. In the confirmation 
dialog box, click OK.
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